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Introduction



Welcome!

In a few short years the world has changed. Once music making was strictly ¢
vided between those with access to professional studios, expensive equipmer
other musicians, and those whose music making was confined to the realms ¢
ond rate equipment, limited funds and a good deal of dreaming.

We at Steinberg are pleased to be part of the continuing revolution that has br
down these barriers, allowing anyone with musical ambitions to realise their tr
musical potential.

The Cubase VST you now have in front of you, is our finest achievement to da
embodies the experience of over ten years of Steinberg history. Whether you .
seasoned professional musician or someone starting out in music, Cubase VS
vides the finest easy-to-use tools, and the best framework for your music.

Karl Steinberg Manfred Rirup



About Cubase...

Now that you have Cubase VST, you belong to one of the largest music softw
user groups in the world. Cubase is a family of music software, ranging from t
easy-to-understand package for the beginner to professional tools for the mos
manding applications. That's the Cubase advantage, Cubase grows as you de
musically.

Cubase may come in different versions and on different computer types, but it
ways a Cubase. What you learn now will be just as valid if you decide to chanc
another version or another type of computer. We developed a method of worki
with music software that has re-defined 'ease of use', and set the standard.

Cubase VST was created as a result of years of experience in both software ¢
neering and listening to our users. The Cubase of today is a very different pro
compared to its first release. A major component of this continuing success stc
your active involvement. We welcome suggestions and comments about Cubg
VST and the direction it should take in the future. Also we are very pleased to
independent Cubase Clubs appearing all over the world. These create networ
expertise and advice which helps all Cubase users.

Cubase is used by Hollywood film composers, world class recording studios, :
dio-visual facilities, and — of course — every conceivable type of musician. We
very proud of this, and would like to thank you for becoming part of the Cubas
family.

Your Steinberg Team.



How to find your way around the Manual and the On-
line Help

The documentation for Cubase VST comes in several flavors:

The Installation booklet

This separate booklet describes how to install the program. This is the first item
should read.

Getting Started (this document)

This document is the on-line version of the printed Getting Started book. It cont
the following:

e A Guided Tour in which you can find out about Cubase VST.
e Introductions to the various aspects of the program, allowing you to try out
many of the possibilities.

In other words, this document is not a complete description of all the features o
program, but a good way to get started.

e Getting into the Details.
This is the main documentation, containing detailed descriptions of Cubase
VST parameters, functions and techniques. When we refer to the “Electronic
Documentation” in this document, we mean the Getting into the Details doc-
ument (if nothing else is stated).

e Score Printing and Layout.
If you have the Score or Audio XT version of Cubase VST, the program in-
cludes a more advanced Score Editor. This editor is described in the Score
Printing and Layout document.

e MIDI Mixer and Mix Tracks.
Describes how to use the MIDI Mixer in Cubase VST to control levels and pa-
rameters in your MIDI instruments from within the program.

e IPS.
This document describes how to use the Interactive Phrase Synthesizer.

e Controlling Tape Recorders.
If you plan to use Cubase VST together with a multitrack tape recorder, this
document contains information about how to do this, using Tape Tracks.

* The Modules documents.
In the subfolder called “Modules” you will find a document about how to use
Modules in Cubase VST, as well as separate documents for each Module that
is included with your program version.

e The VST Plugins documents.
In the subfolder called “VST Plugins” you will find documents describing
each of the audio plug-in effects that are included with your program version.



So, what should | read?

¢ |n either case, follow the instructions in the Installation booklet.

e Then, if you want to get acquainted with the program, read this document
and refer to the electronic documentation whenever necessary.

e If you know you want to learn as much as possible about this program, you
should make sure to read this document and all the included electronic doc-
umentation documents.

-10 -



About the On-line Help

Cubase VST comes with Windows Help. There are several ways of bringing ug
Help texts:

* To see a list of topics in the Help file, select Contents from the Help
menu.

* To get general information about a window or a dialog, press the [F1] key
on the computer keyboard or click the Help button in the dialog.
A Help text is displayed, describing the current window or dialog box.

* To get specific information about an item in a dialog box, click the Ques-
tion mark on the window’s title bar. Then click on the item you want to
get information about.

* To get information about a menu item, pull down the menu, position the
pointer over the item and press [F1].
A Help text is displayed, describing the selected menu item.

* To get more information about how to use the Windows 95 Help, pull
down the Help menu and select “Using Help”.

e Some items are described in detail in the On-line Help only!

How you can reach us

You can find us at the World Wide Web, at the following address:
www.steinberg.net
On the web site you can do the following:

e Find support information, answers to frequently asked questions, etc.

e Send email to our support personnel.

e Download the latest update of your program and demo versions of other
Steinberg products.

e Communicate with other Steinberg users in the User Area.

* There are also sections for Education and Multimedia users.

-11 -
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Guided Tour
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What is Digital Audio?

“Audio” is any sound source that you can connect to the sound input of your P(
dio card; a microphone, an electric guitar or similar. “Digital” we say because |
computer converts the audio signal to numbers, which Cubase VST captures
stores on your hard disk. This convertion of sound into a stream of numbers o
up an enormous range of possibilities for creatively manipulating your recordir

What is MIDI?

MIDI is a type of control information used with synthesizers. Let’s explain this
with an analogy: Your computer can send messages to a printer about how you
a page to look. The printer then takes care of converting this information to the
tual “ink” on paper.

With MIDI the synthesizer works much like a “musical printer”: the computer
sends information to it, specifying which notes you want it to play, and it takes c
of actually creating the audio.

One of the advantages of this technique is that a recording made with for exam
piano sound can be played back with a harpsichord, brass or guitar sound, ju:
changing settings on the synthesizer.

General MIDI (abbreviated GM) is an additional specification for MIDI instru-
ments. If an instrument or sound card is General MIDI compatible, it will have
common, wide ranging set of sounds built in (piano, bass, drums, brass, strings
If you create music with a General MIDI compatible instrument it can be playe
back on any other GM instrument and the music will sound more or less the s
This allows you to share your Cubase VST songs with other people, and even
lish your works in a common data format, for example on the Internet!

Cubase VST also supports two extensions to the GM standard, called GS (Ro
and XG (Yamaha).
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The Main Windows in Cubase VST

The Transport Bar

This is much like the transport control on any tape recorder. This is where you |

Stop, “wind the tape” etc. But the Transport bar is also used for setting tempo,
signature etc.

These are used for

defining where to start
and end recording and
what section to Cycle.

These fields show you
the current Song
Position in bars, beats
and ticks (to the left) and
in tine position format
(to the right)

AN

Activates the
metronome.

Tempo and Time
Signature

Iﬂeplace 1 ~\IT0001.01.000

dade | — VY  Left Locator

I i [ - 0005.01.000

Right Locatar
I
When you activate this,
the program will cycle
the section between the
Locators.

0001.01.000 00:00:00:00 | AVTI || R
0404
Click
Sync

AN Em e

\r
These buttons are the

equivalents of the transport These ipdicators show MIDI In
controls on a regular tape (recording) and Out (playback)
recorder. activity.
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The Arrangement

This is where you record and assemble your Songs.

Vertically, the Arrangement is divided into Tracks, letting you organise your re-
cordings. You might use one Track for drums, another for bass, a third for mair
cals, a fourth for vocal harmonies, etc.

Click in thi

column to Mute ‘ g g The Track
e

\ The name of the

(silence) a Track.

This symbol C | Chn | Track JTrack. Double
indicates an #*| anp |Yocal 1+ | clickto change.
Audio Track 4 | any Vocal 2 The Track’s
+ 1~ | flute channel
This symbol ..
indicatesa — 3 1 | 3 bazzoon
MIDI Track o — The active
(4 gz (selected) Track.
This symbol £ Hu!ns Recording always
indicates a 416 Strings 1 happens on the
Drum Track i Strings 2 active Track.
) &8 Ac Guitar
This symbol 19 Tenor Sax
indicates a .
£ 11 Organ
This button It Hixer
opens the

Inspector i35

The right part of the Arrangement is called the Part Display.

Time runs from left to right, as the ruler indicates.

The Song Position The Left Locator Va The Right Locator

w:'art Colorzs =]
F

|
[Vocal2 +ord

g = buantize 8 =  Mouse | 000S.01.000

bassoon bassoon

. stabs stabs Sua
Each recording you make appears in the

Part Display as a box, called a Part.
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The horizontal position shows you where in the Song the Part starts.

# Amrange - Bridge

[FSolo | Shap I'I.-"B 7| Lluantize I 8T =] Mouse Iﬁ
M|C|Chn | Track
| any |Yocal 1
*| any | Yocal 2
+11 flute
The vertical position of the Part The width of the box shows you
shows you which Track it is on. the length of the recording.

In the Part you will see a visual representation of the recording.

At the top of the Arrange window is a bar with various pop-ups and settings.

Click here to listen to the This note value is used for ~ The mouse pointer’s position
selected Track only the Quantize function. in bars, beats and ticks.

Amange - Bridge

148

Shap ’I Part Colors

O0%. 07,000

Clon [Tk [

*| anp | Vocal 1

*| anp | Yocal 2 =
s flute
I

The “precision” for editing This pop-up is used to give
operations, like moves and splits different Parts different colors.
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The Audio mixer windows

The Monitor Mixer window is where you mix your Audio Tracks, that is, adjust tl
levels (volume), stereo panning, effect sends, EQ, etc.

. 4 VST Mixer MiE B Insert Effect
Mixer buttons
automation AT

Mute and

Solo buttons
|

controls \% zert
EE

Input level Pan controls

switch

Level meter

Master Effect
displays

Level faders

i Level meters
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The EQ and Effect windows

For each audio channel in Cubase VST, you can have up to four bands of par
ric equalization. Furthermore, each channel has four effect sends, which you
assign to four internal “effect processors” for adding reverb, chorus and other
fects.

Effect sends Equalizer section

Enabld
Gain Gain Gain

[N | HiLimit Hi Limnit
i Frequency Frequency i

3

Lo Limit Lo Limit | ekl

Hi Limit

“\'-._‘ [ 1% : ;PN‘JG. choins
_,.( ;P&H
& s Corm o

‘\"1 [ T e <t e o
eI D
e o

3 ST
\ .(J;:)mt.. autopan
P e .

AT b

Apart from the four send effects, which are common to all audio channels, you
have up to four different Insert Effects per channel. These are accessed via th
sert buttons in the Monitor Mixer window (see the picture on the previous pag
There are also four Master Effects, which are inserted into the master output
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The GM/GS/XG Editor

This is one of the places where you can adjust the levels, panning and other p
eters for the sounds created by your MIDI synthesizer. If you use MIDI instrume
that are compatible with one of the standards GM, GS or XG, you can also use

editor to select sounds for each MIDI channel.

-BB---HBJMMa-EHE

Rl

L—

il

JT‘

Frogram

= QOO0 OOVOOD

Heverﬁ I_WITIT ITITWW WWWW WWW
I T N A0 R 0 A A A R

Picked Bas: French Hor

Plzzmto Str.

| F|fth Lead

| Standard

brand Fiatu Nuted Trum || Halo Fad

| Grand Piano [ Perc.Organ Fretless Bass | Ocarina |[Grand Piana [Grand Piana [Metalic Pad [Atmosphere

— Effects

Plate T | Reverb Flanger

23 | Reverb Time

2| Charus ’7

Device

GS [ Z| Mode G5 Reset |
IMPU-4D1 .. !I Output Help |

The Pool

This window lists all your audio recordings. It is also used to import audio files

ated in other programs, for use in Cubase VST.

This is a file containing an
audio recording.

Use this menu to import Files created in
other programs.

| Do !I Wiew
File Mame , D=k S Img Length Diake Time
Hear  Segment I Start End Length SFate Range
= African ey (9 L] ™ 253K 1997 -06-03 17:58
g1 African 44 264756 264712 44100
= Sterloop weay (9 a0 ™ ATIH 1997 -06-03 1802
g1 Sterlood 44 177105 177064 44100 FH—F——t+—PF+—p——4—F—F+—F—
= mutrand ey i (] % 17K 1997-06-03 17:59
g mutrorns. 1 0 425273 428273 44100 f—= ——h
g1 =hart mu 75431 234415 158984 44100 ey
g1 mutron 75431 280165 204734 44100 —— L
g1 mutron2 75431 352521 307090 44100 —— |

These are segments that play parts of the file.
By dragging segments into the Arrangement, you can use the audio file in your Song.
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The Audio Editor

This is the window where you do the basic editing of your Audio Parts, moving
trimming start and end points of Audio Events, etc.

4 Sound Card - Track 20004.01.0000013.01.000 !IEII:{

Edit Sola | [Volume =[[Gato =l[To :Ilv.ew =] Snap [ & _zI[ O004.07.000 I_
[ O00a.01192 [ Ta &l Quant [8 =zl 0013.01.000

2 =l
=
:
B | o—

The Wave Editor

This window is for detailed editing and permanent alteration of the actual audi

cordings.

|D0 _||F|Ie _||Segment _|| 00:00:01:327 I I I || 1] | 1]
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The MIDI Editors

There are four different editors for editing your MIDI recordings:

Key Edit
4@ Key - Trumpet 1, 0001.01.000, 0109.01.000 o [=] B3
EditSolo_| [Gote =1[Ta :II SnapOFF =] [0007.07.000 I_ I_ AL a“
[Tar & == Quant[ 76 =] ["0705.07.000
START === == LEMGTH ===== FITCH ==== Y¥ELOOMN === YELOOFF === CHN ==

Notes

3 EE i == d
= | )
& B
=, - A L

Continuous Events

This editor consists of a “grid” with the notes shown as boxes. The pitch of ar
is indicated by the vertical position, and the note length is indicated by the widt
the box. This is the editor to use when you want quick graphical editing of not:
and continuous controllers, such as modulation and volume.

Drum Edit
4 Drum - DrumKit, 0001.01.000, 0003.01.000 _[O]x
EditSolo | [Goto =I[Da =1 | Snapl2 = [ 0000 000 Bl_a l‘lJ,ll, 1 ql
Dium Solo | [T ATsslected =] [ AMidTom  Quantl 2 =] 000Z.01.000 : v
START ========= LEMNGTH ===== FITCH ==== YELOOM === WYELOOFF === CHN ==
Drum Sounds 2 3 2 3 2 3
Bass Drum 1 ‘I
High Tom & & & < & ¢
Side Stick
Ac. Snare
| HandClap AR ¢ O &
El Share
¢ & & el o S ¢ O & ¢
LowFloorT om
Cls HiHat & ¢ ¢ S ¢S » < * < <
HiFloorT om 5 4
Pedal HiHat
Notes ——=rrr =
TOpen HiHat [
Lowbdid Tom
HiMid Tom T
o] o [»] _—

This editor is similar to Key Edit, but designed specially for editing drum and p
cussion Tracks. Each Drum Sound has its own row and settings, making it ea:
create and change rhythm patterns.
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List Edit

@ List - DrumKit, 0001.01.000, 0003.01.000 =] S |
Edit Solo Imm I— Snap'ﬂw BlFlal‘l)lr |'J q In
[Mask =] [Tor &l =] [Tne. Mote =] Quant[ 76 _=I[ O007.07.000 v -
StartPas. Lenath  Wall Wal2 Wal3 Status r 3 2
0001.01.000 243 D2 120 B4 MNote

0001.01.000 43 F#1 120 64 Mote

0001.01.000 43 B2 120 B4 MNote

000101096 ===== 7 53 === Main¥alume

0001.01.192 ===== 7 E6 === Main¥alume

0001.01.192 ===== 4 88 === FcatChl

0001.01.192 ===== 10 106 === Pan L

0001.01.192 300 F#1 120 B4 Mote |

0001.01. 288 ===== 7 83 === Main¥alume

0001,02.000 ===== 7 121 === Main¥alume

0001,02.000 s==== 86 === === Aftertouch »

0001,02.000 == 1 75 === Modulation \

0001,02.000 43 F#1 90 G4 Mote

0001,02.000 563 \B3 120 B4  Note >

0001,02.000 43 N#1 70 B4 Mote EEEEE

0001.02.192 510 F¥1 120 B4 Mote

fele | 2l

The Everllt List MIDI Events The Event Display
In this editor, all MIDI notes, controllers and other Events are shown in a list.
can move, insert and delete Events in the list and perform detailed editing of al
ues. List Edit is useful when you want absolute control over values and position
if you are a “computer type of person”, used to numerical editing.

Score Edit

@ Score - Trumpet 1, 0001.01.000, 0109.01.000 =] E3
EditSolo | [Gote =l[Do =] [ 000202000 Snap[ &1 =] [ 000701000 I_ "_I_I,_ In |
[To &l = 53 Quant] 8 =1 [ 0703.07.000 Bf: ®<| e €] 864
ST m==—r=—r=—— LEMGTH ===== FITCH ==== WELOOM === VELOOFF === CHN ==
Insert |1 o || JIF Al A AT =]  ennswin | b ore|ne] 8|2 2] O 8]Jr] | AR Hide |0

Here, the MIDI notes are presented as a musical score. Use Score Edit to ma
printed scores, or simply if you are used to working with musical notation.
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Quick Start
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About this Chapter

This chapter gives you a really quick introduction to Cubase. It is based on the
Quick Start demo Song, included on the CD-ROM.

We assume that a Windows compatible sound card has been already installed
(as described in the Installation booklet) and tested as working with the Win-
dows’ Media Player.

Opening the Quick Start Song

1.

2.

Insert the Cubase CD-ROM disc into the drive.

Use the Explorer application to copy the folder Quick Start Song on the
CD-ROM to your hard disk.

. Open the Quick Start Song folder, on your hard disk, and locate the Cu-

base Song file with the same name. Double click on it.
Cubase launches, and the Song opens. What you see now is the Arrange win-
dow, the real focus of Cubase.

Playing Back

At the bottom of the screen you will find thieansport Bar This is used to control
playback, recording and many other functions, much like the controls on a reg
tape recorder.

MR 0007.02.256 00:00:22:00

bor

100 |

r

thor

The transport controls.

<<i

. Click the Play button, on the Transport Bar.

The Song starts playing. At this point, you will only hear the audio Tracks, that
is, audio recordings stored on your hard disk as files. No MIDl is played at this
point.

. When you are done listening, hit Stop. Also try out Fast Forward and Re-

wind to see how you can move the Song Position (the vertical moving
line in the Arrange window) to any point in the Song and start playback
from there.
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Muting and Soloing Tracks

As you can see, the Arrange window is divided into a number of Tracks. These
listed vertically. You can silence any number of Tracks, by using the functions M

and Solo.
/ The Solo button A Muted Track
&range - DEF_AF

MSolo | Snap | 1/2 II Lluantize |0

Track lnfo | A& M( C | Track Chin | Dutput .I
[ Strings [ % Brushes 1 | vsT
|ristrurnet 1 | %| Drum Kit 2 VST
| ® * Bass 3 VET
Olukput & | @uitar 4 VST
| SB AWE. B2 s ‘wah Guitar 5 VaT
7 rhae *| Sax 6 |¥5T

1. Click in the “M” column in the Tracks list, for the Track Bass.
You will notice how the bass disappears from the music. Click again to get it
back. What you just did was muting and unmuting a Track.

2. Experiment with muting/unmuting Tracks but leave the Tracks Vibes and
Strings muted for now.

3. Click on the name of the Track Bass.
The Track goes dark. What you just did, was selecting a Track. Selecting
something means it is now the target for some operation you are about to per-
form.

This Track is selected \

< Ammange - DEF.ARR

FSolo | Snap [1/2 2] Huantize Iﬁ

Track Info | & | b Track Chr | Output

| Bass Brushes 1 VST

i

Drum Kit VST

I 0 Delay
ERE 4 | Guitar 4 |VST
woaoll i | Wah Ruitar L voT

4. Click on the Solo button, at the top of the Arrange window.
You will now hear only the selected Track. Solo can be thought of as a sort of
inverse mute. Click Solo again to hear all the unmuted Tracks.

-25-



Activating the MIDI Tracks

The two Tracks at the bottom, called Vibes and Strings, do not play audio but M
You can see this by checking the “C” column for the Track. The note symbol ir
cates that a Track is a regular MIDI Track whereas the waveform symbol indic
an audio Track.

Audio Track ——— | M| C | Track
symbol ﬁ.’ Brushes
| % Drum Kit
[ [~[Bass
s | Guitar
* | Wah Guitar
MIDI Track symbol — & | S ax
@ | | YVibes
& | Stnings

To be able to play the MIDI Tracks you need to have an audio card with a syn
sizer on it, or an external MIDI synthesizer connected to a MIDI Interface. If yc
synthesizer is not General MIDI compatible, you might still play the Tracks, ar
you will probably hear something, but it might not be the sounds we assume in
example.

1. Make sure your synth is in its General MIDI compatible mode.
Most synths are on startup already in this mode.

2. Click twice on the Stop button to move the Song Position to the begin-
ning of the Song.

3. Unmute the two Tracks Vibes and Strings.
4. Activate playback.
You will now hear, from the MIDI synthesizer, some additional parts in some

sections of the Song. If you don't hear anything, check the Output column for
the MIDI Tracks and make sure they are set to the correct “port”.
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Changing the Sound of a MIDI Track

Now, let’s try to make some changes to the sound and levels of the MIDI Tracl
The easiest way to do this (although there are others) is to use the GM/GS/X(
itor.

1. Let the music keep playing.

2. Select “GM/GS/XG Editor” from the Edit menu.
A window with faders, knobs and other controls, opens. The 16 sections rep-
resent the 16 MIDI channels in your General MIDI instrument. The Vibra-
phone sound you are hearing is playing on channel 1 and the Strings on
channel 2.

Chows| 0 |0 |0 I_l
| |
Program | [Skings 2 | [Mew

|"-"i|:nraphn:une |E.F'ian|:| 1

The text fields at the bottom of the window indicate the names of the sounds.

3. Adjust the “Vol” faders for channels 1 and 2.
These faders transmit MIDI messages to your MIDI synth, instructing it to ad-
just the volume on these MIDI channels. If nothing happens, make sure that
the Mode pop-up menu in the lower right corner of this window is set to
“GM”, and that the Output pop-up menu below it is set to the “port” that your
General MIDI synth is connected to.

4. Position the mouse over the Program selection item for channel 1.

5. Click with the mouse button.
A hierarchical Program menu appears.

6. Select some sound from this menu.
The Vibes part will now play back with the sound you just selected instead. If
nothing happens, this is because your instrument is not set up to receive the
MIDI message Program Change.

7. If you like, experiment with the other controls in this window.

8. When you are done, close the GM/GS/XG Editor.
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Setting the Levels of the Audio Tracks

Now that you've learned how to mix the MIDI Tracks, let’'s do the same for the
dio Tracks.

1. Rewind the Song to the beginning and activate playback.

2. Select “Monitor” from the Audio menu.
The audio Monitor mixer appears. Here you can see, via the colored bar
graphs, which audio channels are playing (in this example, each audio chan-
nel corresponds directly to an Audio Track, so that Track 1 plays back on au-
dio channel 1, and so on).

<. VST Mixer
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The Monitor window.

3. Use the channel faders to adjust the levels of the Tracks, as desired.
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Adding an Effect

Now, let’'s add some audio effects to the Guitar Track. To hear what we’re doir
let’s Solo it first.

1. Locate Track Guitar, the one labelled “Chan 4” at the bottom, and click
on its Solo button (at the top of the “channel strip”).

2. Click on the same Track’s FX button, located just above its Solo button.
The EQ and FX Send window for that channel appears. Essentially this is a
mixer window with detailed settings for one channel only.

<. Y¥ST Channel S5¢

The effect settings in the EQ/FX window.

The section we are interested in now is the one to the far left, with the four blu
knobs. These represent controls for the amount of effect for this audio channe
you can see from the labels, there are four effect available.

1. Click on the On buttons for all four effects.
2. Use the knobs to add various amounts of each effect to the Guitar sound.

To do this, press the mouse button with the pointer over the knob, keep the
button down and drag in a circular motion around the knob.

Drag in a circular motion around the knob.

3. When you are done, close the FX window, click the Solo button again to
deactivate Solo and finally close the Monitor window.
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Checking Out the Arrange Window Toolbox

So far you've been mixing and setting sounds. Now it’s time to explore the poss
ities ofeditingthe music. This is mainly done in the Arrange window, using a
graphical Toolbox that allows you to manipulate recordings.

As you have probably noted, the recordings on the Tracks are made up of Pat
small boxes that each represent a musical recording, regardless of whether it
tains audio or MIDI. Editing in the Arrange window means manipulating these
Parts.

|Strings I |Strings I Strings I Strings I

Parts in the Arrange window.

1. Position the pointer somewhere in the area where all the Parts are (the
Part Display) and press the right mouse button.
A Toolbox appears.

NENAAS
a 2%

The Arrange window Toolbox.

2. Select the Eraser Tool.

3. Click on one of the Parts.
It disappears - because you just erased it!

4. Select Undo from the Edit menu.
The Part comes back.

5. Select the pointer from the Toolbox.

6. Position the mouse pointer over any Part, press the mouse button and
drag.
The Part moves. If you like, play back to hear the effect.

7. Select one Part. Then hold down [Shift] and click on more Parts, one af-
ter the other.
They all get selected and turn dark to indicate this.

8. Press the mouse button with the pointer over one of the selected Parts,
and drag.
They all move together, as a block.

9. If you like, try out the other Tools.
The functions of the most common Tools are described in the chapter “Work-
ing in the Arrange window”.

-30-



Checking the Contents of the Parts

The Arrangement is fine for block editing purposes, like repeating a chorus ett
However, there will be many instances when you will want to perform more de
tailed manipulations of your recordings. For this you use the various Editors.

1. Double click on a Part on an audio Track.
The Audio Editor opens. This has a Toolbox and a number of controls, menus
and settings all of its own. If you like, experiment with the possibilities.

2. Close the Audio Editor.

3. Double click on a MIDI Part.
The Key editor opens. This is one of a number of MIDI editors, each one
streamlined for a certain type of work.

4. Again, experiment with the possibilities, if you like.

5. Close the Key editor.

Closing Up

This finishes our quick tour of the demo Song. By now you are probably anxiou
record something of your own. Proceed to the next chapter to get an introducti
the basic methods and concepts used in the program, and then get ready for
unique musical experience, using Cubase VST to realize your own musical ins
tions.

e Apart from the Quick Start Song, there may also be other Demo Songs in-
cluded on the CD-ROM. Use these to try out other features and get an impres-
sion of the full capacity of Cubase VST!
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Basic Methods
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Why you should read this Chapter

In this chapter, none of the actual features of Cubase VST are described. Inst
the chapter contains information about the general methods you need to emp!
when using Cubase VST, plus some useful terminology. These methods are t
same in every part of the program, no matter if you are making a basic recordir
using Cubase VST at its most advanced level. To make your work with Cubase
as effective as possible, please take the time to read this chapter.
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Using Tools

When you are working with Cubase VST, you need different tools in different <
ations. You may for example want to input notes or import audio using a Penci
tool, or delete notes using an Eraser tool. There are a lot of other tools as wel

N 2 % ) 2

Some examples of tools

About Toolboxes

The various tools used in certain situations, are gathered in Toolboxes. Each i
sentially a “frame” containing an icon for each tool. Most of the windows in Cu

base VST have their own Toolbox.

NESABIERAS
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Some examples of Toolboxes

Selecting a Tool from a Toolbox

1. Press the right mouse button.
Make sure the pointer is not positioned over a numerical value field, as this
will instead increase the value (see page 37).

2. The Toolbox appears.

Wafﬁh%@
Y21%S

3. Move the pointer to the tool you want to select, and release the mouse
button.
The Toolbox disappears and the pointer takes on the shape of the selected
tool.
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Pop-Up Menus

Throughout the program you will select values from pop-up menus. These diff
bit from the regular “menu bar menus”. Pop-up menus may be located anywhe
a window, and are not on a menu bar. But, selecting is done identically from a
menus, pop-up or regular.

Shap IEar ﬂ‘\ Snap IElar =I

Press the mouse button with t?ﬁe pointer Off
positioned on the small triangle... Bar
142
144

Y S Y Y

1416 !

...to pull down a pop-up menu.
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About Positions, Lengths and Resolution

Cubase VST works with a MIDI resolution of 384 fractions (or ticks) per quarte
note. You will often work with position values in the Arrange window and in the
MIDI editors. Positions in Cubase VST are displayed in one of two formats:

* Meter Positions
Meter Positions are divided into Bars, Beats (quarter notes) and Ticks. This is
the most commonly used position format in Cubase VST.

0003.01.096

For example, if you place the Song Position pointer one sixteenth note into the third bar, the
position will be displayed like this: “3.1.96” (third bar, first beat, 96th tick).

* Time Positions
Time Positions and lengths are shown as “hours: minutes:seconds:frames”.
How many frames there are to each second depends on the frame rate, as set
in the Synchronization dialog box. See the “Synchronization” chapter in the
electronic documentation.

The beginning of the Song,
00:00:00:00 displayed as a Time position.

MIDI Note Lengths

MIDI Note lengths are always displayed as ticks. In the table below, some com
note values are shown as ticks:

Note Value Ticks Note Value Ticks
Whole note 1536 Eighth note 192
Half note 768 Eighth note triplet 128
Dotted Quarter note 576 Dotted sixteenth note 144
Quarter note 384 Sixteenth note 96
Dotted eighth note 288 Sixteenth note triplet 64
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Setting Values

Different types of values

There are three basic kinds of values displayed in Cubase VST:

e “Normal” values.

e “Segmented” values, i.e. values divided into two or more “subvalues”. Exam-
ples of these are positions, tempo, time signature, etc.

* Note Pitches.

. _ ] — (NESIN LTS
13%211- | 0006.02.000 38 Valoc
Tempaigig —~ —oAmEeel o

Some different values.

Changing values

There are several ways to change a value in Cubase VST:

¢ Click on the value with the left or right mouse button.
The left button decreases the value, the right button increases it.
For each click, the value changes one step. If you hold down [Shift] while
clicking, the value will change in larger steps (often steps of ten).

¢ Scroll the value up or down by pressing and holding down one of the
mouse buttons with the pointer over the value.
The left button decreases the value and the right button increases it.
If you hold down [Shift] while using the mouse, the value will scroll in larger
steps (often steps of ten).

* Hold down the [Control] key, click on a value and drag the mouse up or
down with the button pressed.
The whole screen will act like an invisible scroll bar or fader, which you can
use to change the value.

e Double click on the value, type in a new value and press [Return].
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About changing “segmented” values

If you are using the mouse to change a “segmented” value such as a position
decimal number, you can change any one of the “segments” individually. In a |
tion value for example, you can change the bar, beat and tick values independ
just by positioning the pointer at the right numeral.

Clicking on the “Beats” value...

| 0005.04.024 | 0005.02.024
¢ Left Lolgtar - Left Locator

...will change this value only

If you are changing a segmented value by typing, you can use spaces, dots, co
or any character that is not a number, to separate the numerals. However, you
have to type in all the numerals. If you just type in a single number, you will cha
the largest numeral in the segmented value, and all the lesser numerals will be
their lowest values:

|

Double clicking on this ...brings up a value
value (Song Position)... box.

15] | 0005.01.000

If you type a single value ...the lesser numerals get their
and press [Return]... lowest values automatically.

About editing Note Pitches

If you are editing a pitch (note number) by typing, there are two ways of typinc
as anote namda letter followed by a number and maybe a #-sign) o\Da
note numbefa number from 0 to 127, where 0 is the lowest note).

2.J = You may enter a MIDI note number,
for example 37...

LT e )
(k]
==L

[m] 3.2 pu

I

& 2
...but Cubase VST will display the name of the note (here C#1).

In some windows you also have the option to edit note pitches via MIDI:

1. Double click on the pitch value.

2. Press a key on a connected MIDI keyboard.
The value gets the pitch of the key you press.

3. Press [Return].
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Naming

You can give hames to Tracks, Parts and many other items in Cubase VST. Tt
a name just double click on it. The text gets highlighted and you can type in th
changes you want to make. You can use the arrow and [Backspace] keys, just
any text-editing program.

Double clicking on the name...

1pr i 1pt 1 [ 1
Tpt 2 |
TE—1 | Thn 1 | 2

...highlights it and makes it ready to edit.

Window Techniques

Cubase VST is a Windows 95 program, which means that you may move, resi
scroll and close windows using standard Windows 95 procedures. There are &
couple of special features:

Changing the Magnification

In the Arrange window and most of the editors, a small slider appears on eact
scroll-bar. The slider on the left/right scroll bar changes the horizontal magnific
tion. The slider on the up/down scroll bar changes the vertical magnification. E
dragging the slider to the right/downwards, you increase the magnification. Dr
ging the slider to the left/upwards will decrease magnification.

The vertical magnifying slider /-

The horizontal magnifying slider \‘ ]

=
You can also change the magnification from the computer keyboard, using the
lowing keys:
(G] Decrease horizontal magnification.
[H] Increase horizontal magnification.
[Shift]-[C] Decrease vertical magnification.
[Shift]-[H] Increase vertical magnification.
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Dividers

Some of the windows in Cubase VST are divided into two or more sections. T!
“borders” between the sections are called Dividers. If you position the pointer ¢
Divider, the pointer takes on the shape of a hand. You can then click on the Di\
and drag it in the direction of one of the sections. This way, you will shrink that :
tion and enlarge the other.

shap | 148 =) Wuannze | I1b ] MOuze |

fo A M CT|Track Chr
[ y Yocal 1 1
; y Yocal 2 2
L fel TRt 1
| HN 1
B2 & Tbhn 1 2
an i Alto 1 2 | Intro

i Alto 2 2

h Tonnr 1 - Tea

Dragging the Divider in the Arrange Window.
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Using the Computer Keyboard

When you are working with Cubase VST, the computer keyboard has several
ferent uses:

Transport Controls

The Transport functions (such as Play, Stop, Record and so on) can all be mat
from the computer keyboard. The keyboard commands for these functions are
mainly located on the numeric key pad to the right on the computer keyboard.
page 101in this document.

e You can use the numeric key pad to control the transport functions, even if
the Transport Bar is hidden or a dialog is open.

Keyboard Shortcuts
Many of the items in Cubase VST’s menus have a computer keyboard equival
a “shortcut”. These keyboard shortcuts generally use the keys to the left on th
computer keyboard.

How Keyboard Commands are displayed in this Manual

The following list shows how the “special” keys on the computer keyboard are
played in this manual.

In this manual: On some keyboards:
[Shift] P

[Alt] Alternate

[Control] Ctrl

[Tab] —

[Return] <

[Backspace] “—

When the text says something like “press [Control]-[T]” this means that you shc
hold down the Control key on the computer keyboard and press T once.

e Some key commands involve pressing two modifier keys, for example: “press
[Control]+[Alt]-[T]”. The “+” sign between the modifiers means that you
should press the Control key and the Alt key at the same time, hold them
down and then press T once.
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Undo

Cubase VST has a very wide-ranging Undo function. This means that if you re
your last action, you can Undo it. This is very helpful when something doesn’t t
out as intended. Remember that it is onlyl#staction that can be undone.

You Undo an action by selecting “Undo” from the Edit Menu, or by pressing [C
trol]-[Z] on the computer keyboard.

Zalo Structure  Funchons

Indo Delete

Optior

I

(B0t

ISy

Eeste

Delete Track,
Select

Copy to Phraze. ..

(SEr =
([SEr{FE
(SEr{ s
Dl

Often the menu item Undo tells
you what will be undone at any
given moment. In this case,
“Undo Delete” means the last
deletion will be undone.

If you wish to “Undo the Undo”, this is possible. The menu text changes to “Re
after an Undo (for example “Redo Delete”). If the menu item is grey, nothing ¢

be undone.
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Setting up your System
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Setting up Audio

e This chapter (and in fact the whole Getting Started book) assumes you are us-
ing one “standard” audio card, with analog stereo inputs and outputs.
If you have an audio card with several inputs and outputs, you find informa-
tion about activating different Inputs and routing audio to different Outputs in
the electronic documentation.
To get a grip on the basic audio procedures in Cubase VST, we recommend
that you set up and connect your audio hardware so that it resembles a stand-
ard “two in/two out” card, and try out the possibilities described in this docu-
ment. Then go on to learn about the Output Bus features as described in “The
Input/Output Bus System” in the electronic documentation.

Connecting your system - Inputs and Levels

Example 1 — The simplest possible MIDI and Audio system

The simplest audio/MIDI system you can have is an audio card which also con
a MIDI synthesizer.

; [<—Audio Card with
S MIDI synth O O

()

In this system, the microphone, plugged directly into the audio input on the car
used to record audio. The stereo output on the card delivers both the output fr
the audio tracks (the material recorded with the microphone) and the output fr
the MIDI synthesizer on the card.
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Example 2 — A Basic system including an External Mixer

Standard Windows audio cards often do not provide optimal audio quality for r
cording the output of a microphone.

To improve sound quality, it is often preferable to connect the microphone (or o
device you plan to record onto audio Tracks) to an external mixer and then cor
the audio output of that mixer to the audio card.

In addition to this, more advanced MIDI synthesizers are normally in external
boxes. This means you have two audio sources that you want to hear in your ¢
ers or headphones — the output from the audio card and the output from the s
sizer(s). Again, the solution is to connect it all to a mixer.

The picture below shows a setup that includes both these functionalities.

¢+ |« —Audio Card
o - O O

Ol O
t
Send/Bus Out
& MainOut

5

;j

A

o IVIREITHUR |

In the example above, a special output on the mixer called a “monitor send” ol
separate “bus” is connected to the input of the audio card. This ensures you ca
arately control what gets recorded on an audio Track.

The main outputs of the mixer are connected to the speakers, and it is via this
nection you are able to hear the output of the audio card and the synthesizers
blended to a final mix.

Naturally, there are endless variations on the above concept depending on the
of mixer, the sources to be recorded and the specification of the audio card. Cc
your music dealer for help on configuring a system ideal for your specific neec

Recording From a CD player

Most PC computers come with a CD-ROM drive that can also be used as a re
CD player. Normally, the CD player is connected via a special connector to the
dio card so that you can record the output of the CD-player directly into Cubas
VST.
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The Sound Card Setup application

Normally, a sound card hasveral inputs: a microphone input, a stereo line inpu
possibly digital inputs and maybe a connection from theRCIDA drive in your
computer (see abe).

With the sound card you shouleMe recéved one or more small applications that
allow you to configure the inputs of the card to your likiflgis includes:

Selecting which in/outs are active.

Turning monitoring via the card on/off.

Setting levels for each input. This is very important!

Setting Levels for the Outputs, so that they match the equipment you use for
monitoring.

About Recording Levels and Inputs

When you connect your equipment, please remember ffexiedit types of evices
deliver different types of audio signals.

* Microphones and electric guitars deliver low level signals. The term used is
indeed “microphone level”. These types of sources should always be con-
nected to a microphone input.

e Mixers, synthesizers, tape recorders and many other devices deliver a
stronger signal called a “line level signal”. These should always be connected
to a “line input”.

It is very important to make sure you use the correct type of input on your aud
card, or your recordings will either be distorted or unnecessarily.nois

e Cubase VST does not provide any input level adjustments, since these are
done differently for each card. Adjusting input levels is either done in a spe-
cial application included with the card or possibly from an ASIO control
panel, accessed from Cubase VST’s Audio System dialog box.

About Monitoring

In Cubag VST, Monitoring means listening to the signal being recorded while g
paring to record or while recordinghere are basically three ways to monitor:

e Via a Mixer
If you have the equipment connected to a mixer and then to the audio card,
you can of course chose to listen to the connected equipment directly from
the mixer. If you should chose this option or not depends on how advanced
your mixer is.

e Directly via the audio card.
In this case, the audio input on the card is connected directly to its output.
You set this up with the mixer application that comes with the card.

¢ Via Cubase VST
In this case, the audio passes from the input into Cubase VST and back to the
output. You then control monitoring via settings in Cubase VST.
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Which should I choose - “Card” or “Cubase” monitoring?

* Monitoring via Cubase VST has the advantage that any effect and other
settings you make in the program will also be apparent on the monitored
signal, not only on recordings you have already made and play back.
This will not be the case if you use the card for monitoring.

* Monitoring via Cubase VST has only one disadvantage: There is an una-
voidable delay in the Monitor signal (the monitored sound will appear to
be a little late). This is due to the way audio is handled on PC computers/
audio cards.

Normally, audio card monitoring does not have this problem.

Setting up

e |If you want to use Cubase VST’s monitoring, make sure any monitoring
(“through”) function is deactivated in the card’s mixer application.

* If you instead want to use the card’s monitoring, make sure this function
is activated in the card’s mixer application. Also select the Global Disa-
ble monitor option in Cubase VST’s System dialog (found on the Audio
menu).

System and ASIO Settings

1. Select “System...” from the Audio menu.

Audio Syztem Setup EE
— Audio Perfarmance — Audio [/0
Number of Channele | 16 4510 Device 4510 Multimedia Driver ]
temony per Channel I 288 | kB ASIO Control Panel |
sk Block Buffer Sizel| 95 T kB Latency 750 Miliseconds
Apply Settingz do not take effect Sample Rate I 44.100 kHz ;I
&y | ] 2 b g |
U e = et Audio Clack Source | Internal Il
— File Cache Scheme — bdonitoring
| Yirtual Tape Recorder ;l @ Tape Type
) Record Enable Type
¥ Recorded Buffers qo direct to dizk {7 Global Dizable
— MIDI Sync Reference MIDI to Audio Delay Pricrity
{1 Time Code I i S amples I Marmal II
(@ Audio Clock

The System dialog.

2. Make sure that “ASIO Multimedia Driver” is selected on the ASIO De-
vice menu.
Again, this assumes you are using a regular Windows audio card. If you have
a card for which there is a special ASIO driver, you should select that driver.
See the electronic documentation for details.
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3. If required, adjust the Number of Channels in the Audio Performance
section.
How many channels you will actually be able to use depends on your com-
puter’s processing power, the speed of the hard disk and other factors.

4. Click Apply.

5. Click on the ASIO Control Panel button.
The ASIO Multimedia Setup panel appears. This is used to set up your audio
card.

ASID Multimedia Setup |

— Prezetz
I Cuizkom j
— Dutput Parts
M ame Statuz  Sync Ref
SB1E Wave Out [220] Active ez
— Input Portz
M ame Statuz  Sync Ref
SB1E Wave In [220] Active Mo
Advanced Options ... | Help
Cancel |

The ASIO Multimedia Setup panel.

6. Pull down the Presets pop-up menu.
This contains pre-programmed setups for some common audio cards, but you
can also add your own Presets here (see the electronic documentation).

7. Select the Preset for your audio card.
There may be several Presets for a single audio card type. For example, you
may be able to select a “half duplex” or a “full duplex” setup. “Full duplex”
means that the card has the ability to record and play back at the same time,
which is a great benefit. If your audio card supports this feature (see the audio
card documentation), make sure to select the “full duplex” Preset.

8. Close the dialog by clicking OK and then close the System dialog.
Once the settings are done, they are automatically saved together with the
program.
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If there is no Preset for your audio card

If you cannot find a Preset for your audio card model, you need to set up the «
manually:

1. In the ASIO Multimedia Setup dialog, click on the “Advanced Options...”
button.
A dialog with more settings appears.

ASI0 Multimedia Setup - Advanced Options

— Sample Rate
|441 00 Hz vl Buffer sizes (in the lists below] are set separately for
each sample rate selected here.
r— Output Port — Preset
Audio  Buffer Size  Offset Audio Sync
Device Mame Buffers [Samples] [Samples] Channels Reference Custam j
SB16 Wave Dut [220] 3 2756 i 2 Yes
Stare [Velete |
i~ Port Order
SB16 W ave Out [220] [Sync Reference] Mave up |
— Input Port: Move down |
Audio  Buffer Size  Offset Audio Sync
Device Mame Buffers [Samples] [Samples] Channels Reference
B 5616 Wave In[220] 3 2 0 2 No Bl ST
Sync Reference
ISampIe Pozition - Output j
IEard Options j
Check Synchronization ... | Detect Buffer Size ... | Help | Cancel | QK I

2. Locate your audio card in the Output and Input Port lists and make sure
the checkboxes to the left in both lists are activated for your card.
If you have more than one audio card in the computer, only one should be
active at this point. See the electronic documentation for info on more ad-
vanced options.

3. If your card has the ability to record and play back at the same time
(“full duplex”), make sure that this option is activated on the Card Op-
tions pop-up menu in the lower right corner of the dialog.

If you are unsure about your specific card’s ability, check its documentation.

4. Click OK to close the Advanced Options dialog and the basic ASIO Mul-
timedia Setup dialog, and finally close the System dialog.
The settings are automatically saved together with the program, but you can
go back later and save your Advanced ASIO Multimedia settings as a Preset
(see the electronic documentation).
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Enabling/Disabling Audio

Frocessng ’
Pool Ctrl+F
Edit Audio...

Generate SMPTE...
ShEten.

[/ Diiepuo—, —|

On the Audio menu you will find a setting called Disable Audio, which allows y:
to disable all audio input and output. This feature is mainly for two situations:

e When you only want to record and play back MIDI and don’t want to
waste processing power on the audio engine.
This allows the computer to use all its power for screen updates and MIDI
playback.

* When the computer you use is not powerful enough to run Cubase VST
with the VST engine enabled.
Note the following:

e The setting is automatically saved in the Cubase VST preferences. This means
that if you disable the Audio Engine, it will remain disabled until you enable
it again.

e Itis only CPU processing power that is preserved. The program will still use
the same amount of primary memory (RAM) and disk space.

e All audio functionality is actually intact, it is only audio recording, playback
and synchronization that are disabled. If you like, you can for example per-
form “silent editing” of audio in this mode.

Disabling audio on startup

e To disable audio on startup, hold down [Shift] while launching Cubase
VST.
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Setting up MIDI

This section describes how to connect and set up MIDI equipment. If you have
MIDI equipment you can skip this section and move directlyatge 56

Connecting the MIDI Equipment

The descriptions below describe four setup examples for small MIDI systems.
might need or want to hook things up differently!

Example 1A - Using the same Keyboard for recording and playback, via a
separate MIDI Interface

1. Connect the MIDI Out of the instrument to a MIDI In on the MIDI inter-
face.

If you have several, it doesn’t matter which MIDI In you use. Cubase VST can
record from all inputs on a multi-port interface.

2. Connect a MIDI Out on the interface to a MIDI In on the instrument.

«® MIDIIn
1 =@ MIDI Out

Your MIDI interface may have more than one MIDI Out. Each MIDI port can
address up to 16 different devices (or the 16 different voices in a multitimbral
module ). On smaller MIDI interfaces, the Outputs all carry the same informa-
tion, so it doesn’t matter which you use.

On larger, multi-port interfaces, the MIDI Outputs are all separate, that is,
they carry different sets of the 16 midi channels. This allows Cubase VST to
send MIDI data selectively to different MIDI channels on any of the available
outputs. If you have a multi-port interface, you should connect the first output
to your instrument, and use the following outputs if you need to connect
more instruments.
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Example 1B — Using a Keyboard with a built-in MIDI Interface

If your instrument has a built-in MIDI interface, no MIDI cables are needed, onl
serial cable (see the instrument’s documentation for cable specifications).

. Make the connections with computer and instrument turned off.

. Connect the cable between the serial port on the computer and the com-
puter connection on the instrument.

Many instruments have a special switch that needs to be set for the computer
connection to be active (see the instrument’s documentation).

m» Computer Connection

The connection above allows you to feed the computer with the signals from tl
keyboard, during recording. It also allows you to send MIDI signals from the c«
puter to the instrument during playback.

Example 2- Using a separate Keyboard and Sound Module

If you have a separate MIDI keyboard, that produces no sound, and a sound m
without keyboard, you should hook things up as in the picture below. Using Cul
VST’s MIDI Thru feature (described later) you will still be able to hear the sour
from the sound module while playing the keyboard and when recording.

-

«@ MIDIIn
1 =@ MIDI Out
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Example 3 — Adding more devices using the MIDI Thru connectors on the

instruments.

«® MIDIIn
=@ MIDI Out
=@ MIDI Thru

You might want to use more instruments for playback. Connect MIDI Thru on
first instrument to MIDI In on the next, and so on. In this hook-up, you will alwa
play the first keyboard when recording. But, thanks to the Thru connection, you
still use all your devices for providing sounds on playback.

e If you plan to use more than three sound sources we recommend that you ei-
ther use an interface with more than one output, or a separate MIDI Thru box

instead of the Thru jacks on each unit.

Example 4 — Using a separate Keyboard and MIDI Card

If you have a card in your computer with a built in MIDI synthesizer, you don't
need to make any MIDI connection to get Cubase VST to play back from the c
However, to be able tecord MIDI data you needt leasta separate MIDI key-
board, that produces no sound but only transmits MIDI signals. This should the
connected to MIDI In on the computer.

|<—MIDI Synth
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Setting up the Instruments

If you have a General MIDI, Roland GS or Yamaha XG compatible instrument
make sure it is set to its GM/GS/XG mode. If you have other types of instrume
set each Sound (Timbre, Part, Program, Patch) to receive on a different MIDI C
nel.

Setting MIDI Thru and Local On/Off

In the “MIDI Setup” dialog on the Options menu, you will find a setting called “MIL
Thru” which can be enabled or not. This is related to a setting in your instrument ¢
“Local On/Off” or “Local Control On/Off”.

¢ |f you use a MIDI keyboard instrument, as described in Example 1 earlier in
this chapter, MIDI Thru should be activated and that instrument should be set
to Local Off (sometimes called Local Control Off — see the instrument’s oper-
ation manual for details). This will let the MIDI signal from the keyboard get
recorded into Cubase VST and at the same time re-routed back to the instru-
ment so that you hear what you are playing, without the keyboard “trigger-
ing” its own sounds.

When “MIDI Thru” is active in
Cubase VST, MIDI data received is
immediately “echoed” back out.

MIDI data coming in to
the instrument is played
by the “Synth” inside it.

t 3 AN
[ ====== L [Synth7]
When you ]
press a key, it 1 J41k
is sent out via . .
MIDI to When Local Control is On in the

Cubase VST. «m» MIDIIn  ingrument, the keys you press will be
=@ MIDI Out played by the “Synth” inside the Instrument.
When Local Control is turned Off, this
connection is cut off.

e |f you use a separate MIDI keyboard, that does not produce any sounds itself,
as in Example 2, MIDI Thru in Cubase VST should also be activated, but you
don’t need to look for any Local On/Off setting in your instruments.

e The only situation where MIDI Thru should be deactivated is if you use Cu-
base VST with only one keyboard instrument and that instrument cannot be
set to Local Off mode.
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Checking your MIDI Setup
1. Play your MIDI keyboard.

2. Check the “In” indicator on the Transport Bar so that you are sure that
Cubase VST receives MIDI data.

3. If you have Thru activated, the “Out” indicator should indicate Output
of data.

When this lights up, Cubase VST is
transmitting MIDI data.

o [ [120.000]
0404
1ok | TempoiSig

Jnc:

l
When this lights up,
Cubase VST is receiving

4. Make sure you hear the instrument that you are playing.
If not, check your MIDI connections and Cubase VST’s MIDI Thru setting.
Also check the audio equipment and audio connections.

5. If you listen to the sound of the same instrument as you are playing,
make sure the sound from the instrument doesn’t sound “thin” or
“flanged”.

If it does, you have probably not set the instrument to Local Off. This means
that every key you press is played twice, once directly on the instrument and
once via MIDL.

Saving the settings

The Audio Hardware Setup settings are automatically saved by Cubase VST.
other settings you have made you will want to save, so that you don’t have to
them each time you launch Cubase VST:

1. Pull down the File menu and select “Save As...”.
2. Click on the “Song” file type selector.

3. Make sure you save in the same folder as where you have your Cubase
VST program.

4. Type in the name “DEF.ALL” (make sure you type the name exactly like
that, but without the quotes of course!).

5. Click Save.
Now the next time you launch the program, the basic Song settings you just
saved will automatically be loaded (see page 241).

-55-



Preparations done! Where do | go next?

There are basically two things we suggest you do:

e Read through the rest of this document and try out the different possibil-
ities as you go along.

e Read the sections of the electronic documents that interest you, to get
more detailed information about each section of the program.
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6

Recording Audio
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Preparations

Selecting a Sound Source

Before you begin recording, you have to select which sound source to record.
may for example have a microphone connected, as well as some kind of line |
instrument or mixer, and the audio output of an internal CD drive. Depending
which audio card you use, you may be able to make this selection from inside
base VST, by clicking the ASIO Control Panel button in the Audio System dial
(seepage 4% For many audio cards, however, the input source selection and o
settings are made in a small, separate application program included with the ¢
card. See the documentation for the audio card.

e Astandard stereo audio card often allows you to mix several input sources.
However, if you plan to record a single sound source, we recommend that
you turn down or deactivate the other sources, to avoid unnecessary noise.

Activating Cubase VST Inputs

Cubase VST allows you to use audio cards with several Inputs and route diffe
Inputs to different audio channels. This Getting Started book however, assume:
are using a “basic” 2 in/2 out audio card (or, if you have a larger audio card, th
you are using the two first Inputs only). Still, you need to make sure that these
puts are activated before you attempt to record anything:

1. Pull down the Audio menu and select Inputs.
The Input window appears:

Channel - 1

Channel - 2

The left column contains the available “physical” Input ports (in this case there are two
Inputs). The fields in the right column show the names that will be used for each Input
throughout the program. The middle column contain an indicator for each input pair,

showing which Inputs are active.

2. Make sure that the indicator in the middle column is lit.
If not, click on it so that it lights up. This shows that the Inputs are active.

3. Press [Return] on the computer keyboard to close the Inputs window.

e Read more about the Inputs in the chapter “The Input/Output Bus System” in
the electronic documentation.
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Choosing a Sample Rate

Before you can start recording you have to set the sample rate for the Song:

1. Open the System dialog (on the Audio menu).

Audio Syztem Setup EE

— Audio Perfarmance — Audio [/0
Number of Channele | 16 4510 Device 4510 Multimedia Driver ]
temony per Channel I 288 | kB ASIO Control Panel |
sk Block Buffer Sizel| 95 T kB Latency 750 Miliseconds
Apply Settingz do not take effect Sample Rate I 44.100 kHz ;I
&y | ] 2 b g |
U e = et Audio Clack Source | Internal Il
— File Cache Scheme — bdonitoring
| Yirtual Tape Recorder ;l @ Tape Type
) Record Enable Type
¥ Recorded Buffers qo direct to dizk {7 Global Dizable
— MIDI Sync Reference MIDI to Audio Delay Pricrity
{1 Time Code I ] Samples I Marmal II
(@ Audio Clock

2. Use the Sample Rate popup to select a sample rate.
This setting determines the audio quality of your recordings. The higher the
value, the better the quality, but when you raise the value, each recording
also uses up more disk space and computer processing power. For recordings
where the audio quality is important, 44100 Hz is the most common sample
rate. For multimedia purposes, or in situations where you want to keep the
audio files reasonably small, 22050 Hz may be a better choice.
Please note that some audio cards might only support a limited number of
sample rates (see the card’s documentation for details).

e This setting is done once and for all for the whole Song. You can not make
some recordings at one sample rate and others at some other sample rate.

3. Close the dialog by clicking OK.

Once the settings are done, they are automatically saved together with the pro
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Setting a tempo and time signature for the Song

Before you start you should decide for a tempo and time signature. These are
adjusted on the Transport bar:

The tempo determines the “speed” of
For now, we recommend you the music. The number is in beats
leave the Cycle deactivated. (quarter notes) per minute. x

[ Reptace || =L [ 0001.01.000 | a0 |
-,.EEEMDEI'E - _ Left Locator

iz

B 20T e
I_mz?ﬁ Right FETIT ]
For now, make sure Master is not
activated on the Transport bar.
The time signature determines the overall “feel” of the beat. 4/4, for
example is often used in rock and pop. 3/4 is used for waltz.
Tempo tip

A good way of setting the tempo is to activate playback and adjust the tempo o
Transport Bar while listening to the metronome (Click) that is generated on ea
beat (quarter note). For the metronome to be heard, you need to make sure tf
Click button on the Transport bar is activated:

Click activated on the Transport Bar.

180000 |
| 0401 |

T,em_p.qIEiug,'.Z
e If you start playback with Click activated and still cannot hear the metro-
nome, you need to adjust the settings in the Metronome dialog on the Op-
tions menu (use the Online Help to find out about the parameters and options
in the dialog).
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Selecting and setting up a Track

Before you select a Track to record on, it is necessary to understand somethir
about audio channels and how Cubase VST handles mono and stereo recordi

e All audio is played back via audio channels. The maximum number of audio
channels is determined by the settings in the Audio System dialog and your
computer/hard disk performance.

e Each audio channel can play back one mono audio recording at a time.

e Stereo recordings play back on two audio channels, one for each “stereo
side”. A stereo channel pair always consists of an odd channel and the next
even channel (eg. channel 1+2, 3+4, etc).

e Channels that are used in stereo pairs cannot be used for mono recordings.

For more information on audio channels, see the chapter “How Cubase VST t
dles Audio and MIDI” in the electronic documentation.

Set up a Track for recording as follows:

1. Select an Audio Track by clicking on its name field in the list.
An Audio Track.

A M|C|T|Track Chr L
ay Yocal 1 1
- Yocal 2 2

& Tpt1
b Tnt 2

= |-

* If you don’t have any empty Audio Tracks in your Arrangement, you need
to create one, for example by using the Create Track item on the Struc-
ture menu.

To make sure the Track is an Audio Track, position the mouse in the “C” col-
umn for the Track, pull down the pop-up menu and select “Audio Track”.

& | M

1
—

Track [
e Yocal 1

B woiTask PR

Drum Track
bix Track

puiorece , |l

roup Track
Tape Track
Chard Track
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2. Set the Track's channel (Chn) to the audio channel you plan to record on.
If this is the first Audio Track you record on, select 1. Generally, you should
avoid using a channel already used by another Track, since each channel
only can play one recording at the time.

Track
Yocal 1
Vocal2 |
Tpt1
Tpt 2
Tpt 3
Tpt 4
Tbn 1
Alto 1
Alto 2
Tenor 1
Tenor 2

The “any” channel setting is explained in the electronic documentaion. For
now, select a “normal” channel number.

e If you plan to make a stereo recording, you need to select an odd channel
number.

3. Open the Inspector.
This is done by clicking on the Inspector icon below the Track list.

# Amange - Mel's smells
[Solo | Snap [178 =] Quant
ﬂ! Track Info | & M| C|T | Track Chr
. | vocalz | | |%| Vocall |1
Click on this icon... Vocal 2 1
I 0  Delay & Tpt 1 1
[T Chan s |Tpt2 1
ML & Tbhn 1 2
(P Bl | 4 Ao 2
Record Info & Alto 2 2
T 1
...to open the j T::E: > g
Inspector. ——— || Enable| Status
Tons 4 Track 3 3=
iy B aritone LT
K DhAadnna n
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4. Decide if you want the recording to be mono or stereo by using the

Mono/Stereo switch in the Inspector.

The label on the switch (Mono/Stereo) indicates which mode is currently se-
lected for the Track. But the switch also indicates whether it is possible to
switch mode or not:

ENaDie | Sats ENanie | SLats
The Track is set to Mono. You The Track is set to Stereo. You can
can switch to Stereo by switch to Mono by clicking on
clicking on the button. the button.

|=|'I-3|:'|E'| 2rarLs |:|'|-5||:'|E'| araLs
The Track is set to Mono and cannot be The Track is set to Stereo and
switched to Stereo. This is either cannot be switched to Mono. This
because the Track is set to an even is because there is already a stereo
channel, or because the next channel is recording on the Track.

already used for a mono recording.

If you select Stereo for a Track, it will use the audio channel you set in step 2
above for the left side of the stereo recording, and the next channel for the
right side. These two channels are then reserved for stereo use, so that no
mono Track can be set to any of these channels. For more information about
this, see the chapter “How Cubase handles Audio and MIDI” in the On-line
documentation.

. Double click on the Track name, type in a new name for the Track and
press [Return].

Now you need to make sure that the correct inputs are selected for the audio
channel(s) you have selected:
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6. Pull down the Audio menu and select Monitor.
The Monitor mixer window opens.

< YST Mixer M= B

AlTo

7. Locate the “mixer strip” for the audio channel(s) you have selected for
recording.
There is one mixer strip for each audio channel (the value you set in the Chn
column for the Track on page 62 in this chapter). At the top of the strip, you
find a button with the name of the Input selected for the channel.

8. Hold down [Control] and click on the Input button to pull down a pop-up
menu with the available Inputs.
In this example, we assume that you are using a “regular” audio card with
stereo inputs, but you may also have more advanced audio hardware with
several inputs.

< YST Mizer

| [ | —

— ——
o EE 1
et N[ | N[ | OO | OO —

9. Select the Input to which your sound source is connected.
If you have selected Stereo above, you need to select different Inputs for the
two audio channels.
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10.Go back to the Arrange window and click on the Record Enable button
in the Inspector, to make the Track and its selected audio channel ready
for recording.
If this is the first time you enable audio recording in the Song, you will be
asked to select a folder for storing your recorded audio files.

Selecting a folder for your Audio Files

When you enable recording for the first time in a new Song, a file dialog box v
appear, asking you for a folder for your audio files. The folder you select will b
used to store all audio files recorded for the Song. If you have the opportunity,
recommend that you store your audio files on a separate hard disk.

* If you want to change folder during the session, you can do this at any
time by selecting “Select Audio File Folder” on the File menu.
This opens the same file dialog, letting you select a new folder, which will be
used from that point on.

Monitoring

As described opage 46you can monitor via Cubase VST or directly via the aud
card.

If you monitor via Cubase VST, and Record Enable a Track, monitoring is usu
automatically activated for that audio channel. This means that you will hear t
audio source connected to the channel input, when in Stop mode and when ac
recording.

* You can also turn “Cubase” monitoring on and off manually, by clicking
on the Input button in the Monitor window or in the Inspector.

auto IR g 7 chan
T 1]
Treert Wl e Y
m E Recard Infa
e
...... [P

e If you cannot get monitoring in Cubase VST to work at all, pull down the Au-
dio menu, select System, and check if the Global Disable monitor option is
selected (if this function is enabled, Cubase VST will not provide monitoring
at all). Select Tape Type monitoring, exit the System dialog and try turning
monitor on in the Inspector again. The other monitoring options are described
in the Online help.
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Checking the Input Levels

Digital recording (as in Cubase VST) is different from analog recording when i
comes to recording levels. Whereas with analog recording it is often perfectly
ceptable to let the “needle hit the red” (record at levels actually higher than the
tem can reproduce accurately), thisad true when it comes to digital recording.

The term used here lieadroom The headroom is the difference in level betweel
the signal you record and the maximum level the system can handle. When th
nal increases, the headroom diminishes towards O dB (decibels).

When the signal is stronger than the system can handle - when you exceed tt
available “headroom” - in a digital recording systéward clippingoccurs, which
results in clearly audible and very unpleasant distortion. To avoid this, you shc
use the Input meter function in the Monitor window to accurately check the rec
ing levels, and then adjust the input level in one of the ways described in step
low.

1. Pull down the Audio menu and select Monitor.
The Monitor Mixer window opens.

2. Click the “In” button above the level meter for the recording channel to
activate the Input meter function.

B | S| s

[ | [ | [

Hille

‘?

In this mode, the meter shows the signal level at the input selected for the au-
dio channel.

* If you are making a stereo recording, activate the “In” buttons for both
channels in the stereo pair.
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. Sing or play the connected instrument and check the meter and the nu-
meric level display above the fader.

The level should be as high as possible, without ever clipping (exceeding
0dB).

BN |
Clipping is indicated by the red
pping Y
=W -° ] clip light above the “In” button.
I

To reset the clip indicator, click
on it.

el |

4. If needed, adjust the recording level in one of the following ways:

Adjust the output level of the sound source or external mixer.

Use the audio card’s own application program to set the input levels, if this
possibility is provided (see the documentation for the audio card).

Click the ASIO Control Panel button in the Audio System dialog in Cubase
VST and adjust the input level in the control panel that appears.

This requires both that your audio card supports the ASIO Control Panel func-
tion, and that there are input level settings in the control panel for the card.

. When you are done, click on the “In” button again.
When the button is deactivated, the meters show the output level of each au-
dio channel.

. While you are in the Monitor Mixer window, you may want to adjust the

output level of the monitored channel.
Use the volume fader for the channel to set a comfortable listening level.
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Performing the first recording

Setting start- and end-points for the recording

There are several ways to start and end recordings. In this example, recording
start at the position of the Left Locator and end at the Right Locator (for more |
about this, sepage 8).

To position the Locators, Simply click on the ruler - the left mouse button sets
Left Locator to where you clicked, the right button sets the Right Locator.

Recording

1. Make sure the buttons on the Transport Bar are set up like this:

I 0005.01.000 0005.01.000 00:00:05:08

- LeftLocator ~ \e———
é 0012.01.000 | <«
: T

2. Click the Record button.

| 180.000]

3. After the two bar count-in, start performing.
Recording will automatically be deactivated when you reach the Right Loca-
tor, if you don’t hit Stop before that.

4. When you are done, press Stop.
The program will now calculate an image file so that a waveform can be dis-
played in the program. Depending on the length of your recording, this may
take a few seconds, during which a dialog box shows the progress of the cal-
culation.

The program has now created an audio file in the folder you selected)orb5
The file will appear in the Pool (a window containing a list of all audio used in
Song, se@age 150 In the Arrange window, a Part is created between the start
end points of the recording. The Part contains an audio segment, which in turr
plays back the whole audio file you just recorded.

Cluantize I'IE Tl Mouse | 0001.07.000 | Part Colars =]

L

- 68 -



e Asegment is a piece of an audio file. Read more about audio files and
segments in the chapter “How Cubase handles audio and MIDI” in the
electronic documentation.

Listening to the Recording

1. To hear what you just did, use the Transport Controls to move back to the
beginning of the recording and click Play.

2. Stop when you are done.

If you don’t like what you just recorded

There are two ways you can get rid of a recording that you are not satisfied wi

Using Undo

If after recording you select Undo from the Edit menu, the Part you just created
disappear and you can record again. However, the audio file still resides on the
disk and there is a segment for it in the Pool (sege 151for details). You can al-

ways later delete unused segments and files, so this is nothing to worry about

Deleting the Part
The other option is to manually delete the Part and then record again on the T

* If you delete the Part as you would with a MIDI Part, it disappears, but
the segment and the audio file are not deleted (just as when you use
Undo, see above).

e If you select the Part, hold down [Control] and press [Backspace], a dia-
log appears, asking you if you also want to delete the audio file. To do
this, click OK.

This is the method to choose if you are sure you permanently want to delete
the recording.
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Recording more on the same Track

To record more on the same Track, proceed as follows:

1. Move the Left Locator to the next position where you want to start re-
cording.
This can be at a “free” area on the Track, or at some place where something is
already recorded, as described below.

2. Make sure the Right Locator is to the right of the Left Locator. If it isn't,
please move it.
Move the Right Locator by clicking in the ruler with the right mouse button or
by changing the value in the Right Locator box on the Transport Bar.

e You cannot activate recording if the Locators are positioned in “reverse or-
der”.

3. Activate recording just as you did the first time on the Track.
A new file is automatically created.

About overlap

When you record again, where something has already been recorded on the T
you will get a new Part which overlaps the previous one(s). However, when yo
play back, only the Parts that you can actusdigare played back. Generally: One
audio channel can only play back one audio file at the time.

Recording the Next Track - Overdubbing

Recording the next Track is done just as with the first. Here follows a summar
the steps:

1. Select another audio Track and make sure it’s set to another audio chan-
nel.
2. Set up the Locators and activate recording.

Now, the previously recorded Tracks will play back and you are able to record
new Track as an overdub.
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7

Basic MIDI Recording
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About this chapter

In this chapter, you will learn how to make a basic MIDI recording.
This chapter assumes the following:

e That you have connected a MIDI keyboard (or other controller) and some
kind of MIDI sound source. As described in the examples in the chapter “Set-
ting up your System”, this could be a MIDI keyboard with a built-in sound
source, or any combination of a MIDI controller and a sound module, exter-
nal or built-into the audio card in the computer.

e That the MIDI sound source you use is General MIDI compatible and set to its
General MIDI mode.

e That you are already familiar with Audio Recording as described in the previ-
ous chapter.

e If your instrument is not General MIDI compatible, you will not be able to se-
lect sounds from the Program pop-ups in Cubase VST (see page 76). How-
ever, the actual recording procedure will be the same.

Tempo, Time Signature and Click

If this is your first recording in a new Arrangement, set up the time signature, tel
and Click as described grage 60n this document.

Selecting and naming a Track

Tracks with a note symbol in the “C” column are for MIDI recording. An Arrang
ment can contain an unlimited number of MIDI Tracks.

1. Select a Track by clicking on its name in the list.

* If you don’t have any empty MIDI Tracks in your Arrangement, you need
to create one, for example by using the Create Track item on the Struc-
ture menu.

To make sure the Track is a MIDI Track, position the mouse in the “C” column
for the Track, pull down the pop-up menu and select “MIDI Track”.

2. Double click on the Track name, type in the name you desire and press
[Return].
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Setting MIDI Channel and Output

Setting the MIDI Channel in the Instrument

Most MIDI synthesizers can play several sounds at the same time, each on a
ent MIDI Channel. This is the key to playing back several sounds (bass, piano
from the same instrument.

Some devices (such as General MIDI compatible sound modules) always rece
on all 16 MIDI Channels. If you have such an instrument, there’s no specific set
you need to make in the instrument.

On other instruments you will have to use the front panel controls to set up a
number of “Parts”, “Timbres” or similar so that they receive on one MIDI Chant
each. See the manual that came with your instrument for more information.

Setting the MIDI Channel and Output in the Track List

1. Set the Chn column for the Track to the same MIDI Channel as you just
setup to use on the synthesizer.

2. Drag the Track List Divider all the way to the right, to reveal the Output
column.

Dragging the Divider...

Track 2
4| Track 3
Track 4

...reveals the Output column

[nstrument

MPU-401
MPU-401 __
MPU-401 .
MPU-401 __

= arma

Track 2
Track 3
Track 4

- L ] —

1 = Ld P
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3. Make sure the Track you plan to record on is set to the MIDI Output that
the synthesizer is actually connected to. If it isn’t, pull down the Output
menu for that Track and select the desired MIDI Output.

If you only have one standard MIDI interface, that is limited to 16 MIDI Chan-
nels, then this setting is probably correct as it is. If you for example have a
standard MPU compatible interface installed, this should say something like
“MPU-401".

Clicking in the Output column
brings up a pop-up which lists
the available MIDI Outputs

plus an item called MROS. —

ange - Untitled 2

14

q

Snap |Bar [uantize 16

[mztruimment

SETE MIDI Out [330)

4| Track 3 3 Creative Music Synth [2]
& | Track 4 4 MROS
4| Track B h 5 AW

- L ] -
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Selecting a sound and setting levels

When you play your keyboard, you should now hear the sound that the instrur
plays on this MIDI Channel (the Track’s “Chn” setting).

To select a sound and adjust its level, proceed as follows:

1. Pull down the Edit menu and select “GM/GS/XG Editor”.
. Structure Functionz  Optio

ndo Chil+

i (Bt

[Eamy [Efr{+E

Easte (BT

Delete Track [rel

Select L4

Copy to Phase..

Edit Ctril+E

T E T 15N N N N T I Y Y R T Y N
0
1

e~ T

Matenad .‘\ Chl+R Pan OOOOOOOOO OOOOOO

Revert| 40 [ 40 [0 a0 [ 40 [40 [0 [ a0 [40 [40 [0 [a0 [40 a0 a0 [ a0
EhoruslTl_l_l_l_l_l_l_l_l_l_l_l_l_l_l_

S S Frogram | |
Fretless Bas blockenspl | MusmBox Puted Guit: || Standard ||| Flfth Lead || Ban|0
| Grand Piano [Church Organ | Pizzicto Str. || Ocarina |Brass Section | Marimba  fpnth Bass 1] Banjo

— Effects Device
|  Halz =l Revet | Chows3 =] Chos G5 2| Made G5 Feset |
E4 | Reverb Time I Tahit £ 2] Output Help |

A window with 16 sections of controls, one for each MIDI Channel, appears.

2. Locate the Device section in the lower right corner of the window.

3. Use the Mode pop-up to select GM, GS or XG Mode.
Select the mode that is appropriate for your instrument.

4. Pull down the Output pop-up and select the MIDI Output port that your
instrument is connected to.

5. Locate the channel section corresponding to the MIDI Channel you have
chosen.

6. Press the mouse button with the pointer over the “Program” box at the
bottom of the channel section.
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7. Use the hierarchical menus to select a sound.

Revert] 40 [ 40 [40 [40 [40 [40 [
Chawsl 0 Lo Lo [o o o[
Grand Piano —
Chromatic Perc * L\} L.
Organ ¥| E._Grand CL Or
Guitar ¥| Honky-tonk
Bass ¥ E.Piano 1
Strings/0Orch *| E_Piano 2
Enzemble ¥| Harpzichord
Brazs k| Clawi
Reed »
Pipe 3
s Sunth | fad 13 —

8. Play the keyboard to try out the new sound.
If you don't get the desired sound, this could have many causes:

e The Output of the GM/GS/XG Editor is not set to the MIDI Output that your
instrument is connected to. Check the Output popup menu in the Device sec-
tion.

* Your instrument is not set to its General MIDI (or GS/XG) mode. Make sure
the correct mode is selected on the Mode pop-up in the Device section, and
then click the button to the right (Iabelled “Reset” or “GM On/Off” depending
on the selected mode), to set the instrument to its GM/GS/XG mode.

Please note that when GM is selected, the button (labelled “GM On” or “GM
Off”) is used to switch the instrument in or out of GM mode. Click on the but-
ton to send the command that is currently shown on the button to your instru-
ment. In other words, to activate GM mode, click on the button until it says
“GM Off”.

e Your instrument is not set up to react to MIDI Program Change messages.
Consult the documentation for the instrument you are using.

* Your instrument isn't General MIDI compatible. In this case, you should set
the Mode pop-up in the Device section to “Off” and try selecting sounds for
each MIDI channel manually on the instrument instead.

9. Adjust the “Vol.” fader for the channel to adjust the volume of the sound,
if desired.

10.Close the window.

Verifying the Settings

Now when you play your keyboard you should hear the right sound in the synt
sizer (and only that sound). If not, check the following:

Is the Track set to the correct MIDI channel?

Is the Track set to the MIDI Output the instrument is connected to?

Do you have MIDI Thru enabled in Cubase VST?

Do you have Local Off activated in your instrument (if needed and/or availa-
ble)?

* Do you have the correct sound selected in the synthesizer?
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Recording

1. Set start and end points using the Locators, and decide if you want a
Click or not, just as when recording audio.
If you pull down the Options menu and select “Metronome...” you can select
whether you want an audio click from the computer (“Beep”) or a MIDI click,
or both. The MIDI click settings are described in the On-line help.

2. Click the Record button.
By default, you will get a two bar count-in. This can be changed in the Metro-

nome dialog.

3. Perform the recording and press Stop.
A Part appears.

You can now listen, Undo or record more on the same Track, just as with Audi
Tracks.
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About overlap and the Overdub/Replace switch

MIDI Tracks are different from Audio Tracks when it comes to overlapping Par
When you record again, where something has already been recorded on the T

the result is determined by the setting of the Overdub/Replace switch on the T
port Bar:

Overdub

0001.01.000 .E

_ Left Locator
0007.01.000 4«

ight Locator p—

In this mode, the new recording is simply added to whatever was on that Tracl
fore. When you play back, you will hear both recordings. This can be used cre
tively when you are recording in Cycle mode, as describpdde 92

Overdub Mode is probably the safest way to record. If you add too much musi
you can simply remove it later by editing (see the chapter “An Introduction to Ml
Editing”). Up until now, we have assumed that this switch was in Overdub moc

Replace

| Heplace 0001.01.000 | TRY
ode - Left Locator —
0007.01.000 4

‘Right Locator —

In this mode, whatever you record replaces what was previously on the Track.
place mode is probably the best choice if you have made a mistake and wish t
rect it by recording something new.
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Recording different types of MIDI Messages

There are a few facts about the recording of some types of MIDI messages the
be useful to know. If you don’t know too much about MIDI you may not under-
stand everything below. Later when you have gained a more thorough unders
ing, come back and read this information.

Notes

In MIDI, when you press and release a key on your synth or other MIDI keybo:
a Note On (key down) and a Note Off (key up) message are sent out.

The MIDI note message also contains the information which MIDI Channel we
used. Normally, this information is overridden by the MIDI Channel setting for t
Track. For more information about this, see the chapter “How Cubase handles
dio and MIDI” in the electronic documentation.

Continuous Messages

Pitch bend, AfterTouch and Controllers (like modulation wheel, sustain pedal,
ume etc.) are considered as MIDI continuous Events (as opposed to the mome
key down and key up messages).

About recording Continuous Messages

If you move the Pitch Bend wheel on your synthesizer while recording, this mc
ment gets recorded together with the key (Note On and Note Off messages), |t
you'd expect.

But the continuous messages can also be recorded after the notes have been
corded (or even before). They can also be recorded on Tracks separate from 1
notes they belong to.

Say for instance that you record one or several bass Parts on Track 2. If you nc
another Track, like Track 55, to the same Output and MIDI Channel as Track 2
can make aeparaterecording of just Pitch Bends for the bass Parts. This mear
that you activate recording as usual and only move the Pitch Bend wheel durin
take. As long as the two Tracks are set to the same Output and MIDI Channel if
appear as if the two recordings were made at the same time.

Program Change Messages

Normally, when you switch from one Program to another on your keyboard (ol
whatever you use to record), a number corresponding to that Program is sent o
MIDI as a Program Change message. These can be recorded on the fly with tr
sic, recorded afterwards on a separate Track, or manually entered in one of the
windows. You can also enter Program Change messages in the Inspector.
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System Exclusive Messages

System Exclusive is a special type of MIDI message used to send things that
make sense to a unit of a certain make and type. Every major MIDI manufactt
has its own Sys Ex identity code. Sys Ex can be used to transmit a list of the 1
bers that make up the settings of one or more sounds in a synth. System Excl
can be recorded just as any other messages and can be edited in List Edit.

This is discussed in more detail in the chapter “System Exclusive Handling” in
electronic documentation.

e You can prevent Cubase VST from recording certain types of MIDI data, by
using the Input Filter function. This is described in the chapter “Filtering and
Mapping MIDI data” in the electronic documentation.
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3

Recording Methods
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About Punch In and Out

Those of you who have used multi-track tape recorders know about a techniq
called Punching In. This is when you activate recording while the tape is rolling
you for example have made a mistake in the middle of a chorus, you can play
from the beginning of the chorus and just before the flawed section, punch in
replace that section with a new performance.

Punch Out is when you deactivate recording without stopping playback. If —in
example above — the chorus is followed by a verse which is perfectly OK, you
would punch out at the end of the chorus so that you don’t record anything on
verse.

In Cubase VST there are two ways to Punch In and Out: Manual and Automat

Automatic Punch In

1.

2.

Select a Track and set it up as necessary (as with any other recording).

If you are recording MIDI, decide if the new recording should replace
what is currently on the Track (Replace mode) or if you want to add to it
(Overdub mode).

This is done with the Rec Mode switch on the Transport Bar, as described in
the previous chapter.

. Set the Left Locator at the position where you want recording to be acti-

vated.

. Move the Song Position to some point before the Left Locator.

This can for example be done by using the Transport buttons (Rewind, Fast
Forward etc) or by changing the value in the Song Position box on the Trans-
port Bar. More info on page 103.

. Click on the Punch In button on the Transport Bar so that it is activated.

| overdub 0001.01.000 ‘W
[ Ren:h ~ Left Locatar l
0007.01.000 .
‘Right Lacatar -
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6. Activate playback.

Now, when the Song Position reaches the Left Locator, recording is automatic
activated, as you can note by observing the Record button on the Transport B

IR N

1. Set the Song
Position...

2. Activate playback...

3. When the program NN LA NI RN

reaches the punch in
point...

4. Recording is automatically activated!

7. Record.

8. Terminate recording either by stopping or by Punching Out (see below).
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Manual Punch In

1. Select a Track and set it up as necessary (as with any other recording).

2. If you are recording MIDI, use the Rec Mode switch to decide whether
the new recording should replace what is currently on the Track or add
to it.

3. Make sure Automatic Punch In on the Transport bar is not activated.
Punch In deactivated.:

0019.01.000 l

«  Left Locator L

0007.01.000 4

ight Locator -

4. Move the Song Position to some point before the position where you
want to Punch In.

5. Activate playback.

6. When you reach the right position, click on the Record button or press
[*] on the numeric key pad.

7. Record.

8. Terminate recording either by stopping or by Punching Out (see below).

About punching in on long notes

When you activate recording in Cubase VST, already recorded notes are neve
off, they will play to their end just as they did before you started this recording
This is true regardless of the Record mode chosen (Overdub or Replace).

About punching in on Controller or Pitch Bend data

Watch out when punching in and out on recordings with Pitch Bend or Control
data (modulation wheel, sustain pedal, volume etc), since this may lead to str:
effects (hanging notes, constant vibrato etc).

If you for instance punch out with the sustain pedal on your synthesizer down,
have instructed the program to keep the notes hanging, since the release of tl
pedal has not been recorded. During playback, Cubase VST may clean up Pit
Bend, Modulation and Damper pedal and Channel Pressure at the end of eact
taking into account what happened in earlier Parts. But, the way Continuous M
messages behave is still something to be aware of.
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Automatic Punch Out

1. Set the Right Locator to the position where you want recording to be ter-
minated.

2. Click on the Punch Out button on the Transport Bar so that it is acti-
vated.

| 00319 01000 W

- Ltlocator 0t

Punch Out activated

3. Now, recording is automatically deactivated when the Song Position
reaches the Right Locator.
Activate recording.

When the Song Position reaches the Right Locator... \‘

M-I T

Recording is automatically deactivated,

but playback continues. \

You can of course combine automatic Punch In and Out for a totally automate
cording.
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Manual Punch Out

1. Activate recording in any way you like.
You might for example combine manual Punch In and Out to fix an error in
an otherwise good performance.

2. When you reach the right position, click on the Record button or press
[*] on the numeric key pad.

3. If you like, Punch in again and record some more.

4. When you’re done, Stop Cubase VST.
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About the Cycle

Cubase VST can play back and record in a Cycle — a loop. You decide where
Cycle starts and ends by setting the Left and Right Locators. When Cycle is a
you can repeatedly listen to a section of the Arrangement, and record, adding

on each lap etc. Cycled playback is also convenient when editing and when me
adjustments in the Inspector.

Setting up the Cycle

1. Set the Left Locator to the position where you want the Cycle to begin.
2. Set the Right Locator to the position where you want the Cycle to end.

3. Click on the Cycle button on the Transport Bar so that it gets activated,
or press [+]on the numeric key pad.

Set up the Left and Right Locator...
uuantimw ouse | 0O11.07.000

Chi L
1

2
...and activate the Cycle.

0005.01.000 !

« _ Left Locator L
0009.01.000 |
Right Locator —
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Playing back the Cycle

When you play back with Cycle activated, the section between the Locators ge
peated indefinitely.

You can use any and all functions while the program is playing back. This fact
lows you to use Cycled playback for a number of things, many of which you w
learn about later in this manual:

e Rehearse a part before recording.

e Mute Tracks and Parts to try out variations on an Arrangement.

¢ Concentrate editing in the Audio and MIDI editors to a certain section of the
Song.

* Make adjustments in the Inspector, apply Quantizing etc, to fine tune levels
and grooves.

* Make settings in the Mixer, add EQ and Effects to Audio Parts.

e Make adjustments to the sounds in your MIDI instruments or try out a Track
with another sound.

* etc, etc.
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Recording in Cycle Mode

e The basic Cycle recording procedure is the same for MIDI and Audio Tracks.
However, the results are different, as described on page 91 in this chapter.

From the Left Locator

1. Set up the Cycle and activate the Cycle button.

Cycle On/Off
0005.01.000 l

- Left Locator —

0009.01.000 |

ight Locator —

2. Set up a Track to record on.

3. If you are recording MIDI, select a Record Mode (Overdub or Replace)
with the switch on the Transport Bar.
This is described on page 78.

4. Click the Record button.

5. After the count-in, start playing.

6. Keep playing on each lap of the Cycle until you are satisfied.
If you are recording MIDI, see the Cycled Recording Modes and Functions

described below.

7. Stop Cubase VST or punch out manually.
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From Before the Cycle

1. Set up the Cycle and activate the Cycle button.

2. Set up a Track to record on and select a Record Mode (Overdub or Re-
place).

3. Activate automatic Punch In on the Transport Bar.

Punch In activated.\

!i ;:Ixrerdul:- :

0005.01.000 ‘
«  Left Locator

0009.01.000

CcysieRes = Right Locater -

4. Set the Song Position to some point before the Cycle.

5. Activate playback.

When Cubase VST reaches the Cycle, recording is automatically activated.

6. Keep playing on each lap of the Cycle until you are satisfied.
See the Cycled Recording Modes and Functions described below.

7. Stop Cubase VST or punch out manually.

e If you Punch In manually before the Cycle, the Cycle is automatically turned
off!

Punching In and Out in the Cycle

Once you are in the Cycle you can punch in and out manually as many times a
wish without stopping in between. Simply click the Record button or press [*].
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About Recording Audio in the Cycle

If you are recording Audio in Cycle mode, the following happens:

During the entire recording, only one Audio file is created. However, this is split
into a number of Segments (one for each lap) which are “stacked” in the Audic
itor. Since the Segments are all on the same Track, this normally means that «
one of them will play back (the first “take” you recorded, since this is the top on
the Audio Editor). However, you can use this feature to assemble a “perfect” t:
from all the different Segments, by cutting out the best pieces of each Segmen
putting them together. This is described in the chapter “The Audio Editor” in th
electronic documentation.

e None of the Cycle modes and Functions used when recording MIDI (de-
scribed on the following pages) have any relevance to audio recording.
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About Recording MIDI in the Cycle

Basically, MIDI Cycle Recording can either be used to add new data for each
(overdub) or replace previously recorded data. However, there are a lot of spe
modes and functions available when recording MIDI in the Cycle:

Switching Tracks while recording

You can record on more than one MIDI Track while in the Cycle:

1. Set up a few MIDI Tracks that you wish to record on. Also set up the in-
strument(s) so that they play the right sounds on these MIDI Channels.

Snap IEIar EI Huantize 16

14

Mouze

A M C| T Track Chr L
& Flute 1
iy Strings L
& Bazoon
£ Tnangle 10
[ I |

A few Tracks set up for recording a four bar groove.

2. Enter recording in Cycle mode.
Record on the first Track.

3. Without stopping, select a new MIDI Track in the Track list or use the [1]
and [!] keys to step through the Tracks.
Selecting a new Track set to a different MIDI Channel and maybe Output, au-
tomatically routes your playing to the new sound.

4. Record on this second Track as with the first.

5. Keep recording on different Tracks until you are satisfied.
See the Cycled Recording Modes and Functions described below.

6. Stop Cubase VST or punch out manually.

Recording Sys Ex data in the Cycle

There is nothing that prevents you from Cycled recording of Sys Ex data (see
chapter “System Exclusive Handling” in the electronic documentation), althou
this can lead to serious confusion. In plain English: don't, if you’re not absolute
sure of what you are doing.
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Cycle Recording Modes

Switching Modes

On the Transport Bar you will find a small box labelled “Cycle Rec”. This is usec
select one of three “behaviours” when recording in Cycle Mode.

S F
e
—

The Cycle Rec Mode Switch

You can select any of the modes prior to, or during, recording.

e As always when you record, the regular Record Mode switch (Overdub/Re-
place) determines what happens with any MIDI data that is already on the
Track before you start Cycle Recording. For an explanation of the relation be-
tween the Record Mode and the Cycle Recording Mode, see page 97 in this
chapter.

Mix Mode

In Mix mode, everything you record is added to what was recorded before. Th
the preferred mode if you for example are building up a rhythm pattern in Cycl
mode. You can start with the hi-hat, add bass drum on the second lap, snare c
third etc.

Record some notes on the first lap...—_

2y )
llowing b s amphyodded | D DD §H P

to the existing notes

Punch Mode

In this mode Cubase VST automatically punches in the moment you play anyt
on a lap. Proceed as follows:

1. Select Punch Mode.

2. Start Recording in a Cycle.

3. If you make a mistake in the middle of the Cycle, simply wait until you
reach the correct position on the next lap, and start playing again.

What was previously recorded from this point to the end of the Cycle is re-
placed with what you play now.

-93 .



4. When you have a recording you’re happy with, you can turn off Punch

mode, Stop or Punch Out.
Record some notes on the first lap...

N
Whenever you start playing on an
upcoming Iép, your rlcl)evzlregcording >D >D ) ob Qb oh
will replace the notes from that <
point and onwards.

Normal Mode

The name Normal mode refers to the way Cubase VST behaves during norme
opposed to Cycled) recording. This allows you to record afresh on the Track e
time you enter the Cycle.

1. Decide if you want to overwrite earlier recordings on the Track or not,
by selecting a Record Mode (Overdub or Replace).
See page 78.

2. Select Normal Cycled Recording Mode.

3. Record something on a lap.
You will not hear what you recorded, on the next lap(s).

4. If you'd like to redo the recording, simply try again on any upcoming lap.
Everything you recorded on earlier laps is automatically deleted.

5. When you have a performance you like (a complete recording on a lap),
stop recording or switch to another Cycled Recording Mode.

Record some notes on the first lap... BN
D by b

If you play anything on any of the
upcoming laps, it will totally replace ob ob oh ob <b
your earlier recording. z

e Please note: a complete lap is only kept when the recording is stopped some
time during the next lap.
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Cycle Recording Functions

These functions are found on a pop-up menu that appears when you press th
mouse button with the pointer over the “Cycle Rec” text on the Transpowthike,
recording in Cycle mode

0001.01.000
« Left Locatar

0005.01.000

E— Delete Lazt Yerzion
Delete Subtrack E
F.ey Eraze .

Delete Last Version
If you just made a mistake on the last lap, proceed as follows:

e While recording, select Delete Last Version from the pop-up menu or
press [V] on the computer keyboard.

This erases your last recording. It doesn't matter if you didn't play anything for
eral laps, the last lapat you recorded anything as erased.

Delete Subtrack

If you make a mistake and don't wish to keep anything of what you've just recor
proceed as follows:

* While recording, select Delete Subtrack or press [B] on the computer
keyboard.

The Part is cleared (but not deleted) and you can instantly start inputting musi
again, without leaving Record mode.

Key Erase
To erase all notes played with a certain key, or keys, proceed as follows:

1. While recording, press and hold the relevant keys on the synth keyboard.

2. Select Key Erase from the pop-up menu or hold down [K] on the compu-
ter keyboard.
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Quantize Last Version

Quantizing is a function you can use to let the computer correct imprecisely ple
notes to the next correct timing position, defined by you. Quantizing is not irre
cable, it can always be undone unless you specifically “freeze” your Quantize.
base VST provides several different Quantize options, describeaoen208

If you want to Quantize everything you recorded on the last lap, proceed as foll

. Select a Quantize note value by using the Quantize pop-up at the top of
the Arrange window.

]
Lluantize 16 = Mouse I—
M O Off Off The Quantize pop-up
BAT E4 E4.
32T 32 32,
16T 16 1E.
o
AT 4 4
2T 2 2
17 1 1.

. Select Quantize Last Version or press [N] on the computer keyboard.

Just as with Delete Last Version, it doesn't matter if Cubase VST has played b
the Cycle several times since you last played anything, the lasidapcorded an-
ything onis Quantized anyway.
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About Cycled MIDI Recording and the Overdub/Replace Switch

As described opage 78the Overdub/Replace switch is used to decide if what y
record now is added to whatever was on the Track before or whether it should
place the existing recordings.

The same is true for Cycled Recording:

¢ If Overdub is selected, everything you record is added to what was previously
on the Track.

e If you select Replace mode, everything you record during one recording pass
(the time from which you activate recording until you deactivate it again) re-
places what was previously on the Track.

e The Cycle recording Modes and Functions described on the previous pages
only apply to what is recorded during one recording pass. For example, the
special Cycle Punch Mode does not delete any notes recorded on the Track
before, only notes that were recorded in the Cycle this time.

:e.clz)ert(;se(sja‘ly you have a Part already ﬁ ﬁ J) ﬁ ﬁ

2. You activate Cycled recording in
Overdub Mode to add more notes. ~ —_| ,b ‘b ‘b J)

3. If you now use the Cycle
Mode Punch function, you will
only replace the notes recorded
during the Cycle recording pass.
The previously recorded notes
are not affected.
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About Multi Recording

For both audio and MIDI, Cubase VST allows you to record on several differer
channels or Tracks at the same time. There are several uses for this:

* You can record several players playing “live” at the same time.
For this to be possible with audio recording, you would need an audio card
with at least as many separate inputs as there are players.

* You can record a MIDI instrument that transmits on several MIDI chan-
nels simultaneously.
In this case you could either simply record on one Track, and set the MIDI
Channel to “Any”, in which mode the Track will play back each recorded
Event on the MIDI Channel it was transmitted on. Or, you could use Multi
Track recording, to automatically record different MIDI Channels on different
Tracks.

* You can record MIDI and audio at the same time.
The “Any” Channel setting and the Multi Track Recording methods are de-
scribed in the chapters “How Cubase handles Audio and MIDI” and “Multi
Track Recording” in the electronic documentation.
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9

Playback, Tempo and the Transport
Bar
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The Transport Bar

Below, you will find a brief description of what each control on the Transport Ba
used for:

Activates Punch In

The Overdub/RepIace switch

(see page 78)
I I:Ixreru:lul:-

Handle Ddh
(move)

Record start point, Punch In
'/ point and beginning of Cycle

0004.01.000 0005.01.000 |

_ Left Locator

uun!_ﬁ,m.uuu {{ H‘
Right D catn:-k‘

|
Switches between/the Activates  Cycle Punch Out point
three Cycle Recording Punch Out On/Off  and end of Cycle
modes (see page 93)

Song Position Song Position
(Meter format) \‘ Position Slider y (Time format)

0001.01.000 0005.01.000 00:00:12:00

- Left Lacatar I —

0005.01.000 | < ¢ ' r\t I l“
Right Locater” | ‘ ;
Rewir(d Fast Forward/ Stop / \ Play \ Record

Activates automatic Tempo

quantization during record v/ Time Signature
0 @ 00:00:12:00 | 80,000 |
04104 Indicates MIDI

In/Out activity

T;m_p.niEhg,

Turns the Metronome Activates synchronization Turns the Master
On/Off to other equipment Track On/Off

Hiding and showing the Transport Bar

To hide the Transport Bar, select “Hide Transport” on the Windows menu, or p
[F12] on the computer keyboard. To bring it back, select “Show Transport” fror
the Windows menu or press [F12] again.

When the Transport Bar is hidden, you can still access all its functions via the
puter keyboard. See below for a list of Transport Bar key commands.

Moving the Transport Bar
You can put the Transport Bar anywhere you want it, by dragging the handles
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The Numeric Key Pad

The numeric part of the computer keyboard is used for many Transport Bar of
tions. Some of these are described in more detail later in this chapter.

Cycle On/Off Record
Num d
Go to Lock .
last Stop Lower Tempo
Go to \
Cue Point j

Raise Tempo
+

Play

&8
LECEEE

GoTo —
Right Locator (

e’

GoTo — J
Left Locator
Stop S J

In addition to this, the Page Up and Page Down keys function as Fast Forwarc
Rewind.

R

Enter

If you have a computer without a numeric key pad, some transport commands
still available from the regular keyboard (the picture shows American key caps

e )e]le] )< ]
Cytle ONOI Record  Play @@%

The Space bar also functions as Stop button.
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Basic Tempo and Time Signature Handling

Transport Bar and Master Track Tempo

There is actuallya choice of two sources for Cubase VST’s tempo:

e When the song uses a steady tempo throughout, you can turn off the Master
button and simply set the right tempo directly on the Transport Bar. The tempo
can be adjusted at any time, even while playing back.

e When the song contains tempo changes, you need to use the Master Track,
(which is Cubase VST’s tempo Track but also more!). For those tempo changes
to actually “happen” on playback, the Master button on the Transport Bar
must be activated. This is all discussed in the chapter “The Master Track” in
the electronic documentation.

112.000] 120,000/
0404 04/04
Tgrn_p.ru:.uif-:n"_ig'.: T_EI'I'I_EI.EIIE_LQ.-.:

Mazter

-
The Tempo setting on the The Tempi set on the Master Track are
Transport Bar is used. used and shown on the Transport Bar.

Setting the Transport Bar Tempo

The tempo on the Transport Bar is adjusted like any other valupggeein this
document). The value is in BPM (Beats Per Minute). The integer and fraction |
can be adjusted separately, if needed.
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Setting the Song and Time Position

Using Fast Forward and Rewind

The Song Position can of course be moved using Fast Forward or Rewind. If \
hold down [Shift] while clicking the button, Rewind/FF is much faster.

A i

Rewind Fast Forward

By double clicking in the Ruler

If you double click somewhere in the ruler, the Song Position Pointer is movec
there.

]

L3

Double-click in the ruler... ...to move the Song Position Pointer.

By using the Position Slider

The position slider is located on the Transport Bar. Drag the handle or click dire
somewhere on the line to move the handle there.

The range of the slider relates to the length of your Arrangement. This means tl
you drag the slider all the way to the right, the Song Position will appear at the
of the last Part.

0003.01.000 00:00:04:00

Dragging the Position Slider.
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About the Snap Value

When you change the Song Position in the ruler or by using the position slidel
something called “the Snap value” helps you find exact positions quickly. It do
this by limiting the possible points for positioning, to Bar, half note, quarter nof
etc. Snap can of course also be set to Off.

The Snap value is set with the Snap pop-up at the top of the Arrange window.

Shap I'IIE =I

| Off
_T Bar
__5 1/2
—
g -

| 1416

Value Description
Off Any position can be used.
Bar Movement is restricted to exact bar lines.
1/4to 1/16 Movement is restricted to the selected note value.

Shap I Bar II If Snap is set to Bar...

...Parts can only be dragged
to exact bar lines.

-

Shap I 1/4 :I If Snap is for example set to 1/4...

...Parts can be put on any
quarter note position.

Changing Position values on the Transport Bar

You can adjust the Meter or Time Position values on the Transport Bar, as desc
in the chapter “Basic Methods”. The Song pointer is moved accordingly.
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Making relative Position changes

If you double click on either position value and enter a new one, preceded by &
or “=” character, the song position is moved relatively.

ble click...
pouble clic a0 | 0005.01.000 L 00
ar ]
ol <J 1N
ar

...enter a value

preceded by + or — ... H m

ar —

00 << § M L

mar

...and the value

gets added to the ["] 0007.03.000 m

existing position.
—— | —

0o b << § M L

mr

Returning to the beginning of the Song

If the Song is stopped and you click the Stop button again (or press [0] on the
meric key pad), the following happens:

e The Song Position is moved to the Left Locator.
e If the Song Position is already at the Left Locator or to the left of it, the Song
Position is moved to the beginning of the Song.

This means that you can always click twice on the Stop button to return to the
ginning of the Song.

Going to the left side of the window
If you press the [Home] key on the computer keyboard, the Song Position point
moved to the left side of the window.

Going to the last Stop Position

If you press [9] on the numeric key pad, the Song Position moves to the place
last stopped at.
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Moving to the Locators

e If you press [1] on the numeric key pad, the Song Position is moved to the Left
Locator.
* |f you press [2] on the numeric key pad, it is moved to the Right Locator.

Using Cue Points

Cue points are used to quickly locate to any position. If you for example often
yourself jJumping to the beginning of the first chorus, set up that position as a ¢
point.

Programming Cue Points
1. Set the Song Position to where you want the Cue Point to be.
2. Hold down the [Shift] key and press any of the keys [3] to [8] on the nu-

meric key pad.
The key is now programmed with that position.

Locating to Cue Points

If you press any of the keys [3] to [8] on the numeric key pad, the Song Positic
moved to the position programmed for that key.
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Cueing

e This feature only works with MIDI Tracks.

Cueing is when you fast forward through the music while playing it. You might
have done this on a tape recorder. The big difference with Cueing in Cubase V.
that the music is played back with normal pitch.

1. Click and hold down the right mouse button with the pointer over the
Fast Forward button.

2. To change the speed of cueing, drag the mouse left/right while keeping
the mouse button pressed.
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Locators

Setting the Locators by clicking in the Ruler

1. Set the Snap value.

The Snap value restricts the positions you can move the Locator to, as with
the Song position, see page 104.

2. Click somewhere in the ruler with the left mouse button, to move the
Left Locator.
The Locator appears at that position. To move the Right Locator, click with the
right mouse button.

Click with the left mouse button... ...to position the Left Locator.

Setting the Locators on the Transport Bar

You can also adjust the Left and Right Locator position by changing the numel
values in the Locator boxes on the Transport Bar.

Making relative Position changes

Just as with positions (seege 105n this document) you can double click and er
ter a new value, preceded by a “+” or “~” character. When you hit [Return] the
cator is moved relatively.

Setting the Locators by selecting Parts

You can adjust the Locator positions to the range of the currently selected Pat

1. Select the Part(s) by clicking on it/them.
If the range includes several Parts, hold down the [Shift] key while selecting.

2. Hold down the [Alt] and [Ctrl] keys and press [P].
The Locators are positioned around the selected “block”.
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Pre-programming Locator Pairs

If you find yourself moving the Locators back and forth between the same posit
all the time, you can pre-program some Locator combinations for instant recal

1. Set up the Locators as desired.
2. Hold down the [Shift] key on the computer keyboard.

3. Press one of the Function keys [F2] to [F11] on the computer keyboard.
That key is now programmed with the current settings of the Locators.

Recalling Locator Positions

e Press the desired function key ([F2] to [F11]).
The Locators are moved to the memorized positions.
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Using Time Positions in the Rulers

If you'd like to use Cubase VST as a time based program, rather than a meter
(tempo) based one, you can change the position indicators in any window, as
lows:

1. Locate the Mouse Position box.
In the Arrange window this is located on the Status Bar (the area directly
above the ruler).

2. Click once in the box.
Now the ruler and the Mouse Position box change to show time positions in-

stead of meter positions.

Meter Positions The Mouse Position box
'/_

tize IE EI Mu:nu%ﬂﬂ#.m.ﬂw | Part Colors =]
L

Fi

Time Positions ?‘

tize 2 x| Mousg | 00:00:14:00 | Part Colors =]

0o:00: 14:01

3. To switch back to meter positions, click again.

e Please note that even though you have switched to time positions, Snap is still
on and relates to meter positions. You might want to set Snap to “Off” when
using time positions.
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Working in the Arrange window
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About Tracks, Parts and arranging

A Cubase VST Arrangement is roughly structured in three “levels”: Séiracks
each containing a numberdrtswhich in their turn contaikvents(audio record-
ings, MIDI notes, etc). This chapter is about Arrangement editing - in other wol
the re-arranging of the larger building blocks, Parts and Tracks. This is done ir
Track List and in the right part of the Arrange Window, the area called the Part

play.

A |M|C| Track

& Anange - Swingin' C's

Shap IBar !I
I

Chr

Quantize I‘IB = Mousel

L

Yocal 1

-

Yocal 2

Tpt

= =i AEd ix)

Tbn

W[ [Mue Tt 6 |

Alto

Tenor

Baritone

Rhodes

Guitar

Bass

Drums

N PSSR ) PR P R P P e

Track 16

il =l =M M-~ RS BT R S S

Track 17

I Part Calars !I

Chorus

Chorus

Chorus

L=

An Arrangement with the Track List to the left and the Part Display to the right.

You can have up to 16 Arrangements in the same Song. How to create, open,
and set aside Arrangements is describedage 130
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What can | do with Tracks?

The Track is one of the most basic concepts in Cubase VST. Every time you re
something in Cubase VST, the recorded material is placed on a Track. You can
thousands of Tracks in each Arrange window, and you can easily move or cop!
terial between Tracks (if the Tracks are of the same kind - see Track Clasges,
119.

The most obvious reason for putting the recorded material on different Tracks
perhaps that you want to organize your music like an “ensemble” with one Tra
for each orchestral Part, or “musical instrument”. But there are also many othe
vantages of working with many Tracks.
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Creating Tracks

Create a new Track when you want to add another “layer” to your recording. Y
might for example want to add another “instrument”, or make room for an alterr
version of a part in your music. There are several ways to create a new Track:

By using the Mouse

M| C | Track M| C | Track
4 | Oboe 4 | Oboe
4 | Arco 4 | Arco
4 | String Pad 4 | String Pad
4 | Flute 4 | Flute
#  Tniangle #  Tniangle
i | Horns 4 | Homs
o [

Double clicking in an empty ...creates a new Track.
part of the Track List...

By using the Structure Menu

Selecting Create Track from the Structure menu will make a new Track appea
the bottom of the Track List. You may also use the keyboard short-cut [Control]-
to accomplish the same thing.

About Track Classes

As already mentioned, there are several different types of Tracks in Cubase V
When you create a new Track, it will get the same Class as the previously sel
Track, but you can change this later if you wish (s&ge 11}
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Naming Tracks

If you start with an empty Arrange Window (with no Tracks), and create a new
Track, it gets the name “Track 1”. Next time you create a New Track, this gets
name “Track 2” and so on. You can rename a Track at any time, simply by dot
clicking on its current name in the Track List, and typing in a new name.

Selecting Tracks

If you want to record on a Track, change settings for it or perform an operation
affects a whole Track, the Track has to be selected for Cubase VST to “undersit
which Track you wish to direct the action to. The selected Track is also called
“active Track”.

Track Chr
Yocal 1
Yocal 2
\» Tpt

Tbhn
Alto
Tenor

This Track is
selected (active).

= el

[ [ P

B aritone
Rhodes

There are several ways to select a Track:

== RIS RETERIE R SR TR LS R

[

e Click in the name field of the Track you want to select.

e Use the [1] and [1] keys on the computer keyboard to select the Track
above/below the currently selected.

e Press [Ctrl]+[Alt]-[T] on the computer keyboard, and type in the number
of the Track you want to select (counted from the top of the Track List).
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Changing the order of the Tracks

You can rearrange the Tracks in the list like this:

1. Press the mouse button with the pointer on the Track you want to
move. The pointer takes on the shape of a hand.

M| 2| Track | u

i J | Oboe
Arco

s | Triangle
J | Horns
g | Track ¥

2. Drag the Track with the mouse button pressed. A dotted outline
shows you where the Track will be placed.

M C | Track | b

1N & Oboe
1 |4 Aco
s | Flute

4  Tniangle
J’i" Hﬁr"g ..........................

”lacw .......... ¥

3. When you release the mouse button, the Track is moved to its
new position.

Track.
Oboe
Arco

Flute
Tnangle

Homs
String Pad
| Track 7

e All the Parts on the Track are moved with the Track.
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Duplicating Tracks

You may make a copy of a Track and all Parts on it.

1. Position the pointer on the name of the Track in the Track List.
2. Hold down [Alt] on the computer keyboard and press the mouse button.

3. Drag the outline of the Track to an empty field in the Track List.

kM| C | Track
Oboe

4

4| Arco
s | Flute
F

# | Tnangle
J | Hornz
4| Track ¥

4. Release the mouse button.

b4 Track
Oboe
Arco
String Pad
Flute
Tnangle
Horns
Track 7
String Pad String Pad

]

[ P P O S ) P

A duplicate of the selected Track is created and placed,
complete with Parts, at the bottom of the Track List.

e You can not duplicate empty Tracks.
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Deleting Tracks

You may delete a Track and all Parts on it.

1. Make sure that no Part is selected, by clicking in some empty area in the

Part Display.

This is to make sure that what you Delete will be a Track, not a Part.

Zalt Structure  Functions 0O

ption

Undo Chrl+2
i [Birfie
[ [Sir{HE
Easte [Eir{ie

| DeleteTrack __j Del |

Select

Copy to Phraze. ..

k

F it [hrl+F

Check that this menu item
says “Delete Track”, not
Delete Parts.

2. Press [Backspace] on the computer keyboard or select Delete Track on

the Edit menu.

e If you change your mind, you can undo the Delete Track operation with the
Undo option on the Edit menu, or by pressing [Control]-[Z] on the computer

keyboard.
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Track Classes

There are different types of Tracks, caldassesin the column marked “C” in the
Track List, a small symbol shows which class each Track has.

How to select a Class for a Track

| |..I"' | 1 enor | 3 Inero

Press the mouse button with | J | Banitone 5 Inkro
the pointer in the “C”
column for a Track... + | Rhodes B

Jii. Track 16 Fi

b

g Bass 9

F | Dram=z in
...to puII down a menu | |4 | DU | D o

where you can select a | |J~ | Rhodes | 8
o [

Track Class. =
MIDI Track
! Miz Track 0

Audio Track
Group Track

Tape Track
Chard Track

Converting a Track from one Class to another

If you have not recorded anything yet on a Track, you may at any time convert
any class. Just select the new class from the menu as described above. If the
something recorded on it you may not be able to select another class for the

o In the rest of this manual, if nothing else is stated, an operation applies to all
Track classes.
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The Basic Track Classes

L]

Audio Tracks
MIDI Tracks

Drum Tracks

Mix Tracks

Group Tracks
Tape Tracks

Style Tracks

Chord Tracks

Audio Tracks are used for recording and playing back
audio.

MIDI Tracks are used for regular MIDI recording and
editing.

Just like MIDI Tracks, Drum Tracks contain MIDI Events,
but Drum Tracks are tailor-made for use with the Drum
editor. See the chapter “Drum Edit” in the electronic
documentation.

A Mix Track contains data for the MIDI Mixer, a win-
dow that lets you control the volumes and parameters
on your connected MIDI devices, from inside Cubase
VST. See the separate document “The MIDI Mixer and
Mix Tracks”.

These are described in the chapter “Groups” in the
electronic documentation.

These are described in the separate document “Tape
Tracks — Controlling Tape Recorders”.

These are available if you have installed the Style Tracks
module, a device that lets you work with “Styles”, a
kind of automated accompaniment pattern. See the sep-
arate document “Style Tracks”.

Chord Tracks contain information about chord changes.
These chords are used by the Style Tracks, and in the
Score editor in Cubase VST Score.
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About Parts

Parts are the containers for your audio and MIDI recordings. The use of Parts
Cubase VST makes it easy to get a quick overview of the arrangement, and tc
move, duplicate or delete sections of music. On the following pages you find &
number of functions for working with Parts in the Arrange window.

* For more informations about what you can do with Parts, see the chapter
“The Arrangement-Working with Tracks and Parts” in the electronic doc-
umentation.

Creating Parts

Normally, Parts are created automatically when you record something, or wher
drag or import files into the Arrange window (sesje 153andpage 24» How-
ever, there are situations when you might want to create an empty Part, and th
it with Events in an editor. There are several ways to do this:

e Select the Pencil tool and draw a Part.
The length of the Part is restricted by the Snap value (see page 104).

e Set the Left and Right Locators to where you want the Part to start and
end, pull down the Structure menu and select “Create Parts”.
A Part is created on the active Track, between the Locators.

e Double click with the arrow pointer between the Left and Right Locator.
A Part is created on the Track where you clicked, between the Locators.

Naming Parts

When you record a Part, it gets the name of the Track. You can rename a Part
time, using one of the following methods:

e Select the Part, open the Inspector and double click on the name field.
Type in a new name and press [Return].

e Hold down [Alt] on the computer keyboard and click on the Part.
A small name value box opens, where you can type in a new name.

e For the name to be displayed in the Part, you need to have the option “Show
Names” or “Show Names and Waves” selected on the Part Appearance sub-
menu on the Options menu (see page 128).
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Selecting Parts

As with all elements in Cubase VST, you have to select a Part to be able to m
delete or in any way manipulate it. Selecting a Part can be done in several diffe
ways:

By clicking.
Clicking on a Part with the Arrow tool selects it, and deselects all other se-
lected Parts.

By shift-clicking.
If you hold down Shift and click on a Part, it is selected, but all previously se-
lected Parts remain selected as well.

By using the computer keyboard.

If a Part is already selected you can press the right arrow key on the computer
keyboard to select the next Part on the same Track. The left arrow key selects
the previous Part on the Track.

By enclosing Parts in a rectangle.
Click somewhere in an empty area of the Part Display and drag the mouse
with the button pressed. A dotted rectangle outline is shown.

Baz=zoon | Baz=oon

Strimnzs 2

When you release the mouse button, all Parts that were enclosed or
“touched” by the rectangle, become selected.

Strinns ?
If you hold down [Shift] when you start to drag, you don’t have to point at an
empty area, you can start with the pointer positioned over a Part.
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Selecting Parts using the Edit menu

On the Edit menu you will find an item called “Select” which brings up a sub-me
with a number of options that allow you to select all Parts on a Track, all Parts ir
Arrangement, to invert the current selection etc (see the Online help for a com
description of the menu selection options).

=6t Structure  Functions Ophtong Score Audio Mod

Unda Chrl+&
(BT Eipke Luantize 16
[Eapy (Bt e
Easte [Btr{Fs
Delete Track Drel T ——
Select Select Al Chled,
Copy to Phraze. .

Irevert
Edit Ctrl+E Qverlap
Lizt Ctrl+G Track Clazz
Cirurn Ctrl+D Inzide Locators
Score Ctrl+R Dutzide Locatars
GM /G5 /%G Editar Crl+ M|
Get Info Chrl+l Ereare | et k

*You can also select all Parts by pressing [Control]-[A] on the computer key-

board.
*You can also select all Parts on a Track, by holding down [Shift] and double
clicking anywhere on that Track.

Deselecting Parts

There are two principal ways to deselect already selected Parts:

e If you click in some empty area of the Part Display, all selected Parts get
deselected.

* If you hold down [Shift] and click on a selected Part, only this Part gets
deselected.
The other selected Parts remain selected.
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Manipulating Parts

e When you are moving, duplicating or changing the length of Parts, the result
of your actions depends on the Snap value, just as when moving the Song Po-
sition or the Locators (see page 104).

Moving Parts

You can move one or more Parts to a new position on any Track. Remember th
Snap value determines where you can place the Parts.

Press the mouse button with the pointer over the selected Parts
you want to move. The pointer takes on the shape of a hand.

Hihat
| Horns

...and release the mouse button. The Parts are moved. Note that
the relative distances between the moved Parts are kept intact.

Baszoon

Duplicating Parts

To duplicate Parts, proceed exactly as when moving, but hold down the [Alt] ke
the computer keyboard when you are dragging the Parts. You may move the c
cate to any position on any Track.

Other ways of duplicating Parts is to use the Repeat function, or Cut/Copy ant
Paste. These functions are described in the chapter “The Arrangement — Part
Track Operations” in the electronic documentation.
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Changing the length of a Part

You can change the length of a Part in the following way:

1. Select the Pencil tool from the Toolbox.

2. Click on the outline of a Part and drag the outline to set a new length.

Mute Tpt

e If you make a MIDI Part shorter, all Events in the removed section of the Part
will be erased!

Splitting a Part
You can use the Scissors tool to split a Part in two:

1. Select the Scissors tool.

2. Click on the Part.
The Part is split in two, at the position where you clicked (taking the Snap
value into account). The two Parts will have the same name as the original
Part.
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Joining two Parts

Just as you can split a Part in two, you can use the Glue Tube tool to “glue toge
two Parts. The two Parts do not have to touch one another:

1. Select the Glue Tube tool.

2. Click on the first Part.
The Part is joined to the next Part on the Track. The resulting, longer Part will
have the name of the first Part.

Fils 1. Fills 2
v
Fills 1
b}

¢ If you hold down [Alt] and click on a Part with the Glue Tube tool, all the
consecutive Parts on the Track will be joined into one.

Monitoring the contents of a Part

With the Magnifying Glass tool, you can perform what is known as “Scrubbing
This means that you can listen to the contents of each Part separately in Stop

1. Select the Magnifying Glass.
From there on, the procedure differs for Audio Parts and MIDI Parts:

2. To monitor the contents of an Audio Part, click anywhere in the Part.
You will hear the contents of the Part played back, from the point where you
clicked, for as long as you keep the mouse button pressed (or until the end of
the Part).

When you press the mouse button, the pointer takes on the shape of a speaker.

3. To monitor the contents of a MIDI Part, drag the pointer forwards or
backwards over the Part.
Notes and other MIDI Events will be played back according to how fast you
drag the pointer.
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Deleting Parts

There are several ways to get rid of unwanted Parts.
e Select them and press [Backspace] on the computer keyboard.
¢ Select them and use Delete Parts on the Edit menu.

e Click on the Parts with the Eraser tool.
If you hold down [Alt] when you click, the Part and all the consecutive Parts on
Track will be deleted.

e Deleting an Audio Part will not erase the actual audio file or the segment in
the Pool!
To delete an Audio Part and erase the corresponding audio file from the hard
disk, select the Part, hold down [Control] and press [Backspace].
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Part Appearance and Color

By using the Part Appearance submenu on the Options menu, you can choos
the Parts should be displayed in the Part display. The setting is global for all A
rangements in the Song.

Welfegel Score Audio Modules  Windows  Help

Chaze Events k
Multirecard P » ——
Part Appearance Show MNames
Fart B ackground... Show Events
v Follow Song F Show Frames
Record Tempo £ Mutes Shaow Mames and ' aves
MIDI Setup... v Mote On
tID Filker... v Faoly Pressure
|nput Transtormer. .. v LController
M etronome... v Frogram Change
Synchronizatian. . v After Touch
Bermaote Contral... v Fitch Bend
Setup MiZermaps... v Specials

There are four options:

¢ Show Names.
The Parts are displayed as boxes with the Part names.

e Show Events.
Each Part is displayed as a box containing a graphical representation of the E
in the Part. For MIDI Parts, you may define which types of Events should be d
played, by turning on and off the flags in the Part Appearance sub menu.

Events shown in Audio Parts and MIDI Parts.

¢ Show Frames.
The Parts are displayed as empty boxes.

¢ Show Names and Waves.
MIDI Parts are shown as boxes with the Part names; Audio Parts are shown
with names and a representation of the audio waveform.
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Part Color

To distinguish Parts, you may give them different colors. You have a choice of
user definable colors.

Adding Color to all Parts on a Track

1. Make sure no Parts are selected.
2. Select the Track in the Track list.

3. Select the desired color from the Part Color pop-up.
I Part Calgrpz F - ----------- > IPE"rt Calars j!

"w'hite

by
The Part Color pop-up is found
above the Part Display. [l Fefrain

Bridge
Il Intro

Coda

Chorusz

B Solo
/ Percuzzion !

Choosing one of the colors from the W Drumz
menu adds color to the Parts. I Guitar

 Ea::

B Flute

[ Stings
B Fevboard
[l Fiano

Click here to edit the Il 5axophone

colors and names. —— Edit...

Adding Color to some Parts
1. Select the Parts.

2. Select the desired color from the Part Color pop-up.

Selecting different colors for different Parts can be very useful if you want to e
several Parts in a MIDI Editor. As described in the chapter “The Midi Editors-G
eral Information” in the electronic documentation, you can then choose to disg
the Events in the color of their respective Part, making it easier to distinguish 1
different Parts.
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Managing the Arrangements

As stated earlier, you can have up to 16 Arrangements in one Song. This secti
scribes some functions used to handle Arrangements.

Creating a new Arrangement

You create a new Arrangement by pulling down the File menu and selecting “N
Arrangement”, or by pressing [Control]-[N] on the computer keyboard.

Naming an Arrangement

To keep track of the different Arrangements in a Song, you can give names to ¢
Click with the right mouse button with the pointer over the current Arrangemer
name (to the left in the Arrange window’s Title bar), and type in a new name.

* If you choose to save an Arrangement to disk as a separate file, then the
name you give it while saving will be used as the Arrangement’s title next
time you load it.

Activating an Arrange Window

Normally, if you want to work in the Arrange window, you click on it to activate tt
window and bring it to front. However, if you have a lot of Arrangements in yoL
Song, some of them might be obscured and impossible to activate this way. T
you can use the following method instead:

1. Pull down the Windows menu.
At the bottom of the menu, you find a popup with all Arrangements in the

Song:
Windows Sl
Casos —
Lie | Part Calars
Stack -
e s . | |
Stactk Edians
Hide Tranzport Bar F12
Arrangernents amingin' o'z
ard symphony !
mel's zmell
[ htitled S

2. Select the desired Arrangement from the list.
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Saving and Opening Arrangements

The basic file format for Cubase VST is the Song file, but you can also save a
open Arrangements separately, using the “Save As” and “Open” commands ol
File menu. This makes it possible to transfer recordings from one Song to ano
Save the Arrangement containing the recordings, open the other Song and op«
Arrangement you saved.

* Read more about Saving and Opening in page 237.

Closing an Arrangement

If you select Close on the File menu, press [Control]-[W] or click on the windov
Close button, the following alert message will appear:

Arrange - Pubert theme |

Do wou want ko zave thiz arangement’?

Yes! | Mi | SEt.-'-‘-.aidel Cancel

Select one of the following options:

* Yes.
Opens a file dialog where you can save the Arrangement for later use. After
saving, the Arrangement is closed.

* No.
Closes the Arrangement without saving it.

* Set Aside.
The window is closed, but the Arrangement is kept ,“hidden” in the Song. To
open a Set Aside Arrangement, pull down the Windows menu and select it
from the Arrangement popup menu there.

* Cancel.
Cancels the operation, i.e. the Arrangement is not closed.

e Please note that there is no “Close Song” command! Even if you close all Ar-
rangements, the Song is still there. To create a new Song, use the “New Song”
command on the File menu.
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The Track Columnsand the Inspector
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The Track Columns

The Track columns show names and settings for the Tracks. These settings ¢
changed directly. The headings are the same for all Tracks, but may have a sli
different meaning for different Track classes. Not all columns apply to all Tracl
classes.

Getting the Track Columns to appear

The Arrange Window is divided into two parts, the Track columns to the left an
the Part display to the right. To get all of the Track columns to appear, press t
mouse button with the pointer positioned above the Divider (the border betweel
two parts of the Arrange Window) and drag it as far to the right as possible. Yo
should now be able to see all of the Track columns.

4 Anange - Bridge ARR
[FSolo | Shap IBar = Cuantize I 16 =] Mouse I
7 S 5
Strings 2 SB16 MID_. | EI¥Y S5
4 | Bazzoon 3 SB16 MID.. | EI¥ Bzn
~ | Triangle 10 SB16 MID_. | 52 Jaz= LLELT LLELT
& | Strings 1 L4 SB16 MID.. | EIV Sir
| Dirumkit 10 SB16 MID.. | 52 Jazz
& | Dull bass 2 SB16 MID.. | Hord Dullbass
* | Yocal 1 1 Y51
F| /

The Divider, dragged as
far right as possible.

Changing the order of the Track Columns

You can arrange the vertical columns in any order you like, by simply dragging
headings to the left and right, respectively.

If you drag to the left, the column will be inserted to the left of the column you

"drop it on". If you drag to the right it will be inserted to the right of the column y«
"drop it on".
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The Activity Column

This column is only shown if the checkbox “Activity Display” in the Preference:
dialog (reached from the File menu) is activated. The column, with the headin:
“A”, shows if any MIDI/audio is being sent out from the Track at the moment. T
width of each bar represents velocity for notes. The activity column applies to

dio Tracks, MIDI Tracks, Drum Tracks, and Group Tracks.

Strings 2

4 | Bassoon
| |'-. | Triannala
The Activity Column as it looks when notes are played back.

e This column cannot be moved!

The Mute Column

The Mute column is indicated by an “M”. By clicking in this column, you tempc
rarily “silence” the Track. A black dot is displayed in the column. To make the

Track sound again, you just click in the Mute column again.

Click in the "M" column... \

Track

Chi

b
\

Lead vox

Lead vox2?

_ﬁ

Chirp

L R A

Track 8
...to Mute the Track. The black dot

indicates that a Track is Muted.

== ST LE

e 2 1D

Track

Chr

Lead vox

i

Lead vox2

P

Chirp

= = 1O
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The Solo function

If you click on the Solo button in the upper left corner of the Arrange window (|
press [S] on the computer keyboard), all Tramlksepthe selected are Muted. This
is useful if you want to listen closely to the contents of a Track, and don’t want
other music to interfere.

4 Anange - Bridge ARR

The highlighted Solo button

indicates that Solo is —ﬂm Shap IH
activated. A || Track Chn
> |@  t | Flute 1
All Tracks except the ;’ ® |} | Sinngs 2 h
| AT ———
— @~ Tnangle 10
> @ ) Stnings 1 L
~—> @ | Drumkit 10
~> @t | Dull bass 2

You can unmute one or more Tracks while in Solo mode if you want to
hear, for example, just how two or three Tracks sound together.

When you deactivate Solo, all Tracks will return to the Mute status they
had before Solo was activated.

If any MIDI notes are sounding at the moment their Tracks are Muted,
they are allowed to play until their end.

It is also possible to Mute single Parts, using the Mute tool.
This is described in the chapter “The Arrangement - More on what you can do
with Parts and Tracks” in the electronic documentation.

About the “M” sign in the Mute column

For Audio Tracks, the Mute column serves a second purpose: when monitorin
activated for a Track, an “M” is displayed in its Mute column. This is only an in
cation; you cannot change the monitoring status by clicking in the column. The
Mute function works as usual, regardless of the monitoring status.
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The Class Column

This column is indicated by a “C” and is used to set a Track to a certain Class.
page 119or a thorough explanation.

The Time Lock Column

This column is indicated by at "T". If you click in it, a lock symbol will appear,
meaning that Events on the Track are fixed in time. The uses for this are exple
in detail in the chapter “Time Locked Tracks” in the electronic documentation.
Normally, you should make sure that no Track is Time Locked.

A Time Locked Track. \

& |M C| Track T |Chn | Output I
+| Track 1 vy 1 |SB16MID.
+| Track 2 a2 |SB16HMID..
| || Track 3 ' |3 |SB1GMID.. |

The Track Column

This column shows the Track's name. To enter or change a name, double clic
this field for the relevant Track.

The Chn Column

The Chn column shows the Audio/MIDI Channel for each Track. You may chat
the channel of a Track at any time. For a full explanation of Audio/MIDI Chann
and the effect of changing them, see the chapter “How Cubase handles audio
MIDI” in the electronic documentation. To avoid confusion, please take your til
and read that chapter.

e The Chn column has different functions for Chord Tracks and Tape Tracks (see
the separate documents about Styles and Tape Tracks, respectively). The col-
umn is not used at all for Style Tracks, Mix Tracks or Group Tracks.
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The Output Column

For MIDI and Drum Tracks, the Output column shows which physical MIDI Outf
each Track uses (see the chapter “How Cubase handles Audio and MIDI"). Fo
dio Tracks, this column will always show the word “VST”.

& M| C| Track Chr | Output [riztrument ]
& | Flute 1 SB16 MID.. | 53000
£ Strings 2 L4 SB16 MID.. | EI¥ St
4 | Bazgoon 3 SB16 MID..  EIV Bzn
| Triangle SB16 I'-ED--
4| Strings 1 i SB16 MHD_. | EIV Sk

To change Output for a MIDI Track, position the pointer in its
Output column, press the mouse button...

A | M| C| Track Chir | Output Irstrurnernt T|
| Flute 1 | SB16 MID.. | 53000 |
2| Strings 2 £ SE AWE32 MIDI Spnth [E2]
4 | Bassoon 3 e
B [[Triangle e R |
. Puzic Sunth [2]
& | Strings 1
- MROS
~ | Drumkit 1‘1

...and select the MIDI Output you want
from the pop-up menu that appears.

If you hold down [Control] while you change the Output value, all Tracks
will get the selected Output value.

The function of the Output column for Mix Tracks is described in the chapter
“The MIDI Mixer and Mix Tracks” in the electronic documentation. The func-
tion of the column for Chord Tracks is described in the separate document
about Styles.

The column is not used at all for Style Tracks, Tape Tracks or Group Tracks.

The Instrument Column

In Cubase VST terms, dnstrumentis simply a certain MIDI Channel together
with a certain Output. Instruments can be defined for MIDI Tracks and Drum
Tracks.

Defining your different MIDI Channel/Output combinations as Instruments can
practical, since you can do this once and then not have to check the actual Ch
and Output settings. The concept is more thoroughly explained in the Instrum:
chapter in the electronic documentation.
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Using the Inspector

e The information in this section is mostly relevant to MIDI Tracks/Parts only.
For Audio Tracks, the Inspector is mainly used to set up the Tracks for record-
ing, as described on page 62.

What is the Inspector?

The Inspector is a part of the Arrange Window. It contains a number of value- .
name fields, where you can change settings and properties of a Track or indiv
Parts on a Track.

There is one important thing to remember before you start working with the Ins
tor:

e The settings you make in the Inspector will affect the material during play-
back. You do not really change anything recorded.

When you play back notes from a Part...

== |

...they pass through the Inspector...

| i SYome

I { Tranzp

0 welae
...and are output, in this i
example transposed one fifth
(i.e. seven semitones) upward. , g'

The actual recorded material in the Part is not affected.

r 4]

This also means that Inspector settings, such as transposition, are not shown
you edit a Part. To make these settings permanent you need to use the Freez
Parameter item on the Functions menu, as describpdagmn147
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Getting the Inspector to appear

You open the Inspector by clicking on the strip with the little Inspector Icon bel
the Track column, or by pressing [Alt]+[Ctrl]-[l]]. An area to the left of the leftmo
column in the Track list appears. In this you find a number of value fields, nan
fields and buttons, described in the following pages.

[FSolo | Shap Im Lluantize IT_ZI
A |M|C| Track Chn PN
& | Flute
& | Strings 2
4 | Triangle 10 Trian Trian
4 | Strings 1
4 | Drumkit 10
4 | Dull bass Dull bazs
4 | Yocal 1 1
) o

Click on the Inspector Icon... I\j(g

...to open the Inspector.

Trackffo | [m]c] Track Chn
| Bassoon & | Flute 1
|Fitrurent & | Strings 2 L3
[ EMBs
Ouatput 4 | Triangle 10 Triang Triang
| SB1E MID.. + | Strings 1
| 3 Chan 4 | Drumkit 10
Patch + | Dull bass 2 Dull bas=
* | Yocal 1 1
Off  Bank
IT Prog
Off “alume
IT Tranzp
IT"-.-"E|DD
IT [relay
IT Length
IT Compr
IT Fan

* To close the Inspector, click on the Inspector Icon again.
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Changing values in the Inspector

By changing values in the Inspector, you make changes to your Parts and Tra
Some fields are duplicates of fields in the Track list, Audio Monitor Mixer or Gl
GS/XG Editor, while others can be found only in the Inspector. To get a basic |
of how to use the Inspector, follow the steps below:

1. Open the Inspector.
2. Select a MIDI Track on which you have recorded some music.

3. Check that no Parts are selected.
The heading of the Inspector should read “Trackinfo” - otherwise, just click on
an empty area in the Part Display.

4. Start playback.

5. While the music is playing, try changing the "Transpose" and "Volume"
values in the Inspector.
The transposition and volume of the played back music will change accord-

ingly.

Making Real-time changes with the Inspector

When you change the value of a parameter in the Inspector, the new value is i
diately sent out to the MIDI Output. This will affect not only the sound source ¢
signed to the selected Track, but all MIDI devices connected to the same Outp
the Track, and set to receive on the same MIDI Channel.

You may use this feature for setting appropriate values (e.g. volume, velocity ¢
while the music is playing.
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What is affected by the Inspector?

This depends on what is selected in the Arrange window. The following possik
ties exist:

When a Track, but not a Part, is selected

When no Parts are selected, the Inspector has the heading “Trackinfo”. The pi
eter values affect the selected Track, and all the recorded material (the Parts)

Track Info

I Bass i

Instrument
| Mord

The Inspector opened for the Track “Bass”.

One Part is selected
The Inspector has the heading "Partinfo". The parameter values affect the sel
Part only.

Fart |nfa

I Bazz verze

[Rztrunent
| Mard

The Inspector opened for the Part "Bass verse”.

Two or more Parts are selected

The Inspector has the heading "Partinfo”, and shows the parameter values of c
the selected Parts. If you change a parameter, you will get the question “Copy
to all selected Parts?”. If you click “Yes”, all the selected Parts will get the new
value, regardless of their previous settings. If you click “No”, the change only ¢
fects the Part whose values were shown in the Inspector.
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How MIDI Part and Track settings relate

As you have seen, you may change parameter values both for the whole Trac
for individual Parts on the Track. It is the latest change that “counts”. If you for
ample change the velocity value of a single Part and then set another velocity »
for the whole Track, the Part will also get this latest velocity value. Other param
settings for the Part will remain unaffected.

Make various settings for a Part... ...then change the velocity
value for the whole Track.

Track Infa Fart Info
aTs WErSE I Bazz I Basz verze
Irtrument Inztrurment Instrurment
| Mord | Maord | Mard
Cutpit Clutpat Clutpuit
| EE1EMID.. | SE1EMID.. | SE1E MID..
I_E— Chan I 2 Chan I 2 Chan
Hatch Fatch Fatch
. .

| _

[off Bark OF  Bark OF  Bank
[off Prg [0ff Prg [0 Prg
ri Wolurme i 73 Wolume
IJ 3 Tranzp I 0 Trahsp I 3 Tranzp

100 Veloo 22 T Weloo 22 Veloo

IT Delay IT Delay I— Delay
Iﬁ Length W Length i

IT Carnpr IT Compr ff Compr
m Fan W Fan Qff  Pan

Now the velocity value for the Part is changed to that of the
Track, but the other settings for the Part remain unaffected.
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The Fields and values in the Inspector

The Inspector contains hames, numerical values and pop-up menus. All these
tings can be changed using any combination of mouse and keyboard, as usual
all other changes, these can of course be done while the music is playing and

while recording.

The tables below contain the different parameters in the Inspectandary and

MIDI Tracks/Partsyespectively. For other Track classes, the contents of the Ins
tor may differ. For a more thorough explanation of some of these parameters,
the chapter “Inspector Real Time Parameters” in the electronic documentatior

Audio Parts/Tracks (Mono or Stereo)

Parameter

Track/Part Name

Delay

Chan

Input button

FX/EQ buttons

Record Info

Record Enable but-
ton

Mono/Stereo button

Explanation

If a Track is selected, this shows the Track’s name. If a Part is
selected, this displays the name of the Part.

Delays the playback of the Audio Track/Part. With a negative
value, Delay will cause the Audio Events to play earlier in-
stead.

The audio channel the Track uses, as described on page 61.
For Tracks set to stereo, both channels in the stereo pair are
shown (e.g. “3+4").

This is a duplicate of the Input button for the audio channel
in the Monitor mixer window.

Clicking this button activates monitoring for the channel,
while holding down [Control] and clicking allows you to se-
lect an Input for the channel. See page 64.

These are duplicates of the FX/EQ buttons for the audio
channel in the Monitor mixer window. See page 222.

Shows the name of the audio file currently assigned for the
recording.

Click this button to enable recording on the Track.

This is used to select whether the Track should be set to Ste-
reo or Mono. The label on the button indicates which mode
is currently selected for the Track. A lit up button indicates
that it is possible to switch mode (see page 63).
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Audio Parts/Tracks (“any” channel)

If the Track or Part is set to audio channel “any”, the Inspector appears differe
There are no FX/EQ buttons, and the Input and Record Enable buttons are rep
by a number of Monitor and Record Info buttons, one for each audio channel.

Track Info

I Audio 2
I 0 Delay

any  Chan

Record Info

ElEEN N
j5)efv)e
o jrofrifie)
 13) 1415} 16]

b onitors

The “any” channel concept is described in the electronic documentation.

MIDI Parts/Tracks

Parameter
Track/Part Name

Instrument

Output
Chan
Patch

Bank

Prg

Volume

Transp

Explanation
The name of the selected Track or Part.

The Instrument (Output and Channel) that the selected Track or
Part is assigned to.

The Output port for the selected Track or Part.
The MIDI Channel set for the Track or Part.

If you are using a soundcard with a built-in synthesizer that
supports SoundFonts (such as the Creative Labs AWE series)
you can use this field to select sounds for the synthesizer (see
the chapter “Program Change and MIDI Volume” in the elec-
tronic documentation).

Lets you associate a MIDI Bank Select message with a Track or
a Part, to make an instrument switch "program bank" (see the
chapter “Program Change and MIDI Volume” in the electronic
documentation).

Lets you associate a MIDI Program Change number with a
Track or a Part, to make a connected instrument switch sound.
If GM, GS or XG Mode is activated in the GM/GS/XG Editor,
clicking this field will open a hierarchical pop-up menu, where
you can select a GM instrument by name.

If you are using the Studio Module, Program selection is done
differently - see the separate Studio Module documentation.

A volume value for a Track or a Part. This setting is sent out as
a MIDI Volume message.

Lets you transpose the notes in a Part or on a whole Track.
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Parameter
Veloc

Delay

Length
Compr

Pan

Explanation

The value in this field is added to the velocity of the notes
played back.

Delays the notes. With a negative value, Delay will cause notes
to play earlier instead.

Changes the note length by a percentage factor.

Compresses/expands the velocity range of notes. This is done
by multiplying the velocities with a percentage factor (25% -
200%).

If for example you want to “even out” a Part with varying ve-
locity values, you could select a “Compr” value of 25, 50 or
75%. The smaller the value, the lesser the velocity difference
between notes. To compensate for the decrease in velocity, you
may want to add a positive value in the “Veloc” field.

In a similar way, “Compr” values greater than 100% will make
velocity differences greater.

Sends out a MIDI message, telling your instrument to place the
sound of the Part/Track in a certain position in the stereo field.
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When should | use the Track Columns and when should
| use the Inspector?

Many of the parameters in the Inspector have equivalents in the Track column:
member the following facts:

e The Inspector can affect both Tracks and single Parts. The Track columns only
affect whole Tracks.

e The fields with the same name in the Track columns and the Inspector have
exactly the same function. Changing the value in one affects the other as well.

Why then use the Track columns at all? Well, for one thing, it is very handy to h
instant overview and control over all Tracks at the same time. The contents of
Inspector will change depending on which Parts you have selected. There may
be situations when you want the Part display (to the right in the Arrange Wind
as large as possible, and therefore need to close the Inspector.
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Using Freeze Play Parameters

As already mentioned, the Inspector settings (or “Play Parameters”) do not ch
the MIDI Events themselves, but work rather like a “filter”, affecting the music
playback. However, sometimes you may want to make these settings perman
i.e. convert them to “real” MIDI Events in the Part. You might for example want
transpose a Part and then edit the transposed notes in a MIDI editor. For this,
need to use the Freeze Play Parameters item on the Functions menu:

1. Select the Part(s) with Inspector settings you want to make permanent.
If no Parts are selected, all Parts on the active Track will be affected.

2. Pull down the Functions menu and select “Freeze Play Parameters”.
Bank Select, Program Change, Patch, Volume and Pan settings in the Inspec-
tor will be converted to MIDI Events and inserted at the beginning of the
Part(s). All notes in the Part(s) will be modified according to the Transpose,
Velocity, Delay, Length and Compression settings in the Inspector, and the In-
spector settings will be reset.

e When you export a MIDI file, you can choose to have all Inspector settings
automatically included in the file, with no need to perform Freeze Play Pa-
rameters:

Before exporting, select “Preferences” from the File dialog and make sure that
the checkbox “Leave MIDI File Track Data as is” is not activated! Then export
the MIDI file, as described on page 244.
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Real-time Thru

In most MIDI recording situations, the Thru function in Cubase VST is used to
“echo” incoming MIDI data via MIDI Out. If you use the Thru function, the MID
data that Cubase VST receives via MIDI In is modified in real-time by some of
Playback parameters. This means that if you for instance set a transposition v
of 7 (semitones) and play your keyboard, all notes coming out via the MIDI Out
transposed a perfect fifth higher.

|

e

I
——— Notes from the keyboard...

| = Naume

I §  Tranzp

i ...are passed through the I_
H Inspector... N Welae

...and output again,
t d fifth d. -
ransposed one fifth upwar H

1
—h_

This allows you to try out what effect a certain parameter setting will have on t
music, before and when you record something. Since different Parts can have
ferent settings you must select the right Track and check that the Song Positic
somewhere within the Part that has the settings you want to try.

Track | I ! . w3

Track | I e
L ([ReatThu |

Track | —————1

The Part in the "cross" made up by the
Active Track and the Song Position is
used for real-time "Thruing".

e |t doesn’t matter which Part or Track you have visible in Part Info (you may
have stepped through the Parts and Tracks with the arrow keys on the compu-
ter keyboard), it is only the Song Position and Active Track which determines
which Part’s settings should be used for the real-time modification.

The real-time parameters used for modification are: Transpose, Velocity and C
pression.

You can also thru-put to up to four Instruments (Outputs and MIDI Channels),
the chapter “Multi Track Recording” in the electronic documentation.
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Using the Pool
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What is the Pool?

& vsT M=] B3
[Da = [view _=1[File 5 =
File Mame Diisk S Img Length Diate Time
Hear  Segment Skart End Length SFate Fange
= African. ey [os o} 255K 1997-06-03 17.58 -
g1 Africant i 264756 264712 44100 | I
= Sterloop way [0 (5] - 1TIK 1997 -06-03 1802
g1 Sterlood 44 177108 177064 44100 —H—"F——t+—P 1+ —+—1+—F+—F+—F——
= mutron3 wneay (o i - 517K 1997-06-03 1759
g mutrond.1 0 425273 428273 44100 f—= ——ad i
g1 shaort mu 243 234413 155954 44100 ——d d
g1 mutraon 7543 280165 204734 44100
g1 mutron 7543 382521 307090 44100 T
2

Every time you record on an Audio Track, a file is created on your hard disk. T
file is also added to the Pool, a window listing all audio files used in the Song.
way the Pool displays Cubase VST audio files and their contents is similar to 1
way the Windows Explorer displays lists of files and folders.

But Cubase VST is not restricted to playing complete files. It can also play any
tion of a file from the beginning, at the end, or some snippet in the middle, sho
long, it doesn’t matter. A specification for such a section of a file is cafleg-a

ment For each file that is used in the Song there will be at least one segment.
can be more. For example, different sections of an audio file might be used in 1
than one place in the song. All the segments are listed in the Pool.

This Audio File has four segments, playing different sections of the file.

517K \1 557-05-03

vm&lrun&wav C:
g  mutron3

zhort mu

mLtron

mLtron2

1]
2431
2431
2431

CE

425273
234413
280163
3F252

425273 44100
1:35934 44100
204734 44100
307030 44100

1

E

A

L

The number to the left of the name, shows how many
times each segment is used in the Song.

e Read more about files and segments in the chapter “How Cubase VST

handles Audio and MIDI” in the electronic documentation.

This chapter describes the basic techniques and information related to the Po
the electronic documentation you will find a lot more information.
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Opening the Pool

The Pool is opened by selecting “Pool...” from the Audio menu or by pressing
[Control]-[F].

How files and segments are displayed

Files
Each file is represented by a line in bold text, preceded by a triangle. For eacl
there are a number of settings and information, described in the chapter “The A
Pool” in the electronic documentation.
B African.way iZ: o 44 250K
I Sterloop way iZ: i 4 TN
Renaming a file
You can rename an audio file by double clicking on its name in the Pool and ty;
in a new name. This method makes it possible for Cubase VST to keep track c
name change. Renaming audio files in the Explorer or from the Desktofrés-
ommended.
Segments

Each file that is in use, has one or more segments, listed below the file in the
The segments have their own settings, described in the chapter “The Audio Po
the electronic documentation.

To display or hide the segments for one audio file, you click on the triangle pre
ing the file.

= mLtron3 weay i i o  STK
] mutrond. 1 0 428273 28275 44100 =
nj 1 zhort mu Fi=r Xl 234415 155954 44100
g2 mutron Tod 280185 204734 44100
:ﬂ 1  mutron2 o431 02921 307090 44100

To Show/Hide all segments for all files, select Expand/Collapse from the
pop-up View menu.
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Auditioning a segment

To audition a segment from its beginning, press and hold the mouse button witl
pointer over the speaker icon to the left of the segment name. The segment w
played back in its entire length (or for as long as you hold down the mouse but

=7 ImLtrond sy i 2 517k 1997 -05-10
mLtrons . [ 100 f_"""'"'!]f'{"'"*"’—_'
short mu 75431 100 - p——y

If you don’t wish to audition the segment from its beginning, you can click any
where in the waveform image to the right. The segment will play back from the
sition where you clicked, for as long as you keep the mouse button pressed.

Finding Out how a Segment is used in the Song

Next to the speaker icon for each segment, you will see a number telling how n
times in the Song this segment is used. A segment without numbers is not use
ywhere.

== mutron3 seay [ i P S1TK

g mutron3a 0 428275 428273 44100 e
@1 short mu 75431 234415 155954 44100

@2 mutron 75451 280165 204734 44100

@1 mutronz 75431 352521 307090 44100
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Dragging from the Pool to the Arrange window

One of the most important features in the Pool, is the possibility to drag segm:
into the Arrange window. This example makes use of the Quick Start Song inclt
on the CD-ROM:

1. If you haven’t already copied the Quick Start Song folder to your hard
disk, do this now.
See page 24.

2. Open the Song “Quick Start Song”.

3. Select New Arrangement from the File menu so that you get a new empty
Arrangement.
In this example you will not use the original Arrangement, even though it will
still be there in the background. -

4. Make sure you have a number of Audio Tracks at the top of the Arrange-
ment.

5. Set the tempo of the Arrangement to 70 BPM.

6. Pull down the Audio menu and select Pool.
A Pool window with a large number of audio files in it is displayed.

7. Resize and arrange the windows so that you can see the first eight Tracks
in the Arrangement, as much as possible of the Part Display and as much
as possible of the Pool window.

8. In the Pool window, select Expand from the pop-up View menu.

9. Now, below each file appears one or several segments.
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10.Position the mouse pointer over one of the segment names, and press
the button. With the mouse button down, drag the segment onto an Au-
dio Track in the Arrangement.
The picture sequence below shows this step in more detail.

1. Point at the
Segment name

o
A egment E\[\

=] oean ik §

2. Drag onto an audio Track in
the Arrangement

g2 mutron
v addis weavy ol
\2 addis way 7200

Joliz2 wvan :

4 Arrange - Untitled 2

[FSolo | Shap I'I.-"B = Cluantize 8T = ouse | D00S.01.000 | Part Colars
k| C | Track Chn

# | Track 1 1

# | Track 2 2

# | Track 3 3

# | Track 4 4

# | Track 5 5

# | Track b G

& Track ¥ 1

+ | Track 8 2 File/M ame

4 | Track 3 3 Hear/ Segment Stark End Lenatk

4| Track 10 4 j o

& | Track 11 5 o (]

& Track 12 G 3

234415

% zhort mu 7a431 120311 445;

4| Track 14 g |MPU-4 g2 mutron 75431 250165 2047
HE]| ~ addis way o

g2  addissvay 2000 275000 20300
[+ addis2 e of:

3. The Segment appears as a
Part in the Part Display

4 Amange - Untitled 2

Track
Track 1
Track 2
Track 3
Track 4
Track 5
Track b
Track 7
Track 8
Track 9
Track 10
Track 11

adladlsdisdi=dt At AE ST AN L

[P R TR SR - B TR LS
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11.1f the Part doesn’t appear at the place you intended, simply drag it to the
right Track and bar position.
As always in the Arrangement, the Snap value affects where the segment is
positioned.

12.Play back to hear the new Arrangement.

13.Drag another segment to another Track, and position it so that they start
at the same time. Play back to hear the results.

14.Continue like this to add more Parts to build an Arrangement.

Two tips:

e Remember that you can repeat Parts that are already in the Arrange-
ment.
This might be faster than dragging the same segment from the Pool many
times.

e Use the Cycle function to try out different files and see if they go well to-
gether.
The Cycle function makes the section between the Left and Right Locator re-
peat over and over again. Just place the Left and Right Locators where you
want them, click on the Cycle button on the Transport Bar so that it is lit, and
activate playback. Then drag files to positions inside the Cycle while the pro-
gram is playing back!

The Cycle button.

!| Cwerdub | (| W | |—uuu1 01.000 0001.01.000 00:00:00:00 120.000]
_— e 04/04
o
b1

:w_id‘e_ - _ Left Loeator lick | Tem i
i.-. By

1 —

| |

l ho iz | I I]I;I1l].l]4.192 44 ' [~ I l“ nc Faster
ﬂm@;ﬁ - Right Locator -
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Importing Files into the Pool

If you have any other audio file on your hard disk, and would like to use it in th
song, you can import it into the Pool and then drag it into the Arrangement, as
scribed above.

File Specifications

The Audio file must meet the following specifications:

e |t must be in Wave (.WAV, most common on PC computers) or AIFF ((AIF, Au-
dio Interchange File Format, most common on Macintosh computers) format.

e It must be an uncompressed 16 bit file.

* The sample rate (also called sampling frequency) of the file must be the same
as the one used in the Song (see page 59).

* The file can be mono or stereo.

Importing the file

1. Activate the Pool window.

2. Select Import Audio from the pop-up File menu.

e = W

Save Poal !

Load Poaol
Frepare Archive

Pranara bd aztar

A regular file dialog appears.

3. Select a file format (WAV, AIF or both) from the File Type pop-up.
Files of the selected type(s) are listed in the file dialog box.

4. Use the file dialog box to locate the file and select it.

* You can audition the audio file with the Play button.
When you click the Play button, its label changes to “Stop” and the selected
audio file is played back. Playback continues until you click on Stop, or select
another file.

* You can select several files by using the [Shift] or [Control] keys, in
standard Windows fashion.

5. Click “Open”.
Now, the File(s) will appear at the bottom of the Pool window, each complete
with a segment which can be dragged into the Arrangement (see above).

* Please note that you can also import audio files directly into the Arrange-
ment, using the “Import Audio File” item on the File menu (see the elec-
tronic documentation for details).
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Introduction
There are several ways to edit audio recordings in Cubase VST:

* By manipulating Audio Parts in the Arrange window.

* By changing file and segment settings in the Audio Pool (see the Audio Pool
chapter in the electronic documentation).

* By editing and trimming the Audio Events in the Audio Editor.

e By applying permanent editing and processing the actual audio files and seg-
ments in the Wave Editor (described in the Wave Editor chapter in the elec-
tronic documentation).

This chapter describes the basic features and techniques in the Audio Editor.
more detailed information, see the Audio Editor chapter in the electronic docur
tation.

About Segments, Events, Parts and Non-destructive
editing
As already mentioned, an audio segment is a section of an audio file. Basicall

each segment consists of a reference to an audio file, a start point and an enc
(calledStartand End Insetf'om now on).

An Audio Event can be viewed as a “box” containing a segment (together with
some additional settings). The Audio Part, in turn, is a “box” containing one or :
eral Audio Events (just like MIDI Parts contain notes or other MIDI Events).

When you edit an Audio Part in the Audio Editor, you do not change the actua
cording (i.e. the audio file), but rather the properties of the segment(s) and Au
Event(s) in the Part. The editing you perform is non-destructive, meaning that
audio data is lost. You can always change the settings back to the way they we
fore you started editing.
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Opening the Audio editor

To open the Audio editor, proceed as follows:

¢ Double click on an Audio Part,
or

1. Select one or more Audio Parts.
You can edit Parts from several Tracks at the same time, if you like.

2. Pull down the Edit menu and select Edit, or press [Control]-[E] on the
computer keyboard.

You can only have one Audio editor window open at a time.

The Audio Editor - overview

@ Sound Card - Track 10001.01.0000006.02.000

Edit Sola | [Walume z[[Gato =l[Do  =l[View =l Snap [ 8 _=I[ 00OT.01.000 I_
[ O00z02192 [ Ta Al I= | Quant [[8 nnnsuzn_nn

START ========= END ==== == === QPOINT ===== SEGMENT ============ FILE African.way

+|Sterool |
3 i }—-HH}VO—WM
a FHMMW%—’F—

| | I |

About Lanes

When you first open the Audio editor you will note that it is divided horizontally
into something we callanes You can move or copy Events between Lanes, but t
results of this are different, depending on the audio channel setting of the edit
Track:

e When Editing A Single Channel (Mono) Track.
If the Track is set to Mono, and set to play back on one specific audio chan-
nel, in the Arrange window (as opposed to being set to channel “Any”), the
Lanes all have equal value. The only reason for you to use more than one
Lane when editing a single channel Track is if you find that it gives you a bet-
ter overview of what is going on.

* When Editing a Stereo Track.
If the Track is set to play back in Stereo, the Audio Editor will show two differ-
ent Lanes, one for each stereo side. This means that if you edit a Stereo Track
set to channel 3, the Audio Editor will display lanes for channel 3 and 4.
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* When Editing a Multi Channel Track.
If you are editing a Track set to channel “Any” (or several Parts on different
Tracks), each Lane will represent one of the available audio channels. Which
audio channel each Lane “uses” is indicated by a number on the left side of
the window.

By moving an Event between Lanes with different channel numbers, you
change which audio channel the Event is played back on.

e This chapter assumes you are editing Parts on the same audio channel. For
more information about multi channel audio editing, see the Audio Editor
chapter in the electronic documentation.

How Audio Events are displayed

Normally, Audio Events are displayed as boxes containing a waveform - or twi
waveforms if the corresponding audio file is in stereo. In addition, several hanc
markers and other things can be shown in the Event. What is displayed depen
the setting on the View pop-up menu:

[iew =l

v Wavefarms

MI
v Handles

By Output
v Lane Info

Diynamic Events

Waveforms

This option governs whether the waveform(s) should be shown or not. Usually,
will want to leave this option activated.

Names

When this is activated, the name of the segment is shown in the top left corne
the Audio Event.
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Handles

Each Event has a Start and End Inset which represent the Segment start and
points in the audio file. If the “Handles” option is activated on the View pop-up
menu, handles for adjusting the Start and End Insets are visible in the upper ar
lower corners (respectively) of the Events. For information about how to adjust
Insets, sepage 166 in this chapter

ﬁl.ﬁ.hicanﬁl

i~
\
Start Inset handle Q-Point handle End Inset handle

The shape of the handle indicates what the Event actually plays:

- If this symbol appears at the beginning of the Event, it means that the
Event plays the audio file from the beginning.

o If this symbol appears at the beginning of the Event, it means that the
Event plays the file from some point later than the absolute beginning of
the file. The Start Inset has already been adjusted.

- If this symbol appears at the end of the Event, it means that the Event plays
the audio file to its end.

- If this symbol appears at the end of the Event, it means that the Event does
not play the file to its absolute end. The End Inset has already been ad-
justed.

e Even if the Event doesn’t begin or end inside the window, the Start and
End Inset symbols will be visible at the edges of the window.
If you have long Events, this allows you to see the “status” of the Insets (as de-
scribed above) without scrolling the view.

The Handles option will also show/hide the Q-Points (sage 16).

By Output

When this is activated, all Events that play back on the same audio channel w
displayed on the same Lane. For more information about this, see the Audio E
chapter in the electronic documentation.

Lane Info

If this option is activated a field will be shown to the left of each Lane, displayil
the number of the corresponding audio channel.
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Dynamic Events

When this is activated, the lower part of the Audio Event will display a volume
curve, a pan curve or Match Points. This is all described in the Audio Editor cha
in the electronic documentation.

About Q-Points
In the Audio Event, you will also find a vertical line with a handle, marked “Q”.

This is the Q-Point, a marker that is used for snapping the Event to musical pc
tions.

Mrican5|
=t e

The concept behind this is that with audio, as opposed to MIDI, the beginning
the Event might not occur at a musical position at all, there might for example |
significant amount of silence at the beginning of the recording.

This means that snapping the beginning of the Event to a musical position norn
doesn’t make much sense. Hence Q-points. These allow you to specify a positi
the Segment which is to be taken as it's first “musically significant position”, th
first down-beat for instance.

* To move the Q-Point in an Audio Event, just click and drag the Q-handle.
For the Q-Point to be visible, “Handles” must be activated on the View pop-
up menu.

For more info about working with Q-Points, see the Audio Editor chapter in the
electronic documentation.
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Which Audio Events will | Hear?

If any two Audio Events try to play back on the same audio channel at the san
time, only one of them will be heard. This is shown in the pictures below:

ﬂl 1=t Fartl

The "1st Part” Event is cut off by the "2nd Part” Event.

ﬁl MainB Eat|

The "MainBeat” Event is cut off by the ”Fill-in” Event. After the end of this shorter Event, the
"MainBeat” Event will be heard again.
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Creating Audio Events

There are three general ways to create new Audio Events in the Audio Editor:

* By recording.
Audio Recording in the Audio Editor is done just as in the Arrange window. If
you are editing several Parts on different Tracks, you determine which Part to
record into by clicking in the Lane Info field to the left in the window.

e By importing.
If you select the Pencil tool and click somewhere in a Lane, a file dialog will
open. Locate and select the audio file you want to import, and click OK. An
Audio Event is created at the position where you clicked (taking the Snap
value into account), and the file and segment is added to the Pool.

The file specifications are the same as when importing into the Pool (see page
156).

e By dragging segments from the Pool.

This is done just like dragging segments into the Arrange window (see page
153).
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Manipulating Audio Events

This section describes some of the basic ways of manipulating Audio Events.

Moving Events

Audio Events are moved just like other objects in Cubase:

1. Select the Arrow Tool.
2. Select all Events you want to move.

3. Press and hold the mouse with the arrow pointer over one of the selected
Events (not in the handles) and move the mouse.
The mouse box shows you where the Q-point of the first selected and
dragged Event will wind up when you release the button.

4. If you want to restrict movement to horizontally or vertically, hold down
[Shift] while dragging.

5. Release the mouse button, and the selected Events are moved to the new
position.
The Snap function applies, positioning the Event so that its Q-point gets
aligned with the closest Snap value.

You can also make fine adjustments to Event position, using the Hand tool. Tt
described in the Audio Editor chapter in the electronic documentation.

Duplicating Events

This works just as when moving Events, except that you press [Alt] and hold il
down while you are dragging the Events. The duplicated Audio Events will pla
new segments, with the same properties as the original.

e If instead you want the duplicated Event to play the same segment, you
can create a Ghost Copy of the Event, by holding down [Control] while
you are dragging.

The advantages of this are that you don’t get a lot of identical segments in the
Pool, and that you can edit one segment, and have your changes affect sev-

eral Audio Events at once. For more info about Ghost Copies, see the Audio

Editor chapter in the electronic documentation.
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Changing Start and End Insets

Changing the Start and End Insets is the main way to trim your Audio Events.
There are a couple of things to think about before starting:

* Snap to Zero.
If the option “Snap To Zero” in the Audio menu is enabled, all offset adjust-
ment will be followed by an automatic “search for a zero crossing”. The ad-
vantage of using zero crossings is that there will be no clicks due to sudden
volume changes in the audio material. For more info on Zero Crossings, see
the chapter “The Audio Editor” in the electronic documentation.

e Changing the Magnification.
It is often a good idea to zoom in horizontally and vertically when you are
making fine adjustments to the segment start and end points. Use the sliders
in the lower right corner of the window to change magnification.

* The Inset value is in ticks.
There are 384 ticks for each beat (quarter note) which means that when you
change the Insets this is the resolution you are using for the position value.
However, if you need sample accurate editing of Segment Insets, you can per-
form this in the Pool, see the electronic documentation.

* The Insets do not “snap” to the closest Snap value.

Changing the Start Inset

The Start Inset is adjusted by dragging inupper left corneof the waveform part
of the Segment. Usually, you will point at the handle, click and drag, but the hal
does not actually have to be shown (hide/show it with the View pop-up menu, if
like).

Position the pointer in the upper left corner of the
waveform, and drag the Inset left or right.

4____I%JHLI‘ril::-Em 1]

-

¢ If you click somewhere along the very top edge of the segment (though
not on the segment name) the Start Inset will immediately be set to that
position.
The Start Inset can also be changed numerically from the Info Line (see page
170).
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What happens when you Change the Start Inset?

Changing the Start Inset adjusts from which point in the file the Segment play:
“hides” more or less of the beginning of the file. It doesmatethe audio in the
Song. Note the difference between changing the Start Inset and moving the E

Before moving the Event Before moving the Start Inset

| I
After moving the Event After moving the Start Inset

Changing the End Inset

This is done just as changing the Start Inset, only you click and draglawgre
right cornerof the waveform. Changing the End Inset adjusts the Length of the
Event; that is, it hides more or less of the end of the file.

If you click somewhere along the bottom edge of the segment, the End
Inset will immediately be set to that position.
The End Inset can also be set numerically on the Info Line (see page 170).

Monitoring the changes

If you activate the Speaker icon, a short section of the segment will be played
when you change the Insets, allowing you to fine-tune the settings by ear. In tl
electronic documentation, you find information about how to set the length of
section to be played back.
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Auditioning Audio Events

This allows you to check out the contents of an Event, by playing it back from
position:

1. Select the Magnifying Glass from the Toolbox.
2. Make sure the Scrub icon on the Status Bar is deactivated.

When this is activated, the Magnifying Glass is used for Scrubbing. This is de-
scribed in the Audio Editor chapter in the electronic documentation.

ﬁ I The Scrub icon deactivated
‘ n (Auditioning mode).
W[ |
The Scrub icon activated
‘ ﬁ ﬂ } Eﬂal (Scrubbing mode).
) F

3. Click on an Event.
The Event is played back from that point as long as you hold the mouse but-
ton down. The audio is routed through the monitor mixer as usual.
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Deleting Audio Events

Audio Events can be deleted in several ways, just as Parts in the Arrange win

¢ By clicking with the Eraser tool.
This will remove the Event from the Audio Part. The file will remain on the
hard disk, and in the Audio Pool, together with the segment.

* By selecting the Event and pressing [Backspace] on the computer key-
board.

Again, this will only remove the Event from the Audio Part.

* By selecting the Event, holding down [Control] and pressing [Backspace].
If you do this, the following alert message will appear:

Cubase Audio ¥5T

FPermanently delete the Audio files?

Yeg Mo

If you click No, only the Audio Event will be removed, as if you had not
pressed [Control].

If you click Yes, the audio file will be permanently deleted from the hard disk,
and the segment and file will be removed from the Audio Pool.

e Permanently deleting an audio file from your hard disk this way cannot be
undone!
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Editing on the Info Line

The Info Line is a section in the window containing numerical settings for the ¢
lected Audio Event. Proceed as follows:

1. To display the Info Line, click on the “1” button on the Status Bar:

Bli «|@)s
k > ‘
pr] \
\|
STARTOOO1.02.192 ENWD DOD4.03.195 GFPOMT O SEGMENT African FILE Afric

2. Select one, and only one, Event.

3. Adjust the values as described in the table below:

Heading: Description:

Start Start Position. Adjusting this moves the Event.

End End Inset. Adjusting this shortens or lengthens the Event.

QPoint Q-point. Adjusting this moves the Q-point. See page 162 in this
chapter.

Segment Segment name. If you change this, this is reflected in all Events

that play the Event, and in the Pool.

File File name. Changing this means that the actual audio file on the
hard disk is renamed.

Chn The audio channel the Event plays on. This cannot be changed
on the Info Line.
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What can | do with the MIDI Editors?

When you record MIDI data, you fill Parts with notes and other MIDI “Events”.
But you don't really get to see and manipulate those Events individually from t
Arrange window. In the MIDI editors you do!

Different types of Events and where to find them

Below we'll list the different types of MIDI data that Cubase VST can record, a
how and where they are displayed for editing:

Notes (Note On and Off messages)

Notes are displayed in all MIDI editors. Let’s look at a simple drum pattern anc
how it is shown in the different editors:

In Drum Edit

4 Drum - DrumKit, 0001.01.000, 0003.01_000

_|C
- *
Drum Solo | [To: &lselected =] [ Shitwhiste  Quant] 2 =] [ 0007.07.000 ﬂﬁﬂﬁﬂﬂﬂj

Edit Salo ||I3|:|t|:| =l Dn =l | D003.0z2.000 Snapl 2 _=I[ 0007.071.000
START ====i===== LEMGTH =====  FITCH ==== YELOOM === YELOOFF === CHMN ==
M Sound
Bazz Dirum 1 2
Side Stick 16
Ac. Snare 16 |<+ < & & & o
Hand Clap 16 LS ¢ ¢ L O L O
El Snare 16
Shrt/hiztle G & L I o o o L &
LowFloarT om 16
Cls HiHat BlE € ¢ ¢ ¢ ¢ & ¢ ¢ ¢ ¢ ¢ ¢ ¢ & ¢
HiFloorT om 16 A
Pedal HiHat 16 |
Low Tam 16 /
= o / b|——

In the Drum Edit window, the notes are shown as diamonds.
Each key corresponds to a Sound, as listed to the left. The different
shadings of the diamonds indicate different velocity values.
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In Key Edit

The piano keyboard to the left is there to make it easy
to find the right pitch when inputting or editing notes.

4 Key - DrumkKit, 0001.01.000, 0003.01.000
[Gote =)D = | Smap| 16 _=|[ 0001.01.000 F ‘ ‘ ‘f ‘1
[ To: Al =l ==== Quart[ 16 =] [ 0007.00.000 B 1 a E(] J. st

START ========= LEMNGTH ===== PITCH ==== YELOOM === NYELOOFF === CHMN ==

1]

-

-

-

-

-

-

-

-

-

— = = = = = =
-]CZ

-

-

1] = = = = = = = = =
- =

-

-

= KN [+ e

The notes are shown as boxes, with higher notes higher up in the grid.
Since this is a drum pattern, all the notes are short, but otherwise note
length is indicated by the width of the rectangle.

In List Edit

The notes are shown both in the list
to the left, and in the graphic display to the right.

4 List - DrumKit, 0001_01.000, 0003.01.000

i | [Goto =l[Da =l | Snasd 16 =l 0001.07.000

[Mazk. =] [To Al 2l [Ine Mate =l Quant] =l 0007.07.000 B‘ F ‘a‘ « ‘ J ‘h‘u‘q
Start-F/: Length  %all Wal? “al3 Status
0o .“1 .00o 249 D2 120 B4 Maote L
0007.07..000 48 F#1 120 B4  HMaote L
0007.07..000 48 B3 120 B4 Hote L
00017.01.096 —==== I B === MainVolume |]
0001.01.192 ===== f BE === Mainolume
0001.01.192 ===== 4 88 === Foot Chl
0001.01.192 ===== 10 106 === Pan
0001.01.192 300 F#1 120 B4  HMaote L
0007.01.238 ===== f 43 === Mainolume
000702000 ===== f 121 === Main¥olume
000702000 ===== a6 === === Aftertouch
000702000 ===== 1 78 === Modulation
000702000 48 F#1 90 B4  HMaote L
000702000 AE4 B3 120 <‘El'l_l'ﬁl'l:i'tE\\ L
000702000 48 D1 70 B4 Mote L]
0001.02.192 510 F#1 120 B4  HMaote

il | D —r—

The black bar graphs are for graphically displaying and )/

editing MIDI “Value 2” in every Event. In the case of
notes, “Value 2” is the velocity value.
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In Score Edit

4 Score - Trumpet 1, 0001_01.000, 0109.01.000
EditSolo |[Gote =I[De =l | 000203000 Snapl 8T =] 0007.01.000 :
Bl ®[df st §
[To &l =l 33 Quant[ 8 =] [ 070901 000 : I’}

START ========= LEMNGTH ===== PITCH ==== YELOOM === NYELOOFF === CHN ==
inzent |1 o] T A A A|T] - |  ennswin W] bferfue|#]x] 2] O] ]J]t
Trampet 1
py 1 2 3 4
- T f ] i T T f oy ——————
EEET R = SEERRITE L N I O B
= = — — = =

Y
(41 | /‘
In Score Edit, notes are displayed and edited

just as notes on a printed score.
This snapshot is taken from Cubase Score.

Continuous Messages

In MIDI, various types of MIDI messages are used to transfer continuous chan
To be exact, these types are:

e Aftertouch (Channel Pressure and Poly Pressure).
¢ Pitch Bend.
e Controllers, like sustain pedal, MIDI Volume, Modulation wheel etc.

To be really exact (not to say pedantic!) some of these are not really continuol
Sustain Pedal for example can only be down (On) or up (Off). However, the M
specification groups all these messages as Continuous messages, and so do
base VST.
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Continuous messages are shown and edited in Key Edit and List Edit:

In Key Edit, the area beneath the Divider is the Controller Display.

Edit Solo_| [Gote _=I[Da

=l Snap|0Off _={[ DOO07.071.000 :
[To: Al = : me— Duanpt: i3 .:J: 070907000 mFﬂF ﬂﬂﬂj
START ====i==1=== LEMGTH =====  FITCH ==== VELOOW === VYELOOFF === CHN ==
1]
1]
1]
—
— — —
- — [——]
1]
—_— i N
|- a
Moo h
L T
Clicking on this icon brings up a pop-up menu,
allowing you to select which type of continuous
data should be shown. In this case, modulation
wheel Events are displayed.
The “mountains” of continuous data (as shown in the Key Edit
Window) are in reality a large number of single Events. This becomes
clear when looking at the same data in the List Edit Window:
Value 2 for each Event is shown in the
The modulation Events are list and in the bar display. The grey
listed in their playback order. color indicates non-note Events.
Shart-Pos. Length  “all “al2 Wal3 Status}\
QOOT.01.000  ===== 57 === === Frogiah Ch -3
0o01.01.000 192 GH3 93 48 Notg \ —
Opo.01. 252 148 A3 71 24 MNotg -
0Q01.01.374 287 GH3 B3 22 Mo -
0bO1.02.264 153 A3 B3 32 Mphe -
000103006 ===== 1 3 === blodulation !
00p1.03.012 ===== 1 & === /Modulation . I
00fy1.03.014 289 F3 939 24/ Mote —
000Y.03.018 ===== 1 1 === Modulation BER R
000\03.024 ===== 1 29 === Modulation u
00 .EQ.IQED ===== 1 39 === Modulation L d
0001.03.036 ===== 1 49 === Modulation -
0oo.03.042 ===== 1 BB === Modulation L
0001.03.048 ===== 1 B === Modulation -
0007.03.054 ===== 1 B4 === Modulation -
o] 7
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Program Change messages

A Program Change message is a MIDI Event, telling a connected MIDI device
switch to another Program (e.g. a sound in a synthesizer, a setting in a reverb
vice, etc). You can record Program Change messages into Cubase VST like a
other Event. If you want to edit (or create new) Program Change messages, it
be done in Key Edit or List Edit.

System Exclusive messages

System Exclusive messages are a special kind of MIDI Events, intended for d
tailed control of the parameters of a MIDI device. Since all devices have differ
parameters, each major manufacturer of MIDI devices has a special ID code tt
included in the System Exclusive message.

System Exclusive messages can be displayed and edited in the List Edit wind
(See the “List Edit” chapter). For extensive System Exclusive editing and man
ing, you can use the SysEx Editor module, described in a separate electronic
ment.
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Opening A MIDI Editor

There are several ways to open a MIDI editor:

e If you haven’t recorded any MIDI data, but want to input MIDI Events “from
scratch” in a MIDI Editor, you need to create a Part first, by using the Pencil
tool or the Create Part function. This is described on page 121.

Double clicking on one Part

If the Part is on a Drum Part, the Drum editor opens. If it is a regular MIDI Par
which editor opens depends on the “Double Click Opens” setting in the Prefere
dialog. To set this, proceed as follows:

1. Pull down the File menu and select “Preferences”.
The Preference dialog opens.

2. Pull down the “Double click opens” pop-up menu and select the pre-
ferred editor (Key, Score or List Edit).

Preferences

Double click opens I o
M[Dr Y
~ Score ¥ .
Ligt

= ey || [ Fe

I 10 Minutes [ Le

The Double Click Opens setting is saved with the Song. If you want this settin
be valid for all new Songs, you should set up your “Def.ALL” song for this. Se
page 241
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Editing a complete Track
You can edit all Parts on a Track at the same time:

1. Make sure no Parts are selected by clicking somewhere in
the background area of the Arrange Window.

iy Tiseh Chr | |=:[18 Structure  Functionz  Opti
Flute rda Ctil+
Strings 2 Cut Chibe
» | Bagzoon . [Eopy CukC
Trangle 10 Triang Triang Triang Easte Clilky
Strings 1 b Delete Track Del
 \Drumkit 10 Select »

Copy to Phrase. ..

i ! Chil+z

\ 2. Select the Track you want to Edit.

Ctrl+D
Ctil+R
3. Select the preferred editor from the Edit Y5 2 E Editar Chlsy
menu or use the keyboard equivalents. Get Info i+l
Motepad Clrl+B
Logical Chrl+L

b aztertrack, r

For MIDI Tracks the “Edit" item opens Key Edit, for Drum Tracks it opens Drur
Edit.

Editing more than one Part

You can edit any selection of Parts, even Parts on different Tracks at the same
The only restriction is this:

e List Edit can only be used to edit Parts that are all on the same Track.

1. Select the Parts you want to Edit.

2. Select the preferred editor from the Edit menu or use the keyboard
equivalents.
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Key Edit

Overview

Below you will find a description of some of Key Edit’s main features:

The position of the mouse pointer is shown both on
the Piano keyboard and in the Mouse Box.

The Do and To pop-ups. See “The The Snap and Quantize
MIDI Editors — General Information” boxes.

in the electronic documentation.

4 Key - Baszoon, 0002.01.000, 0007.01_000

EditJolo |[Goto =I[Da =] F000403T92  Snapl 8 %,V 0006.03.000 _I_ | | -
[T Looped zel™ =] | G0 Quant] 8 _=l| 0ODB.0O3.192 1 ® ‘ J|re[*
ST.':'.#{T B =R LEMGTH ===== FITCH ==== YWELOOMN === YELOOFF === LCHMN ==
1] d3 j
1) ’
1) ',
— I The black notes are selected.
— | —
[—— 3
— o / =
— l\ // =
— \\ e ——
\
VA | S O S O - Y s
\ L =l
| —
— S, 5 e
—1 \ \
\ \ T
2 L \ \ =
The Goto pop-up is used The Soné Position
for moving the view. Pointer.

Clicking here opens the Controller Display.
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Drum Edit

Drum Edit can be used to edit MIDI Tracks. It can also be used in a more adva
context, for editing Drum Tracks. See the chapter “Drum Edit and Drum Track

Overview

Below you will find a description of some of Drum Edit's main features:

The Do and To menus. The position of the mouse is shown in the
See the chapter “The MIDI Mouse Box. The name of the Drum Sound
Editors — General Information” on the corresponding line, is shown in the
in the electronic box below.

documentation.

The Song Position pointer.

4 Drum - DrumKit, 0001.01.000, D003.01.000 M=l E

EditSolo NGo)d =I[Do ] [000Z¢3000  Snap[ 2 | [ 000207000 J | | |f |
Dirum Solo | ITD\&" zelected ;i.l | HiMid Tam Quant] 2 /=] 0003.01.000 ‘ J|re[* 1
START ====1==1=== [ENGTH =====  FITCH ==== WELOON === VELOOFF ===
I!ISDund _ Z
Bass Dirum 1 | | I
High T om < < & < ¢ ¢
Side Stick ||
Az, Share
Hand Clap < ¢ ¢ ¢ < ¢ ©
El Share
Shirtadhistle < o Ll e o v o @
LowFloorT om | |
Clz HiHat R AR IR AR IR R AR JR AR AR BN AR
HiFloorT am A
Pedal HiH at
Low T —— The black notes are selected. -
Open HiNat |
Lowitdid T oy
Hitdid Torn r\ ]
CoemaleComa b The Drum Sound list. By dragging the Divider
. _ b ] —
t further to the right, more columns are shown. :
Clicking here opens the Controller Display.
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About Drum Maps

In Drum Edit, each key on your MIDI keyboard is represented as a “Sound”, ir
“Drum Map”. This map consist of 64 Sounds which can be named and set to r
sent a certain drum sound in your synthesizer, sampler or drum machine.

When you have defined a Sound, all notes that are already recorded with that S
will appear as diamonds on that “line” in the note display.

Opening ready-made Drum Maps

A number of ready-made drum maps are included on the Cubase VST CD-RC
This example describes opening a drum map for General MIDI instruments, b
you may very well find a drum map which has been created specifically for the
drum sounds in one of your instruments. To load a map, proceed as follows:

1. Select Open from the File menu.

2. From the File Format pop-up menu, select “Drumsets (*.DRM)”.

File name:

File farmat; Songs [~ALL) j
Songs [FALL) -]
Armangements [*.ARR] :
Partz [*PRT

3. Locate the Drum Maps folder on the Cubase VST CD-ROM.
You may find it more convenient to copy the desired Drum Maps from the
CD-ROM to your hard disk, and open them from there instead.

4. Locate the drum map you desire, and click OK.
For a General MIDI compatible drum map, open the Roland folder and select
the “GS Standard” map.
Now when you next time open the Drum editor, your Drum Map is already
properly defined and recordings made in the Arrange window should appear
with all the notes on the right “lines”.

If you save your Song, the selected drum map is saved together with the Song.
It will be loaded automatically next time you open the Song.
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Setting up and changing the Drum Map

You can easily change an existing drum map, or set up a whole new one to fit
percussion and drum setups in your MIDI instruments.

e This example assumes you are using Drum Edit for editing MIDI Parts.

1. Check out and take note of which key on your keyboard is used to
play a certain Sound.

2. Open the Drum editor and drag the Divider between the Drum Map
and the Note display so that you see the first few columns in the list.

4 Drum - DrumKit, 0001.01.900, 0003.01.000

EditSclo | [Gote =I[Do = | snapl 2 =IT
Dirum Solo | [To: &N _:.I\I Hand Clap Quart[ 2 =T
START ========= LENGTl‘l===== PITCH ==== WELD QR
58 Sound Huant [-Maote m
Basz Drum 1 : |
High Tom 16 D2 & &
Side Stick 16 CH1
Ac. Snare 16 D1 ;5{}'!
Hand Clap 16 D#1 < ¢ <
El. Snare 16 E1
Shitwhiztle 16 Ba ¢ < P el e
LowFloorT om 16 F1 |
Clz HiHat 16 F#1 e O O O O Ol A
HiFloorT om 16 G1
Pedal HiH at 16 GH1
Low Tom 16 Al
COpen HiHat 16 A1
3. Double click on a Drum | rwobdid T o 1E R
Name and type in your own. = «
1131 1d gt 1. L'+ |

El. Snare

Cowraor T am e F1
= HiH At 1k Fii
4. Double click on the I-note LLai Lo IO L
value for that Sound, and El. Srare 16 E1 I_

type in the pitch of the key
that plays the Sound.

LowFloorT am
- LILD - 41 CHA

Now, recordings made with the Sound played by that key will appear on that li
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If already recorded Notes don’t appear on the Line

It may happen that you have defined an I-Note correctly and still, no notes apj
although they play back correctly. If this happens it is because more than one
Sound is set to the same I-Note. Proceed as follows:

1. Scroll up or down the List to find a Sound set to the same I-Note as the
one you want to use.

2. Scroll the I-note value of the Sound you just located to its lowest possible
value (C-2).

3. Scroll back to the original Sound and check again.
The notes should now have appeared.

If you get the “Double defined Notes” message

Cubasze Audio ¥ST E

& Double defined |MOTE |in pour drum set!

When you change the I-note value, a dialog box may appear saying “Double c
fined I-NOTE in your drum set”. This means that more than one Sound is set t
spond to the same MIDI Note, as described above.

This dialog will appear every time you open Drum Edit, until you change one of
identical I-note values.

Saving your Drum Map

You may of course save any Drum Maps you have created. This is described i
“Drum Edit and Drum Tracks” chapter in the electronic documentation.

-183 -



List Edit

Overview

The Mask pop-up is used to
make List Edit show Events
of a certain type only.

In the Insert pop-up menu, you decide which
type of Events to input.

The Mouse position is
shown in the Mouse Box.

ii.000, 000701000

& List - Flute, 0027,

g dit Solo oto 5] [QOZ02000 Snapl & _=I[ OODE.0Z.000 B' Flal
[Mask =l I\TD: &l _;J lns. 77 =l Quantl 8 =] 000B.D3.132
Start-Fos. \I:anMaH Wal? Wal3 Status 2 3 2 2 3
00071.01.000 9z B4 127 F4 Mok — -
0001.02.000 1920 &4 127 B4 Note —
0001.02.192 192 F4 12284 Ihe Do, Toand —
0001.03.000 192 c4 127 64 Goto menus. —
++9001.03.192 384 AHI 127 B4 Note —
0007 R4 132 192 F3 127 4 Mok —
000Z.0M\10D 192 DH#3 127 B4 Note —
192 D3 127 Note —
D2 127 64 Mok .- —
0002.01.008 192 DH4_127—64% Note [ —i
0002.01.153 192 E4 127 F4 Mok —
0002.02.000) w6 FH#4 127 B4 Noe —
0003.04.000 | 384 DH4 127 B4 Note —
0004.01.000 | /384 BI 127 64 Motk |
1| | =t A

The Song Position is shown both in the

Event list and in the Event display

The Events are shown in the list

and in the display to the right.
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Score Edit

The design and features of the Score editor differs depending on which versio
Cubase VST you have: In the “regular” Cubase VST, there is a basic Score ec
without advanced layout features, while Cubase Score VST contains a larger &
editor, for pro-level score layout and printing.

Unless where explicitly stated otherwise, this section and the Score Edit chapt
the electronic documentation describe the basic Score editor in Cubase VST. |
have Cubase Score VST or Cubase Audio VST you should also read the sepe
“Score Layout and Printing” document.

Overview

Below you will find a description of some of Score Edit's main features:

The mouse position is shown both in the mouse box and as a note name in
the box below. When you move a note, the lower box shows the amount of
transposition in semitones.

& Score - Trumpet 1, 0001.01.000, 0109.01.000
Edit Solo_| [Got 2T 000z.03.128 8T =I[ 00001000 . 1
s | e S 85 &|4[2 - s nd
[To Allselected A | E]] Qaantl 8 =] [ 0703.01.000
START ====:===== LEMGTH ===== T—’I’Tﬁ! ==== VELOOMN === WELOOFF === CHM ==
e [T o3[ 3F MMM | emswe bl bforfuel#][2[0] [r[etan]rme]s o] wros
The Song Position Pointer. -
Trumpet 1
w
gy 1 P 3 / 4
[[(mrad IH E | T [y T | T T T [y | B | T
G ot brar L e = e
——— i i gy w— - -‘ 4
%‘J -
aryton
[P Pon, [ P [eemy ooy [ I
o S P Y P P N PO PSS 0 A PP o NEPH
- - 'i L -"_‘4\_‘;.1_(_.“__]’_;,_(_]“__,‘:.':'&"__
The “inverted” notes are selected. 5
4 0 ]

If you are editing Parts on several Tracks at the same time, the striped
double bar line at the beginning of the score indicates the Active Track.

Getting the Score displayed correctly

When you first open Score Edit, the score layout can reflect the minor inaccure
of a real human performance. There are a number of settings that can be mac
clean up the score layout, without having to change the actual MIDI data. See
Score Edit chapter in the electronic documentation for more info.
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Page Mode vs Edit Mode

If you are using Cubase VST Score or Cubase Audio VST, your program will h
a Score menu. The top item on this menu is used to switch the Score editor bet
its two modes, “Page” and “Edit”.

Slees Audio Modules Selecting Page Mode will display the

music as it will look when printed...
Fage Mode
I Ix & H 11 "5 T >= k. T T T T Ih-l — T :
C=kF C abbimms M- e a—
: = — 7 =
I ﬂ ﬂg T T h F‘% T T T - —
-> L UI ,- 11 b T T T T T T
D] F 1  m———
TN AR 3
I ﬂ 513 T I k. T T T T H T I
I'!? = ) d_-fw | I;- VIrRI r d d dl = I )

...while Edit Mode displays the music in a
way more suitable for editing, see below.

Sea=r Audio Modules
Edit Mode 1
Layout Layer anly ny | 2 3

Ctaff S athinns

anl
N
L 108

L 108

3

v T T
T Q=

The text below assumes the editor is set to Edit mode. The other mode is for ¢
layout and printing.

Users of the regular Cubase VST (not Score) do not have to worry about this.
Window Size

Score Edit’'s Edit mode displays as many notes as there is room for in the win
In other words, to see more or less of your Track, simply resize the window.
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About Recording and Playback in the Editors

Basically, anything you can do in the Arrange window that relates to playback
recording, you can also do in the editors.

* Realtime
As everything else in Cubase VST, editing can happen in realtime. This means
that you can edit while the music is playing or actually even while you are re-
cording!

e Step Recording
If you prefer not to record your music in real time, you may use the Step Re-
cording function to input music one note at a time. This is explained in the
chapter “Step Recording” in the electronic documentation.

* Follow Song
If Follow Song on the Options menu is turned on, the window automatically
scrolls during playback, so that the current Song Position is always visible.

fellEy Score Audio Modu

Chase Events r
Multirecord k
Part Appearance r

Fart Background...

v Record Tempo / &tes

AP ™ o

You may also press [F] on the computer keyboard to turn Follow Song on/off.

¢ Edit Solo
| Edltﬁct% IEDtD

T AT

When this button is actlvated you will only hear the Track/Parts that are cur-
rently being edited. All other Tracks are muted. Use this function when you
want to concentrate on editing the Parts in the editor, rather than hearing the
recording in a context.

e Cycle
Activating Cycle (see page 87) can be very handy for editing, since you can
fine tune a recording and instantly hear the result without having to Rewind
and Play to get to the right section.
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Entering Notes

Notes can be entered manually, using slightly different methods in the differer
MIDI editors:

Key Edit

1. Set the Snap value to the smallest position you want to enter a note at.
If for example you only want to enter notes at quarter note positions, set Snap
to “4".

2. Set the default length of the note to enter with the Quantize value.
The value “8” will for example give eighth notes. You may also change the
length while you’re drawing - see page 189.

Snapl I =l
E!uantl g :"

Snap and Quantize values set up for entering eighth notes at quarter note intervals.

3. Select the Pencil tool.

4. Move the pointer onto the note display, to the position where you want
the note to be placed.
The keyboard display to the left, and two fields on the Status Bar will help you
by showing the position and pitch.

4 Key - Klar 1. 0001.01.000, 0106.01.000

EditSolo | [Gote =I[Do =] [ O007.03.000

[ T &l e B3
START ========= EMGTH ===== FITCH
|} /
|}
C4
= /7
|

The pitch is indicated on the keyboard
display and in the Status Bar.

5. Click once with the mouse to input a note.
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Setting the length while drawing

It is possible to set the length of notes to something else than the quantize va
while entering them. Still th8nap valueapplies so you can only set the Length t
even multiples of this value.

. Aim with the Pencil at the correct position and pitch.

. Press the mouse button and drag to the right with the button pressed.

EditSolo | [Gote =I[Do =] [ 000Z01.192  Snapl 8 =]

| To Al =l B3 Quant[ 8 =]
START ====l==l=== LEMGTH ===== PITCH ==== YELO O

. Release the mouse button.
The Event is adjusted to the closest Snap value.

Determining the velocity of the notes

By holding down different modifier keys on the computer keyboard, you can g
the notes you enter different velocity values. This is described in the chapter
MIDI Editors - General Information” in the electronic documentation.
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Drum Edit

1. Drag the Divider to the right, so that you can see the “Q” and “Len” col-
umns.

2. Locate the Sound you want to enter notes for, and set the value in the “Q”
column to the smallest position you want to enter a note at.
When inputting notes, this value works in the same way as the Snap value in
Key Edit. However, Drum Edit allows you to set different Q values for each
Sound, making it easier to quickly input patterns with 16th note hihat patterns
and eighth note snares and bass drums, etc.

3. Set the default length of the note to enter in the “Len” column.
Again, you may set different values for different Sounds.

Sound uant |-Mote Len  0O-Maote
El. Share 16 E1 32 E1

P Litron " 16 D 32 B3
LowFlaarT am 16 F1 32 F1

Clz HHat e

HiFloorT om 16 G1 32 Gl
Padal HiH at 1E -1 a3 -1

Q and Len values set up for entering a 16th note hihat pattern.

4. Select the Drumstick tool.

5. Move the pointer onto the note display, to the position where you want
the note to be placed.

Two fields on the Status Bar will help
you by showing the position and Sound.

EditSolo | [Gote =I[Da =] [ 400202000\ Snapl & =I[ 1OC
Cirum Solo | [To &l =] [Tz HHat Quant[ 16 ][ 00

START ====:===== LEMGTH ===== FITCH ====  YELOOM =
I!ISDund [uant |-Mate Len O-Mote

El Snare 16 E1 22 El

P uitrar 16 D2 32 B3

LawsFloorT onm 16 F1 32 F1

Clz HiH at 16 e IR . SN
HiFloar T am 16 &1 32 Gl ”%
Fedal HiHat 16 G# 32 G

6. Click once to input a note.
If you want to remove a note, just click on it again with the Drumstick.
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Entering several notes at once

If for example you want to enter a 16th note pattern, there is an easier way of c
this than clicking in the notes one by one:

. Set up Q and Len values for the Sound.
. Select the Paint Brush tool.

. Aim at where you want the first note to be, click and drag to the right.

guant [-Mate Len  O-Mote
16 E1

g6 b g2 F |1l

16 G1 EE 51 i EEEEE

16 GH#1 32 GH

. Release the mouse button.
A row of notes are entered, positioned according to the Q value for the Sound.

Quant |-Mate Len  O-Mate

16 E1 32 Ei
16 D2 32 B3

16 F1 32 F1 1
16

16 G 22 G

16 GH1 a2 GH1
16 Al 32 AT

Determining the velocity of the notes

By holding down different modifier keys on the computer keyboard, you can g
the notes you enter different velocity values. This is described in the Drum Ed
chapter in the electronic documentation.
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List Edit

In List Edit, you can insert any type of Event. However, in this example, we will
sert notes (see the List Edit chapter in the electronic documentation for more i
mation).

1. Pull down the Insert pop-up menu and make sure “Note” is selected.

| Shap
|Inz. Hate =l CQuanl

Faoly-Preszs. !

Contral Change
Frogram Change
Aftertouch
This is where you select the type of Event to enter.

2. Set the Snap and Quantize values as when entering notes in Key Edit.
3. Select the Pencil tool.

4. Aim and click in the Event display to the right of the List.
The Event will appear both in the Event display and in the List.

4 List - DrumKit, 0001.01.000, 0005.01.000

Edit Solo_ | [Gote =i[Do =] [O001.0Z2098  Snapl 76 = [ 0007.07.000 B Flal.‘ J
Mask =] [TooAl =l [lne Note =] Quant[ 76 _=1[ 0007.01.000

Start-Paos. Length  Wall “Wal? “al3 Status

C3 127 B4 Hote

* You can set the length of the note manually while you are entering it, just
like in Key Edit (see page 189).

When you enter a note in List Edit this way, it gets a default pitch. To change t
pitch of the note, proceed as follows:

5. Drag the divider to the right, so that you can see “Val 1” column in the
List.
For Note Events, Value 1 is the pitch.

6. Change the pitch value using any kind of value editing.
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Score Edit
In Score Edit, you use the Note tool to input notes:
1. Set the Snap value to the smallest position you want to enter a note at.

2. Select the Note tool.

3. Select a note value by clicking on a note button on the Toolbar.

Do =1 [ 0001.04.192
=l | FE

A ENERENCIETE TR

The Note tool takes on the shape of the selected note value.

4. Press the mouse button somewhere in the score display.

5. With the mouse button down, drag the note up/down.

nsen [T ol T A A AT | eohswin ]} |or|ue|#] %] 2] 0]

A

Fiano .
g1 [ L 2 \ 3 4
T = i
ﬁil:#i : i ]

v

Accidentals appear to show you the exact pitch of the note. The pitch is also
shown in the value field under the Mouse Box:

[ O00Z.03.000
| CHA

6. When you have the note at the right note line with the correct acciden-
tal, release the mouse button.

Entering Rests

You can use the Rest tool to insert rests between notes. Like the Note tool, the
tool changes appearance depending on the chosen note value. See the Score
documentation for full details.
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Selecting Notes and other Events

¢ Selecting Notes and other Events in the main Event displays is done exactly
like when selecting Parts in the Arrange window, see the previous chapter.

* Selecting Events in the List in List Edit can be done by clicking and Shift-click-
ing.

* You may use the Select sub-menu in the Edit menu to select Events. The con-
tents of this sub-menu varies depending on which editor you are in. See the
Online Help for more information.

* Selecting in the Controller Display in Key and Drum Edit is slightly different.
See the chapter “The MIDI Editors — General Information” in the electronic
documentation.

Manipulating Notes

This section describes some basic MIDI editing techniques. Two features are
able to make editing easier:

e The Snap value.
The Snap value is used in the editors just like in the Arrange window, that is
for restricting movement and editing to certain note positions. However, in
the MIDI editors you can select smaller Snap values than in the Arrange win-
dow, for very fine adjustments of positions and lengths.

Snap'ﬂ
[ff [ff [ff
2pp 3pp 4pp
Spp Bpp 7pp
B4T G4 B4,
3T 32 32,
16T 16 1E.
8T q 8.
4T 4 4,
2T 2 2
1T 1 1.

* The Speaker.
If you activate the Speaker button on the toolbar, notes and other Events will
be played back when you click on them, move them or edit them on the Info

line (see page 196).
484)

R SR

In
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Moving Notes

You move notes by dragging them with the Arrow tool, just like moving Parts in-
Arrange window. If you select several notes, you can move them all at once, n
taining the relative distance between the notes.

Restricting movement to one direction

Sometimes you may want to transpose the note without moving it sideways, or
versa. Proceed as follows:

1. Aim at the note with the Arrow tool and press the mouse button.
2. Start moving the note in the desired direction.

3. Press [Shift] and continue moving the note.
The note will now move in one direction only.

* You can also use the Kicker tools to move a note horizontally in Snap
value steps.
This is described in the electronic documentation.

Duplicating Notes

Again like in the Arrange window, if you hold down [Alt], the notes you drag wi
be duplicated.

Changing the length of Notes

The following method can be used in Key and List Edit, to change the length c
notes:

1. Set Snap to an appropriate value.
The length of the note can only be a multiple of the Snap value.

2. Select the Pencil tool.

3. Click on the right edge of the note, drag the outline of the note to a new
length and release the mouse button.
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Auditioning Notes

—

If you click on a note with the Magnifying Glass tool, it is played back. You car
also drag over notes (and other Events) to play them back one after the other.

Deleting Notes

Just like Parts in the Arrange window, Notes (and other Events) can be delete
several ways:

¢ By clicking on them with the Eraser tool.

3|

e By selecting them and pressing [Backspace] (or selecting Delete Events from
the Edit menu).

e By using various functions on the Do pop-up menu (described in the elec-
tronic documentation).

Editing on the Info Line

At the top of each editor (except List Edit), you have the Info Line. This can be
shown/hidden with the Info button.

When the “i” button is activated, the Info Line is shown.
Hll @ -

Al
START 0001.03.000 LENGTH 192 PITCH D#4 vELOON 12F VELOOFF B4 CHM 3

The Info Line shows the values for one selected note. The values can be edite
as in the List in List Edit.
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Editing in the Controller Display

Key and Drum Edit have a dedicated Controller Display at the bottom of the w
dow, for showing velocity values and Events other than notes. You can also ec
these in List Edit - see the List Edit chapter in the electronic documentation.

Showing/Hiding the Controller Display

There are two ways to show or hide the Controller Display:
¢ Click on the Controller Display button in the lower left corner of the
window.

CZ

¢ Press [Alt]+[Control]-[C].

Once you have opened the Controller Display, you can change its size by drag
the Divider up or down:

T Cde—
1)
1)
1)
1) 3 v
= ! 41T

prfff e

NOTEW. :

=~ L |
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Selecting which Event type should be shown

The Controller Display can show various types of data, but only one type at th
time. Select an Event type in the following way:

1. Position the pointer on the Event type icon (in the Controller Display)
and press the mouse button.
The Event Type pop-up menu appears.

1] .

- —— Pitch Bend

— m ASftettouch

— -— I

1) i

_— Puoly-Prezs.

) 1=

—-— — Program Change

f— bl odulation
BreathChl

é | ----- > é
e T Foot Chil
1 |_ b ainolume

Balance

= N = Fan
E spreszion
Suztain
Unknowr Chil
BreathChl
BreathChl

2. Select one of the Event types from the pop-up menu.
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Editing velocity

One of the data types that can be shown in the Controller Display is note velo
This is slightly different from the other types, since velocity is not an Event itse
rather a property of a note. This means that if there are no notes in the edited
you will not see any velocity values. Also, you cannot create velocity values (y
have to enter new notes). To edit velocity, proceed as follows:

1. Select Velocity on the Event type pop-up menu.
The velocity values are shown as bars, with higher bars representing higher
velocity values.

|
C4 Igf —.

prfff |

NOTEW.

: 3

£ N |

2. Select the Pencil tool.

3. To change the velocity of a note, click on its velocity bar.

To change a series of values, drag over them.
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Creating a velocity ramp
To create a ramp of values, for example a fade-in or fade-out, proceed as follc

1. Select the Line tool.

2. Position the pointer where you want the ramp to start and press the
mouse button.

- 200 -



Editing Continuous Events

Most of the available Event types are “Continuous” Events, such as Aftertouct
Modulation and Pitch Bend (seege 17 They can be created and edited in the
Controller display:

Creating new Events

1. Select what type of data you want to enter.

2. Use the Snap value to decide what “density” you want for the Events.
For very smooth Continuous Controller curves, you should use a small Snap
value. However, please note that this creates a very large number of MIDI
Events, which can cause MIDI playback to “stutter” in some situations. A me-
dium-low density is often sufficient.

3. Hold down the [Alt] key.
From here on there are basically three ways to go:

If you want to enter just one Event, click once with the Pencil.

If you want to “paint a curve”, drag the
Pencil (with the mouse button pressed).

4. Release the [Alt] key.
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Editing the Values

This is done just like creating new Events, except you do not press the [Alt] ke

* To change one value with the Pencil, simply click on it.
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Closing the Editor

There are two ways of closing a MIDI editor, “Cancelling” and “Keeping”.

Cancelling

If you press [Esc] (escape) on the computer keyboard or select “Cancel” from
Edit window’s Control Menu (reached by clicking on the Control Menu button 1
the left on the window’s title bar), the editor and all the changes you made sin

you last opened it are discarded.

* If you haven’t checked the “Fewer Alerts” check box in the Preferences
dialog (on the File menu), a dialog box allows you to change your mind:

Cubasze Audio ¥5T |

Do pou want ta keep the edits’?

1 Kesi Cancel {\

“Keep” will exit the editor, “Cancel” will cancel all changes you
but keep your changes. have made since you opened the editor.

Cancelling can be thought of as a super-undo. It allows you to try out a series
changes to a recorded piece of music and then easily revert back to its original

Keeping

If you close the editor by selecting “Keep” from the Control Menu or by pressi
[Return], the window closes and all the editing you have made is kept.
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The “Keep Appended Events?” Dialog

If you close the editor and a dialog appears asking you if you want to “Keep a
pended Events”, this is because you have added Events outside the Part(s) be
ited.

Cubaze Audio V5T

k.eep appended Events

Mo: Tes

.........

e If you click “Yes”, the Part will be extended to encompass the added Events.
e If you click “No”, the Events outside the Part will be discarded.
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15

Using Quantize and Functions
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How Functions are applied

By using “functions” you can perform various operations on notes and other M
Events, and in some cases on Audio Events as well. Some of the most import
functions, such as the different types of Quantization, can be found on the Fui
tions menu on the menu bar. In addition, the editors have their own “miniature
Functions menus, called the “Do” menus.

Aiisiahe Options  Score Aodio M M = |

Ower Quantize ] Fiwed Mote
Mote On Quantize Wt Delete Mote
[terative Quantize E k.eep Maote
Analytic Quantize Repeat
Groave Quanize » A
, Reverze

Undo Quantize 1

_ Delete
Freeze Quantize

[EarnpEute Seale

Setup Grooves. ..

Logical k
Freeze Play Parameter Alt+Chrl+F
Leqgato

Length Size

Fixed Length

Delete Doubles

Delete Cont. Data

Reduce Cont. Diata

Tranzpose # Velocity. .. Ctrl+H

The main Functions menu and one of the Do menus — they both contain “functions”.

However, before explaining how the functions work, it is important to know exac
what is affected by a function:
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In the Arrange Window
If you use a function from the Arrange window, it will applhatbselected Partdf
there are no selected Parts, the function will appbfitBarts on theactive Track
In the Editors

All the editors feature a pop-up menu called “To”. There you can decide which
Events should be affected by a function. The menu options are explained in thi

ure:

All Events, active or This option has to do
inactive, will be with the Loop feature,
affected.

5 = which is described in
\—ﬁi = =l | the electronic
Al Events documentation..

Looped Events -t

All active or inactive Cycled Events All selected Events,
Events inside the active or inactive,

Cycle (between the will be affected.
left and right locators) Looped Selected Evv.

will be affected,
whether the Cycle is Lol Saizelzt Ev.

Selected Events

on or off.

Only the selected
This option has to do with the Loop Events inside the
feature which is described in the chapter Cycle are affected.

“MIDI Editors - General Information” in
the electronic documentation..
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Quantizing

What is Quantizing?

Quantizing in its fundamental form is a function that automatically moves recor:
notes, positioning them on exact note values:

If you for example record a series of eighth notes, some of them may
end up slightly beside the exact eighth note positions.

Quantizing the notes with the Quantize value set to eighth
notes will move the “misplaced” notes to exact positions.

The Quantize value concept may need some explanation. By setting this value, on
pop-up menu on the Status Bar, you select the exact positions the notes should be
to when you quantize. These are the options:

If you select OFF, no
quantizing will be done.

Quantl & =I[ oooloroo0 Y

CIFt s CIFt

BAT B4 B4,

In the left column, you select 32T 32 32,
Triplet (T) Quantize values. 16T 16 1E.
o, B

4T 4 4.

In the middle column you select regular el e
Quantize values. The available values 1T 1 1.

range from 1 (whole note) to 64 (1/64 note). /4

In the right column, you select

dotted (.) Quantize values. In this example a Quantize value
of eighth note triplets is selected.

The effect of the different Quantize values is explained in the illustration on the
next page.
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Quantizing with different Quantize values

Start with a straight eighth note pattern.

I Quantizing with an eighth note
: triplet Quantize value moves the

each second eighth note, creating
I]uantl =) ""I a triplet shuffle beat.

B Y

. Quantizing with a dotted eighth note
E!uant'ﬂ Quantize value moves notes to

positions three sixteenth notes apart.

: Iﬁ Quantizing the eighth note pattern with a quarter
-
Uuant] 4 note Quantize value, will move every second

eighth note to even quarter note positions.

RS

It is important to realize that there will now be two notes on each
beat! This may cause strange sounds, increased volume etc.

f
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Actually, quantizing in Cubase VST is more than just correcting errors, it is a c
tive feature. On the Functions menu, there are several types of quantization. |
three most important ones are described in this chapter. The rest are describe
the electronic documentation.

When quantizing MIDI Parts, only notes are affected, not other types of
Events.

About Quantizing Audio Parts

Quantizing Audio Parts affects the position of each Audio Event in the Part (tak
the Q-point into account). Since Audio Parts in many cases contain only one A
Event, quantizing audio is often not very useful. However, it is possible to split
audio segment into several smaller segments, and then apply quantization. Tt
described in the electronic documentation.
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Over Quantize

Sk Optionz Score Audio M

Over Quantize N
Mote On Quantize Wt
Iterative MDoantize F

This is a very musical version of the standard “auto correct” quantize. Over Ql
tize will move notes to the closest quantize value, without changing the length
the notes. But it also detects and holds together chords (see the figure below)
you consistently play behind of, or ahead of the beat, it uses this fact when fin
notes to move. In most situations, Over Quantize is probably the most suitable
Quantize function to use.

When you Over Quantize (in this
example with a quantize value of 4),
Cubase VST realizes that the three notes
are a chord, and holds them together.

e Over Quantize can be selected from the computer keyboard by pressing

[Ql.
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Iterative Quantize

Sk Optione Score audio b
Ower Quantize ]
Mote On Quantize Wt

[terative Qluantize l“
Analytic Quantize
Groove Huantize »

If you want to straighten up the timing of your notes a little, but don’t want the |
cise feel you get from using Over Quantize, Iterative Quantize is probably the
bet. It works like this:

Instead of moving a note to the closest quantize value, Iterative Quantize mov
only part of the way. You can specify how much the notes should be moved tow
the selected quantize value in the dialog box that appears when you select Se
Grooves... from the Functions menu.

[terative O

IEE Strength &
20 okt Guaniize

In the same dialog you can also set a value in ticks (0 to 192) called Don’'t Qu
tize. Only notes further away than the specified Don’t Quantize value are mov
This lets you allow a certain amount of loose timing, while still being able to
straighten out really “off” notes.

-212 -



Creating a Shuffle Feel using Iterative Quantize

To show the difference between regular quantizing and Iterative Quantize, let*
look at two identical eighth-note patterns:

Quant] 8T =] Quant[ 8T =]
AUl Options  Score Audio M lielli=d

m Strength %

Ower Quantize

Maote On Quantize woo | LT RRnhauanes
|t§rati'-.-'e u uantize E SNy Optiong Score Audio b
Analptic Quantize Over Quantize 3
R . T r Maote On Quantize '
The upper set of notes are Over Iterative Quantize
Quantized to eighth note Analytic: Quaritize k

triplets...

Groove Cuantize r

l ...while the lower set of notes are Iterative

Quantized using the same Quantize value.
\ Strength is set to 66%. (Don't Q is set to 20,
but doesn't really matter in this case.)

- .................. -- .................. -- .................. -- .................. -- ........ l,
‘,
] L L L ?-
\

The upper pattern gets a heavy, precise triplet feel...

...while the lower pattern gets a more jazzy, natural shuffle feel.

-213 -



Groove Quantize

This type of quantizing is not meant for correcting errors, but for creating rhythi
feels. This is done by comparing your recorded music to a “Groove Map” (a pat
with a certain feel) and moving the appropriate notes so that their timing matc
the one of the Groove Map. You can for example easily create the shuffle feel 1
the Iterative Quantize example above, using a suitable Groove Map instead.

You select a Groove Map from the Groove Quantize sub-menu on the Functio
menu. As you see, there are more than a dozen Groove Maps included with Ci
VST from the beginning, but you can also load new ones from disk or make up
own, (using the Setup Grooves dialog, described in the Online Help).

SN agE Optione: Scoe Audio b
Over Quantize [
Maote On Guantize W
[terative Cuantize E
Analytic Cuantize
Groove Quantize 2w B-Tlet-4
Undao Quantize ] STlet8
; 2l Shuf.

Freeze Quantize MI
Setup Grooves... Foous
Logical » F-Tuplet
Freeze Play Parameter Alt+Chil+F zl. R andm
Legato bve. B andrm
Lenath Size Groove 1
Fixed Length Groove 2
Delete Doubles Groove 3
Delete Cont. Data Groove 4
Reduce Cont. Data Groove 5

] WWerner's
Trangpose / Welocity...  Chil+H Groovet

Groove

The Grooves included with Cubase VST are described in detail
in a ReadMe file in the Grooves folder on the CD-ROM.

Undoing Quantize

e Quantizing is not definite or irrevocable - not even after saving to disk! You
can always re-quantize to any value, even to Off, unless you specifically
“freeze” your Quantize, with “Freeze Quantize” (Functions menu).

This means that notes quantized to eighths can later be quantized to sixteenth
original (un-quantized) positions of the notes are used for determining how no
should be moved, except when using Iterative Quantize. You can re-quantize |
some notes in one of the Edit windows.

To completely restore quantized Events to their original positions, use the Unc
Quantize function on the Functions menu. This can be applied to any selectiol
Parts or individual Events, just as all Functions (s&ge 20k
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Automatic Quantize - Getting your music quantized while recording

This is a function that allows you to have everything automatically Quantized ¢
you go along with your recording. When automatic Quantize is activated, ever
thing you record is Over Quantized immediately. The quantization can be und
just as usual.

m ¥ Automatic Quantize activated.
|
The AQ Button (above the Click button on the Transport Bar) turns on and off.

tomatic Quantize. You can also press [Z] on the computer keyboard to activate
activate.

e There is one thing to note. If you have this function activated, your recording
gets Over Quantized at the end of each Cycle. Even if you select some other
type of Quantizing (like Groove Quantize) during the Cycle, the music will be
Over Quantized at the end of the Cycle. So, before you manually Quantize,
turn Auto Quantize off.

Other Functions

The Functions menu is not only used when quantizing, it contains a lot of othe
functions as well. In addition the “Do” menus in the editors contain useful editi
functions. The same rules as for Quantizing are used to decide what gets affe

The various functions on these menus are described in the Online Help and ir
electronic documentation.
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Mixing
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Introduction

This chapter describes the general procedures of handling levels, pan, EQ an
fects to create a final stereo mix. Mixing is done in different windows in Cubas

VST, mainly the Audio Monitor mixer (for audio) and the GM/GS/XG Editor (fo
MIDI).

e The GM/GS/XG Editor is designed to interact with MIDI instruments compat-
ible with any of the standards GM (General MIDI), GS or XG. However, even
if your instrument is not GM/GS/XG compatible, you may still be able to use
some of the functions in the editor.

Mixing Audio

e This chapter assumes that you are using a “standard” audio card with stereo
outputs only. If you have an audio card with more than two outputs, you can
route different audio channels to different outputs, using the Bus system. This

is described in the chapter “The Input/Output Bus System” in the electronic
documentation.

Setting Levels

1. Set up your Audio Tracks and possibly the Locators, so that they play
back the section you want.

2. Pull down the Audio menu and select “Monitor” (or press [Control] and
[*] on the numeric keypad).
The Monitor mixer window opens.

3. Select “Master” from the Audio menu (or press [Control] and [+] on the
numeric keypad).

The Master window opens. This is used to set the final level of the mixed sig-
nals.
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4. If possible, try to arrange the windows so that you can see both the Mon-
itor mixer and the Master window at the same time.

< ¥ST Mixer =] E3

AT

5. In the Monitor mixer window, make sure the “In” buttons are not acti-
vated for the audio channels.
When these are activated, the level meters show the input level instead of the
playback level.

6. Make sure neither the “Read” or the “Write” buttons are activated.
These are used for automating mixer movements, as described in the elec-
tronic documentation. For now, we'll stick to manual mixing.

7. Activate playback, and use the faders to set the relative volume for the
audio channels.
The fader settings are displayed numerically below the faders. You can boost
weak signals by +6 dB in the Monitor Mixer, if you like. Just be sure to avoid
signal levels above 0 dB (clipping - see page 66).

Clipping is indicated by the red
clip light above the “In” button.

m——
[
1
To reset the clip indicator, click
on it.

M II
rmrmnmmagl
n=iH
EL
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For stereo channel pairs, the faders are automatically “linked”, i.e. mov-
ing the fader for the left channel will automatically move the fader for
the right channel, and vice versa.

Stereo channel pairs are indicated by the word “Stereo” at the top of the
mixer channel strips. To set the level independently for one channel in a
stereo pair, hold down [Alt] and drag the fader.

If you hold down [Control] and click on a Monitor fader, it will automat-
ically be set to position 0.0 dB.

. Adjust the total volume with the faders in the Master window.

The faders are linked, i.e. if you move one fader the other will move as well.
If you want to adjust the level of one stereo channel independently, press [Alt]
and move the fader.

About automating levels
There are two ways of automating level settings:

By using the Write/Read function in the Monitor Mixer.

As described in the chapter “Mixing Audio and using Effects” in the electronic
documentation, this allows you to record and play back fader movements (as
well as most other mixer and effect settings).

By using the Dynamic Event feature in the Audio Editor.

This allows you to set volume curves for individual Audio Events. See the Au-
dio Editor chapter in the electronic documentation.
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Setting Pan
EI EELN | B=Um
|
EHEN

With the Pan controls, you set the stereo position of each audio channel. Like
ume, pan settings can be automated using the Write/Read function or the Dyn
Events in the Audio Editor.

e When you are changing Pan for a channel, the setting is shown numeri-
cally (L63-R63) in the level display below the fader.
To make the display show the fader setting again, click the fader handle.

¢ To select center Pan position, hold down [Control] and click on the Pan
control.

* For audio channels in a stereo pair, you should probably pan the left
(odd-numbered) channel fully left and the right (even-numbered) fully
right.

e [f the Mono switch in the Master window is activated, all audio playback will
be in mono, and the Pan settings will have no effect.

SE16 Wiawe The Mono switch
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Using Mute and Solo

For each audio channel, there is a Mute and a Solo button, which can be of gre
when you want to listen closely to one or several audio channels. These work &
lows:

¢ Clicking the Mute button silences the output of the audio channel.
To deactivate Mute, click on the button again.

¢ Clicking the Solo button silences the output of all other audio channels.
You may Solo several audio channels at the same time if you like. To deacti-
vate Solo, click on the button again.

Mute and Solo settings can be automated using the Write/Read functions in tf
Monitor Mixer. See the electronic documentation.

The MIDI Mute button

1
sl b

W= Il

Activating the MIDI Mute button will turn off all MIDI output. Use this when you
want to concentrate on the audio, setting levels, eq, etc. Closing the Monitor v
dow will automatically deactivate the MIDI Mute function.
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Making Equalizer settings

Cubase VST is equipped with a powerful equalizer. Depending on your compt
power and available free resources, you can have up to 4 bands of full param

EQ per audio channel!

Each audio channel has its own EQ window. To activate and set EQ for a chal

proceed as follows:

1. Click on the “EQ” button at the top of the channel strip.
The EQ and FX Send window opens. This contains a duplicate of the Monitor
mixer channel strip, four effect send knobs (see page 224) and 1-4 EQ mod-

ules.

Hi Lirnit

An EQ and FX Send window with two EQ modules visible and active.

Hi Lirnit

Frequency I Frequency
% %

Lo Lirnit

e |f you make Equalizer settings for the left channel in a stereo channel pair, the
settings will automatically be reflected in the right channel.

2. Use the arrow buttons in the top right corner to set the number of visible

EQ modules.

This helps you avoid “screen cluttering” by hiding unused modules.

3. Activate as many EQ modules as you need (up to four) by clicking on

their “Enable” buttons.

I (D] <]

As soon as any of the EQs are activated, the “Active” button and the “EQ” button indicator in

the channel strip are lit.

[Retive [
'E_—f‘g a [Ensbid m
Gain Gain
Y Y
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e The maximum total number of EQ modules (for all channels together) is gov-
erned by your computer’s performance. If you activate more EQ modules
than your system can handle, you will note that the “Over” indicator in the
Audio Performance window lights red, and the audio playback stutters and
distorts. Keep an eye on the Audio Performance bar graphs and deactivate a
number of EQ modules, until the computer load seems normal.

4. Set the parameters for the activated EQ module.
It is perhaps easiest to set up a playback cycle and experiment with the set-
tings until you get the desired sound. The three basic EQ parameters are:

Gain Governs the amount of boost or attenuation around the set fre-
quency. The value range is + 12 dB.

Frequency  The center frequency for the equalization. Around this frequency,
the sound will be boosted or attenuated according to the Gain set-
ting. The range of the Frequency parameter is determined by the Hi
and Lo Limits.

Q Determines the width of the frequency band around the center fre-
quency to be affected. The narrower frequency band, the more
drastic effect of the boost or attenuation.

The other EQ parameters are described in the chapter “Mixing and Using Effe
in the electronic documentation.

e Please note that high Gain values may give rise to distortion. Check the chan-
nel level meters and compensate with the channel volume faders.

5. Close the EQ window by clicking on its close box in the upper left corner.
In the Monitor window, the “EQ” button indicator for the audio channel will
now be lit, which means EQ is applied to that channel.

Turning EQ on and off from the Monitor Mixer

When you have enabled the desired EQ modules and made settings, you can
equalizing on and off for the channel from the Monitor Mixer window, by holdir
down [Control] and clicking the “EQ” button for the channel. This toggles the s
tus of the Active button in the EQ and FX Send window.
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Applying Effects

There are three basic types of effects in Cubase VST,; insert effects (applied s
rately to each channel, by using the channel inserts in the Monitor Mixer), sen
fects (applied separately to each channel by using the effect sends in the Mor
Mixer) and master effects (effects that accept a stereo input, and are inserted
the master mix). Typical uses for insert effects would be distortion, filters, auto
ners or any effect that you want to send a whole channel through. Typical sen
fects would be reverb, delay, chorus or anything that you want to apply in diffel
amounts to the different audio channels. Typical master effects would be noise
duction units, compressor/limiters or effects that change the stereo characteri:
of the final stereo signal.

In this section, we will only describe how to use send effects. Insert and maste
fects are described in the chapter “Mixing and using Effects” in the electronic
umentation.

Routing an Audio Channel through the Send Effects

You can have four different send effects in Cubase VST, and you can send the
nal from each audio channel to any combination of these four effects. Proceec
follows:

1. In the Monitor Mixer window, click on the EQ button for the audio chan-
nel you want to apply effect to.
The EQ and FX Send window opens, as described on the previous pages. The
section between the channel fader and the EQ modules contains the effect
sends.

ET—DW Button (affects all four sends)

O Pra——Pre-fader Send switch

[®]l |
E‘Q L__Send On/Off

&—Send level

On =i d .
EI B Send routing popup

]
|
2. Make sure the “DRY” button is not activated.

When this button is activated, all four effect sends are deactivated for the
channel.

E

nzert

EE

st | 5

3. Click on the “On” button for the effect sends you want to activate and
turn the corresponding Send level knob to a moderate value.
Remember that the Effects rely heavily on the processing power in your com-
puter. The more activated sends and effect units, the more computer power
will be used for effects.
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4. Pull down the Send Routing pop-up menu for each activated effect send,
and make sure they are assigned to different effect slots.
This pop-up allows you to freely route each effect send to any of the four send
effect slots, or even to an output on your audio card (see the chapter “Mixing
Audio and Using Effects” in the electronic documentation).

21 BEE

Hi Lirnit

Ii chairuz

SR
panner

reverb
(] baster L
M azter B

It is possible to assign two or more effect sends to the same effect slot, but this
would probably only lead to distortion in the effect unit.

5. If you want the signal to the effect to be independent of the channel
fader setting, click on the PRE button for the send.
With Pre-fader effect sends, the amount of effect for the channel is not af-
fected by the volume fader. With Post-fader effect sends (PRE button not acti-
vated), the amount of effect is proportional to the channel volume, and will
change with the volume fader movements. This is the most common setting.

The next step is to select programs and set the parameters for the effect proce

Since you will probably need to adjust the send levels while doing this, leave t
EQ window open.
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Selecting Effects and making settings
You select effect types and programs in the Effects window:

1. Click the big FX button to the left in the Monitor Mixer window (or select
Effects from the Audio menu).
The Send Effects window opens. This window resembles an effect rack, with
separate “processors” arranged on top of each other.

P 3 |

ifidth

zamoles

.mms sterenec
-c;l.::nm
g o100

amaount

Di 5o D e D2 |DE 2o

2. Activate an effect processor by clicking on its “Power” button.

3. Pull down the pop-up menu in the processor’s upper right corner and se-
lect an effect type.
|

o L LadPROG. Mo Effect
| }FI'I.GT. | }F.MI

L rmen. el = 1= earn,  AutoPan

Choirus

. T
:L'DFWE FuzzBox

Grungelizer

Scopion
Stereok cho
Sterecizard
YWiunderverb3
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You can select between the following effects (for more detailed descriptions, s
the separate Acrobat documents for each Effect Plug-in):

Effect Description

Choirus A chorus and flanger effect, which adds “depth” and “anima-
tion” to a sound.

Espacial A reverb effect, adding ambience and “room quality” to the
sound.

Auto Pan Makes the sound move automatically between the left and

right channel.

Stereo Echo A delay effect, with the possibility to set different delay times
for the left and right channel.

Fuzz A simulation of a typical transistor fuzzbox.
WunderVerb 3 Areverb that provides smoother, denser reverberation.

Grungelizer Adds crackles, hiss, distortion and filtering, for a true “lo-fi”
sound.

Other effects may be included with the program when you purchase it. There .
also additional Effect Plug-Ins separately available - contact your Steinberg de
for more information. Furthermore, Cubase VST can also use DirectX compat
plug-ins installed on your computer - see the chapter “Installing and using exte
effect plug-ins” in the electronic documentation.

. Click in the middle of the Prog. button, to put the processor in Program
mode.

. Step between the effect programs, either by clicking on the left or right
part of the Prog. button or by rotating the value dial.

The number of program locations depends on the selected effect type. It
might be a good idea to set up a cycle and have the audio channel play back
while you are making settings, to hear the effect of your selected effect pro-
grams.

Not all Effect Plug-Ins have ready-made programs. See the On-line help and
the documentation included with each Plug-in.

. Use the send level knob in the EQ window to control the amount of ef-
fect for the audio channel.
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7. Use the Effects Master knob to the left on the processor panel to set the
amount of input level to the effect processor.
If you set this to a high value, it might cause clipping (distortion) in the effect
processor. If the output of an effect processor is clipped, an indicator will light
up (this feature is not necessarily supported by all Effect Plug-Ins).

Effects Master knob

Clipping indicator

8. If you want to, repeat steps 2 — 7 for the other effect processors.
Avoid activating effect processors that you don’t use, since this draws some
extra processor power. To minimize the processor load, pull down the Effect
type pop-up for the unused processors, and select “No Effect”.

e The effect settings can be automated, as described in the chapter “Mixing Au-
dio and Using Effects” in the electronic documentation.
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Mixing MIDI

If you have a MIDI instrument that supports any of the standards GM (Genera
MIDI), GS (Rolands extension of GM) or XG (Yamahas extension of GM), you c
use the GM/GS/XG Editor to “mix” the sound of your MIDI instrument, by senc
ing MIDI messages to the instrument. These messages include volume, pan,
gram change and effect settings (GS/XG only). For more information about Gl
GS and XG, sepage 236

e [f your instrument does not support any of the standards mentioned, you may
still be able to use some of the functions in the editor, such as volume and
pan. Refer to the instrument’s documentation and to the MIDI message list in
the Mixer chapter in the Online documentation.

Working with GM/GS/XG Instruments

The empty Song that gets automatically loaded when Cubase VST is first inste
is set up so that each track transmits on one of the 16 MIDI Channels. This cc
sponds to how the GM/GS/XG editor is set up. To avoid confusion, we recomm
that you keep this Track/Channel layout when recording music for GM/GS/XG
sound modules.

The GM/GS/XG editor settings are saved with the Song and should be seen &
intuitive hands-on approach to quickly build a good sounding mix.
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Opening the GM/GS/XG Editor

There are two ways to open the editor window:
¢ Pull down the Edit menu and select “GM/GS/XG Edit”.
* Press [Control]-[Y] on the computer keyboard.

Selecting Output and Mode

Before you start mixing, you need to make sure the editor is set to the correct N\
and sends on the desired MIDI Output. This is done in the Device section:

Device
IGS !I b ode G5 Reszet
|MPU-401 .. =] Dutput Help

1. Pull down the Output pop-up menu and make sure that the correct MIDI
Output is selected.

This should be the Output to which your GM/GS/XG instrument is connected.

2. Use the Mode pop-up menu to select the desired mode (GM, GS or XG).

¢ Select GM if your instrument is General MIDI compatible, or if you have a
non-GM compatible instrument but still want to use some of the mixer func-
tions.

e Use Roland GS or Yamaha XG mode only if you have a Roland GS or Yamaha
XG compatible instrument and wish to access some of the additional features.
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3. Use the On/Off/Reset button to make your instrument ready for GM/GS/
XG operation.
This button has different labels and functionalities depending on which Mode
is selected:

A Z] Mode G O

E Olutput Help

In GM mode, this button is used to switch your instrument in and out of Gen-
eral MIDI mode. Click on the button to send the command that is currently
shown to your instrument.

ﬂ b ode [GS Heset

ﬂ Output Help

In GS/XG mode, this button is labelled “GS/XG Reset”. Clicking it resets all
controls in the window, as well as any connected GS/XG instrument, to their
default values.
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Selecting Sounds

You can select a General MIDI sound for each MIDI channel (except channel
which is used for drums) by using the hierarchical Program pop-up menus at
bottom of each “channel strip” in the mixer.

Revert] a0 [40 [40 [0 [ 40 [a0 [
[0 ool
Grand Piano
Chromatic Perc ¥ | T8 R k
Organ ¥| E._Grand CL Or
| Guitar ¥| Honky-tonk [
Bass ¥ E.Piano 1
Strings/0Orch *| E_Piano 2
Enzemble ¥| Harpzichord
Brazs k| Clawi
Reed »
Pipe 3
s Sunth | fad 13 —

The sounds are organized in 16 instrument groups, each containing eight sou
To select a sound, pull down the pop-up, move the pointer to one of the instrur
groups and select the sound from the sub-menu that appears.

Selecting Drum Kits

If your instrument supports GS and XG, you can use the Program pop-up mel
select a Drum Kit for MIDI channel 10 (which is reserved for drums).

o 4U|4U|4u

n ||n

(=)

_,lc

uital | Standard
Sectic Room

— Rock
Electronic
Analog

frons e
Bruzh

— Clazzic

e The Program settings in the GM/GS/XG Editor are not reflected in the Inspec-
tor and vice versa. Also, if you use ready-made GM Scores that include Pro-
gram changes, these will not be reflected in GM/GS/XG Edit.
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Setting Levels and Pan

You can use the Mixer section in the GM/GS/XG Editor, to set levels, pans, etc
each MIDI channel. Even though this has the “feel” of a normal mixer, it actua
works quite differently: The GM/GS/XG Editor mixes and changes the sound t
sending MIDI messages to the instrument. If the mixer parameters don’t seen
work as expected, you should check that your MIDI instrument really is capabl
(and set to) receiving the MIDI message in question.

e For a list of which MIDI messages are sent by each parameter, see the chapter
“The GM/GS/XG Editor” in the electronic documentation.
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The Mixer section.
The following controls are available for each MIDI channel:

* Volume fader.
Drag the fader to change the volume of the corresponding MIDI channel.

¢ Pan.
Use this to set the position in the stereo image for the corresponding MIDI
channel. The Drum channel (channel 10) has no panning control.

¢ Reverb level.
Although this is not a part of the GM specifications, many GM instruments
(and all GS/XG instruments) have a built-in reverb that can be controlled via
the standard MIDI controller number for reverb (#91). If this is so, use this
value field to set the amount of reverb for the channel.
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e Chorus level.
Like the Channel Reverb controls, this parameter is not a part of the GM spec-
ification. However, some GM instruments (and all GS/XG units) have a built-
in chorus (sometimes flanger or delay) that can be controlled via the standard
MIDI controller number for chorus depth (#93). If this is so, use this value
field to set the amount of chorus for the channel.

e In GS or XG Mode, you can make additional effect settings, as described be-
low.

* Mute switch (GS/XG mode only).
In GS/XG Mode (see below), the channel number fields above the faders can
be used as Channel Mute buttons. You can mute/unmute each channel indi-
vidually by clicking on the respective button.
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Effect Settings (GS/XG Mode only)

If your instrument supports GS or XG, you can use the GM/GS/XG editor to se
and make settings for effects in the instrument. This is done in the Effects secti
the window (which only appears in GS or XG mode).

Effects
| Plate _*| Reverb | Flanger 2| Charus

23 Reverb Time

The Effects section contains the following global settings for the reverb and ch
effects that are included in all GS/XG instruments:

e Reverb pop-up
Lets you select one of eight reverb types. The available reverb types are differ-
ent in GS and XG instruments. In XG mode, selecting “No Effect” allows you
to easily turn off the reverb completely.

e Reverb time
Lets you change the overall reverb time.

e Chorus pop-up
Lets you select one of eight chorus- and related effect types. The available ef-
fect types are different in GS and XG instruments. In XG mode, selecting “No
Effect” allows you to easily turn off the effect completely.
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What is GM/GS/XG?

General MIDI

General MIDI (GM) is a standard set up by the MIDI Manufacturers Associatio
(MMA) and the Japanese MIDI Standards Committee (JMSC).

It defines a standardized group of sounds and the minimum requirements for
eral MIDI compatible synthesizers or sound modules, so that a specially prep:
sequence or MIDI file that is sent to the instrument via MIDI will play back the c
rect sound types, regardless of make and model of the instrument.

MIDI identifies sounds by their program change number. Before the General V
standard was introduced, the same MIDI program change number often addre
totally differenttypesof sound in any two synthesizers or sound modules from ¢
ferent manufacturers, eg, a flute type sound in one instrument and a piano tyf
sound in the other.

With the introduction of General MIDI standard compatible instruments this
changed. These instruments use the same program change numbers for the ¢
types of instruments

So, if the person that prepared a sequence or MIDI file wants the melody to b
played by a "piano”, he can use a certain program change command embedde
the sequence to automatically select a piano sound in any GM compatible sot
module. The GM standard does not specify in great detail how that piano shot
sound. It is simply assumed that the manufacturer reproduces an acoustic pia
within the capabilities used of the instrument.

General MIDI supports all 16 MIDI channels. Each channel can play a variable
number of voices (thus be polyphonic). Each channel can play a different insti
ment (or sound, or program). A minimum of 24 fully dynamically allocated voic
are simultaneously available for both melodic and percussion sounds.

Furthermore, in GM compatible instruments, percussion and drum instrument:
which are key-based always use MIDI channel 10 and specific note numbers &
served for specific drum sounds.

There are a number of other MIDI messages that GM compatible instruments
should respond to. Among these are the MIDI controller events for Volume (Cc
troller 7) and Pan (controller 10). By using these controllers it is possible to cre
a MIDI Mix for a piece of music.

Roland GS

This is a variation of General MIDI introduced by Roland. It defines additional
standard procedures for selecting alternate drum kits and sound variations, ar
setting a number of other parameters in Roland GS compatible instruments.

Yamaha XG

This is a variation of General MIDI introduced by Yamaha. It defines additional
standard procedures for selecting alternate drum kits and for setting a numbe
other parameters in Yamaha XG compatible instruments.
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File Handling
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Saving

Which file format should 1 choose?

There are three document formats you can use for saving your music: Song, /
rangement or MIDI File. You should only choose MIDI Files if you want your
sic (MIDI only - no audio) to be playable in other sequencerso@ge 24X If you
want to save your music for further use in Cubase VST, you should use either
Song or the Arrangement format:

Song
When you save a Song (*.All), the following information is included:

¢ All the Arrangements.

* The Pool, all audio settings and audio file references (but not the actual audio
files themselves).

e The entire Setup, that is, settings in dialogs and on menus, Groove maps,
Transport Bar settings etc.

* The Drum Map.

Arrangement
When you save an Arrangement (*.Arr), the following is included:

¢ All the things you see in one Arrange window; the Tracks, the Parts, Inspector
settings, tempo, etc.

The audio file references, however, are stored in the Pool, and the Pool is not p
the Arrangement. This means that if you only save an Arrangement, there will b
audio files to reference to! Therefore:

e When doing audio work with Cubase VST, we recommend that you always
save complete Songs!

If you have only recorded MIDI, the Arrangement format is often perfectly ade
guate for saving a piece of music. The pros and cons of both formats are show
the table on the next page.
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File Format Advantages Disadvantages

Arrangement | ® Takes up little disk space. * Does not contain any au-
« Can be saved, and opened in dio settings and references.
another Song, which is an easy * Does not contain a com-
way to transfer music between plete “snapshot” of the pro-
different Songs. gram’s “state”.

* Does not contain “unnecessary”
settings if all you want to save is
the MIDI music.

e Opening an Arrangement does
not affect settings in dialog boxes
and on menus, which, in some
situations, is an advantage.

Song e Contains the Pool and all other |e Takes up more disk space
audio settings. than the Arrangement file
format, even if you only have
one Arrangement in the
Song.

¢ Contains more than one Ar-
rangement.

* Saves all the settings on all
menus, in all dialog boxes etc.

* Includes the Drum Map.

e Even though the Song files contain all audio references, they do not contain
the actual audio files! If you want to transfer a Song containing audio to an-
other computer, you need to move the audio files as well. The Prepare Ar-
chive and Prepare Master functions in the Pool make this easier - see the Pool
chapter in the electronic documentation.
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Performing the Save

1. Pull down the File Menu and select “Save As...”

4.

5.

The file dialog appears.

File navigation popup
Save File As

SaveIn |E #0ngzE - j ﬁl - EEE

| 3rd SyrmphorAlLL Whu:uwalk..-’-'-.LL
-] audinALL

-] CizciALL

Q exarnple. all ‘\

@|HockepsLL  File List

Q Fowerll zer. sl

File Name —Filename  Ihel's SmelldALL Save |
File fomat/(lSDngS [*.4LL) j Cancel |

Cubase VST File type popup

. Use the standard controls to find the location on your hard disk where

you want to save the file.

. Use the file type pop-up to select a format, Song or Arrangement.

The other file formats are primarily used for “extracting” special elements of a
Song file. See the Online Help for details.

Type in a name for the file.

Click the OK button.

Using “Save Song”

On the File menu you will find a menu item called “Save Song”.

If you have already saved your Song once (using “Save As...”) selecting Save
Song (or pressing [Control]-[S] on the computer keyboard) will save your
Song without asking for a file name and location. The file you save now will
simply overwrite the earlier version.

If you have not yet saved your Song, selecting “Save Song” is the same as se-
lecting “Save As...".
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About the default Song

Each time you launch Cubase VST, a default Song called “Def.All” is opened. T
makes it possible to customize the default functionality and layout of the progt

1. Launch the program.

2. Set up the program as you want it.
This may include the number and organization of Tracks, MIDI setup, Drum
Map, Metronome settings, Audio settings, Part color and appearance and
much more. See the Customizing chapter in the electronic documentation.

3. Select “Save As” from the File menu.

4. Navigate to the Cubase VST program folder.

5. Type in the name “Def.All” (without the quote signs) and press OK.
You will be asked if you want to replace the current Def.All file. Click Yes.

Next time you launch Cubase VST, you will automatically get your desired set
and layout.

About the Autosave Feature

WV tutosave BNy

In the Preference dialog on the File menu you find a setting called Autosave. If
activate this, you can set how often the program should automatically save yo
Song. The Song is saved under the name “Backup.all” in the Cubase VST prox
folder.
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Opening

1. Select Open... from the File menu.
The Open dialog appears.

Open

File List Search

I £ songs

=l & e =

2] 3rd SumphorypalL Powerl zer. all
-] audio.ALL wihawalk. ALL
-] CiceiALL
Q exarnple. all
| Hackey ALL

|

File selected for opening

el's Smells. ALl

File name IME|'S Smellz.ALL

Open I

File fnrma/ty | Songs [+ALL)

j Cancel |

[
Cubase VST File type popup

Song or Arrangement.

. Click on the file in the file list.

The list will only show documents of the selected type.

. Click OK.
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. Use the standard controls to display the correct folder on your hard disk.



About opening Songs

If the file is a Song, you will be prompted with a reminder that the Song you o}
will replace the Song you have loaded now. If this is not what you want, Cancel
Save the existing Song first.

About closing Songs

There is no way to close the Song in Cubase VST! The Close command on the
menu only closes the current Arrangement, as describpdgn131If you want
to create a new Song, you should use the New Song command on the File me

About opening Arrangements

If the file is an Arrangement, it will appear as a new window on screen, in addi
to any Arrange windows already open. You can have up to 16 Arrangements in
Song at the same time.
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Exporting in MIDI File format

You might want to export an Arrangement as a Standard MIDI File, so that it ca
loaded into other computer programs or hardware sequencers, for example.

e A Standard MIDI File contains MIDI data only - no audio. Any Audio Tracks in
your Arrangement will automatically be excluded from the created MIDI file.

1. Mute all the Tracks you don’t want included in the MIDI File.

2. Pull down the File menu and select “Preferences”.
The Preferences dialog appears.

Preferences |

Double click openz [T Crasshair
Key = Editor ¥ activity Display

¥ Dark Rulers
[T Autozave EYEN [T Fewer alerts
I 5| Wfimutes [™ Leave MIDI File Track Data as is

— Play in backaground
W I ™ Audio

Help |

Use the “Leave MIDI File Track Data as is” checkbox to determine what hap-
pens with the Inspector settings, such as Program Change, Transpose, Vol-
ume, etc:

e If the checkbox is activated, the Program Change, Bank Select, Pan and Vol-
ume settings in the Inspector are ignored. All other settings are converted to
“real” MIDI data and included in the MIDI file.

e If the checkbox is not activated, all Inspector settings will be converted to
“real” MIDI Events and included in the MIDI file. When the MIDI file is im-
ported (into Cubase VST or other sequencers) it will play back just like before
you exported it. In most cases, this is the preferred mode.

3. Pull down the File menu and select "Export MIDI File...”.
The file dialog appears.

4. Select a name and location for the file.
The file will automatically get the extension “.MID”, which is the standard ex-

tension for MIDI files.

5. Click OK.
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MIDI File formats

Cubase VST normally saves MIDI files in format 1. This means the Track struc
is preserved in the file (even though all Parts on each Track will be linked toge
into one long Part). However, if you Export a MIDI File with only one Track un-
muted, a MIDI File of type 0O is created.

Importing MIDI Files

1. Pull down the File menu and select Import MIDI File...
Cubase VST recognizes files as MIDI Files if they have the extension “MID”
(the standard extension for MIDI Files).

2. Use the dialog box that appears to decide if you want the file to appear
in a new Arrange window or if you want to merge the MIDI File into the
current Arrangement.

If you choose the latter option, the file will appear in the current Arrange-
ment, starting at the Left Locator position.

The file dialog appears.

3. Locate the file.
Click on the file in the File list.

4. Click OK.

When importing MIDI Files, the data is automatically split up into shorter seg-
ments (Parts) to make it easier to edit the music in the Arrange window.
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Handling Audio Files

Audio files can be imported and exported in several ways:

e By using the Import and Export commands in the Pool.
These also allow you to export a segment and make it an audio file of its own.

* In the Arrange window, by using the Import and Export Audio File com-
mands on the File menu.
The Export Audio File command lets you mix down several Audio Tracks into
one audio file.

* You can also import audio files directly into the Audio Editor, using the
Pencil tool.

All these functions are described in detail in the electronic documentation.

Make Backups of your audio files!

Needless to say, it is essential that you back up your audio data regularly, prefe
on other media. There are various functions to make it easier to manage your :
files, described in the Audio Pool chapter in the electronic documentation.

Handling ReCycle Files

Cubase VST can import files created by Steinberg ReCycle, a powerful tool fo
working with drum loops and similar sampled material. This allows you to use
Cycle together with Cubase VST, without the need of a sampler. This feature i
scribed in detail in a separate chapter in the electronic documentation.
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A Column 734
Active Track 775
ActiveMovie Plug-ins See DirectX Plug-ins
Activity 134
Aftertouch
About 79
Creating 201
Displaying 201
Editing 202
AQ Button 275
Arrangement
About 75, 112
Closing 131
Creating 130
Naming 730
Opening 243
Saving 238
Setting Aside 131
ASIO Control Panel 48
ASIO Settings 47
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About 13
Disabling 50
Recording 68
Setting up for 44
Audio Card
Setting Up 46
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Monitor Mixer 218
Setting 62
Audio Events
About 758
Deleting 769
Duplicating 165
Moving 165
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Audio File Folder 65
Audio Files
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Managing 150, 246
Pool 151
Renaming 757
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Audio Inputs
Activating 58
Selecting 64
Audio Parts See Parts
Audio Segments See Segments
Audio System Setup 47
Audio Tracks 120

Auditioning
Arrange Window 126
Audio Editor 768
MIDI Editors 7196
Pool 752

Auto Pan 227

Automatic Quantize 275
Autosave 241

B

Bank Select 7144
Brush Tool 791

C

C Column 7136
Cancel (Editing) 203
Chan Parameter 144

Channel
Audio 62
MIDI 73

Chn Column 7136
Chord Tracks 720
Chorus (Audio) 227
Chorus (MIDI)
Level 234
Type 235
Class Column 736
Class see Track Class
Click 60
Clipping
About 66
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Compress (MIDI Inspector) 145
Connecting
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MIDI 51
Controller Display 797
Controllers
About /9
Creating 201
Creating Ramp 202
Displaying 201
Editing 202
Recording /9
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Audio Events 764
Continuous Events 201
Notes 188
Parts 121
Track 174
Cue Points 106
Cueing 107
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Cycle
About 87
Playing Back 88
Recording 89
Recording Audio 91
Recording Functions 95
Recording Modes 93
Setting Up 87

D

Def.All (Default Song) 241
Delay

Audio Effect 227

In Monitoring 47

Inspector 143, 145
Delete

Audio Events 169

Audio Parts 69

Notes 7196

Parts 127

Tracks 778
Delete Last Version 95
Delete SubTrack 95
DirectX Plug-ins 227
Disable Audio 50
Divider 40
Double Click Opens 177
Drum Edit

About 7180

Controller Display 797
Drum Map

Opening 181

Setting Up 7182
Drum Tracks 720
Drumstick Tool 790
Duplicate

Audio Events 165

MIDI Events 7195

Parts 124

Tracks 117

E

Edit Solo 187

Effects
About 224
Editing 226
Sends 224

EQ Button 222

Equalizer 222

Eraser Tool
Arrange Window 127
Audio Editor 7169
MIDI Editors 796

Espacial 227

Events
About 172
Deleting 7196
Duplicating 795
Scrubbing 7196
Sizing 189

Expand 757

Export MIDI File 244

F

Fast Forward 703
Follow Song 187
Freeze Play Parameters 147
Freeze Quantize 274
Full Duplex 49
Functions
About 206
In the Arrange Window 207
In the Editors 207
Fuzz 227
FX Button 226

G

General MIDI See GM
Global Disable Monitoring 65
Glue Tube Tool 726
GM
About 13, 236
Activating 231
GM/GS/XG Editor
About 229
Controls 233
Opening 230
Groove Map 274
Groove Quantize 274
Group Tracks 720
Grungelizer 227
GS
About 236
Resetting 231

H
Help 717

Import Audio File
Audio Editor 164
Pool 156

Import MIDI File 245
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Info Line
Audio Editor 170
MIDI Editors 796
Showing and Hiding 796
Input Levels
About 46
Checking 66
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Activating 58
Selecting 64
Insert Effects 224
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About 738
Audio Parameters 743
MIDI Parameters 144
Opening and Closing 739
Real-time Thru 748
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Internet 71
Iterative Quantize 212
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Joining Parts 126

K
Keep (Editing) 203
Keep Appended Events 204
Key Edit
About 179
Controller Display 797
Sizing Events 189
Key Erase 95
Key Pad 701

L
Lanes 159

Leave MIDI File Track Data as is 244

Left Locator 68
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Drum Edit 790
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Audio 217
Automating 219
MIDI 233
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List Edit
About 784
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Sizing Events 1689
Local On/Off 54
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Moving Song Position to 706
Pre-programming 109
Punching In and Out 82
Recalling Pre-programmed 7109
Setting 68, 108
Setting up the Cycle 87
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Magnifying Glass Tool
Arrangement 726
Audio Editor 768
MIDI Editors 796
Master Button 702
Master Effects 224
Master Track 702
Master Window 2178
Meter Position 36
Metronome 60
MIDI
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Connecting 51
Recording 77
Selecting Programs /5
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In the Inspector 144
Setting for Recording 73
MIDI Editors
About 772
Closing 203
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Creating Notes In 788
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MIDI File
Exporting 244
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MIDI Tracks 720
Mix Mode 93
Mixer
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GM/GS/XG Editor 234
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GM/GS/XG Editor 233
Inspector 145
Part Appearance 128
Part Color 729
Part Display 75
Parts
About 721
Appearance 128
Creating 121
Deleting 69, 127
Duplicating 124
Joining 126
Moving 124
Naming 721
Overlapping (Audio) 70
Overlapping (MIDI) 78
Resizing 125
Selecting 122
Splitting 125
Patch (Inspector) 144
Pencil Tool
Arrange Window 121
Audio Editor 764
MIDI Editors 188
Pitch Bend
About 79
Creating 201
Displaying 201
Editing 202
Pool
About 750
Dragging Parts from 7153
Importing files 756
Position
Meter 36
Relative Changes 705
Setting 703
Time 36
Position Slider 703
Program Change
About 79
GM/GS/XG Editor 75, 232
Inspector 144
MIDI Editors 176
Punch In
About 82
Automatic 82
Manual 84
Punch Mode 93
Punch Out
About 82
Automatic 85
Manual 86

- 251 -



Q

Quantize

Automatic 275

Freezing 214

Groove 214

Iterative 272

Over 211
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